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Chapter 1

Introduction

For centuries, Swahili was written in Arabic script, and hundreds of manuscripts in collections around
the world testify to its long tradition of written literature. Over the last century, however, Swahili in
Roman script has become the norm.
Andika! (meaning Write! in Swahili) has two aims. The first is to make Swahili in Arabic script as
easy to use as Swahili in Roman script – it is equally easy to read and write the the language in either
script. The tools, based on the work of Marehemu Mu’allim Sheikh Yahya Ali Omar (Omar and Frankl,
1997) provide a consistent, standardised transliteration of Swahili in Arabic script, and a one-to-one
mapping of this to Swahili in Roman script. Documents can be typed in either script, and automatically
transliterated to the other.

• New writing in Swahili can be composed in Arabic script and published easily via word-processors,
webpages, or pdfs created by typesetting systems such as LaTeX.
• The ability to convert Arabic script at any time into Roman script means that there is very little
overhead involved in choosing to write Swahili in Arabic script. Material can be produced simul-
taneously in both scripts with the minimum of effort (although the converted text will need minor
editing to cover such things as capital letters, which do not exist in Arabic script).
• Existing Swahili content in Roman script can be converted to Arabic script, making it possible to
reuse content already published in Roman script. This means that large amounts of material in
Arabic script can be be made available very quickly.
• The Roman-to-Arabic conversion can be adjusted to convert numerals, to add or remove markers
such as sakani (sukun), and so on.

The second aim of Andika! is to allow the creation of digital versions of existing Swahili manuscripts
written in Arabic script.

• Perishable Swahili manuscripts in Arabic script can be directly transcribed and made available in
digital format, which is more versatile than a photocopy or scan of the manuscript. At present,
most Swahili literature from earlier periods has only been published in Roman transliteration,
even though the manuscripts were written in Arabic script.
• A direct transcription can be augmented with a fully-vocalised Arabic transcription, a close pho-
netic transliteration (a variety of different ones can be easily created), a transliteration in the
standard Roman orthography, and so on. The tools allow much of these to be generated automat-
ically, reducing the effort this would otherwise involve.
• A critical apparatus (English translation, notes on words, variant readings, emendations, etc) can
easily be added to the digital version, with high-quality typeset output in a variety of formats.
• Apart from allowing easier typesetting and dissemination, having manuscripts in digital form will
make it possible for the first time to use computers to look at word frequency, stylistic variation,
etc, within the texts, to build corpora for classical Swahili, and so on.

Andika! is licensed under version 3 of the Free Software Foundation’s General Public License.1 This
means that, apart from costing nothing to use, it can be adapted and extended as required by the user,
subject to the same license being used for any new version thus created.
1http://www.gnu.org/licenses/gpl.html
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Chapter 2

Examples of Andika! output

2.1 Converting Roman to Arabic script

Existing text in Roman script can be easily converted to Arabic script. Figure 2.1 is a section from the
Swahili Wikipedia page on utamaduni (culture), and Figure 2.2 shows this page after being converted
automatically to Arabic script using the conventions for standard spelling proposed in Andika!.

Figure 2.1: Part of the Swahili Wikipedia page on utamaduni (culture)

Below are typeset versions of one paragraph in both scripts :

Dhana hii ilipoibuka kwanza katika karne ya kumi na nane na kumi na tisa barani Ulaya,
ilimaanisha mchakato wa kulima au kuboresha kilimo au kilimo cha mboga. Katika karne ya
kumi na tisa dhana hii ilimaanisha kuboreshwa kwa mja kupitia kwa elimu na hali kadhalika
ilimaanisha kutekelezwa kwa maazimio ya kitaifa au maadili. Katikati mwa karne ya kumi
na tisa, wanasayansi wengine walitumia dhana ya utamaduni kurejelea uwezo wa kiubia wa
binadamu.

أُلَايَ، بَرَانِ تيِسَ نَ كُومِ نَ نَانٖ نَ كُومِ يَ كَارنْٖ كَتِيكَ كْوَنْزَ الِٕپِٗئِبُوكَ هِئِ ذَانَ
كُومِ يَ كَارنْٖ كَتِيكَ مْبٗوڠَ۔ چَ كِلِيمٗ أَوْ كِلِيمٗ كُبٗريٖشَ أَوْ كُلِيمَ وَ مْچَكَاتٗ الِٕمَِأَنيِشَ

3



CHAPTER 2. EXAMPLES OF ANDIKA! OUTPUT 4

الِٕمَِأَنيِشَ كَذَليِكَ هَالِ نَ الٕٖيِمُ كْوَ كُپِتِئَ مْجَ كْوَ كُبٗريٖشْوَ الِٕمَِأَنيِشَ هِئِ ذَانَ تيِسَ نَ
وَنَسَيَنْسِ تيِسَ، نَ كُومِ يَ كَارنْٖ مْوَ كَتِكَاتِ مَأَدِيلِ۔ أَوْ كِتَئِيفَ يَ مَأَزِمِؤٗ كْوَ كُتٖكٖلٖيزْوَ

بنَِدَامُ۔ وَ كِؤُبئَِ وَ أُوٖيزٗ كُرجٖٖلٖئَ أُتَمَدُونِ يَ ذَانَ لتُِمِئَ وَ وٖنْڠِينٖ

Figure 2.2: The page in Figure 2.1 automatically transliterated into Arabic script

The following paragraph is from Hamad (2011), and is followed by an automatically-generated conver-
sion to Arabic script.

Mafanikio ya Siti yameelezwa kwa kufafanua matatizo aliyoyapata katika jamii yake
katika kuendelea na hatua za kujinyanyua kiuchumi, hata hivyo alipambana nayo na aliweza
kufanikiwa. Historia ya Siti imejitokeza kuwa ya kipekee kutokana na matendo yake katika
jamii iliyo na utamaduni wa kuwaweka wanawake kutojitokeza hadharani hasa kwa kuimba
kwawakati huo. Siti akiwamwanamke aliyepata misukosukombalimbali ya kukatisha tamaa
katika maisha yake ikiwemo ya ndoa yake, aliweza kuhimili na kupambana nayo na kuweza
kufikia kuwa mtu maarufu na wa kuheshimika ndani na hata nje ya mipaka ya jamii yake.
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كُئٖنْدٖلٖئَ كَتِيكَ يَاكٖ جَمِئِ كَتِيكَ أَليِٗيَپَاتَ مَتَتِيزٗ كُفَفَنُؤَ كْوَ يَمٖئٖلٖيزْوَ سِيتِ يَ مَفَنِكِؤٗ
يَ هِسْتٗرئَِ كُفَنِكِيوَ۔ أَلوِٖيزَ نَ نَايٗ أَلپَِمْبَانَ هِيڤْيٗ هَاتَ كِؤُچُومِ، كُجِنْيَنْيُؤَ زَ هَتُؤَ نَ
وَ أُتَمَدُونِ نَ الِٕيِٗ جَمِئِ كَتِيكَ يَاكٖ مَتٖينْدٗ نَ كُتٗكَانَ كِپٖكٖئٖ يَ كُوَ امِٕٖجِتٗكٖيزَ سِيتِ
مْوَنَامْكٖ أَكِيوَ سِيتِ هُؤٗ۔ وَكَاتِ كْوَ كُئِيمْبَ كْوَ هَاسَ هَذَرَانِ كُتٗجِتٗكٖيزَ وَنَوَاكٖ كُوَوٖيكَ
يَاكٖ، نْدٗؤَ يَ اكِِٕوٖيمٗ يَاكٖ مَئِيشَ كَتِيكَ تَمَاءَ كُكَتِيشَ يَ مْبَلِمْبَالِ مِسُكٗسُوكٗ أَليِٖپَاتَ
نَ نْدَانِ كُهٖشِمِيكَ وَ نَ مَأَرُوفُ مْتُ كُوَ كُفِكِئَ كُوٖيزَ نَ نَايٗ كُپَمْبَانَ نَ كُهِمِيلِ أَلوِٖيزَ

يَاكٖ۔ جَمِئِ يَ مِپَاكَ يَ نْجٖ هَاتَ

2.2 Replicating prose in Arabic script

The following is a copy of the specimen text from Appendix C of Omar and Frankl (1997), which was
included to show how their system would look in practice – the text itself is from Omar (1998). The
conventions used here (eg the omission of short vowels in certain circumstances) differ slightly from
those proposed in Andika! – see Section 6.6 for further discussion.

نَ ذهابُ وَ نِ واكٖ مْتانڠ ٹكَُپانڈ؛ سان۔ مْريٖفُ نديانِ، أُنكِنڠام مْليمَ ٹكَُؤٗونَ مار
مْفانٗ سِجَؤٗونَ مْٹِ، ٹكَُؤٗونَ مار كْوٖينڈَ، ٹكَُٹيكَ باسِ مرجْانِ۔ نَ يَكوتِ نِ ياكٖ ماوٖ
يَ زُمُرودِ زَ نِ زاءٗ پهٖيمب نبوزِ هاءٗ نَ نبوزِ، أَتونڠَ مْمٗوجَ بَربٗارٗ كونَ ياكٖ تهين واكٖ۔
مَزيوَ كام مٖؤوپٖ يَوترُزيكَ، مَزيوَ نَمْنَ؛ كُلَّ رانڠِ يَ هَرير نِ ياءٗ مَنيٗؤَ نَ كبيت، كِجانِ

پهٖپٗونِ۔ يَ مَتٖمبٖيزِ كَٹيكَ: يَتٗوكَ پهٖپٗونِ۔ يَ ميٹٗ يَ
Mara tukaona mlima unkingama ndiyani, mrefu sana. Tukapanda; mtanga wake ni wa

dhahabu na mawe yake ni yakuti na marjani. Basi tukatika kwenda, mara tukaona mti,
sijaona mfano wake. T’ini yake kuna barobaro mmoja atunga mbuzi, na hao mbuzi p’embe
zao ni za zumurudi ya kijani kibiti; na manyowa yao ni hariri ya rangi kulla namna; maziwa
yawaturuzika, meupe kama maziwa ya mito ya P’eponi.

All of a sudden we saw a very high mountain which blocked the road. So we climbed the mountain; its sand
was like gold, and its stones were like rubies and seed-pearls. Well then, as we continued on our way, we came
across a tree the like of which I had never before seen. Beneath it was a youth tending goats. The horns of those
goats were green like emeralds, and their silken fleeces were of divers colours, while their milk which dripped
down was as white as the milk of the rivers of Paradise.

2.3 Replicating manuscript poetry: Bajuni fishing songs

Figure 2.3 is part of a manuscript rendering of Bajuni fishing songs collected by Sheikh Yahya Ali
Omar (Donnelly and Omar, 1982). A letter-for-letter transcription of that follows, with an automatically-
generated close transliteration in Roman script. The Roman conversion uses various diacritics to recon-
cile the manuscript’s representation of the Bajuni dialect with standard orthography.
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Figure 2.3: Bajuni fishing songs as written out by Sheikh Yahya Ali Omar

لَانِ السَّ عَلَيْهِ وَ * عَلَيْكُمْ لَامُ الَسَّ
assalāmu 'alaykum * wa 'alayhi assalāni

نْدَانِ ۏٖيْنْيٖ نْدَ هٗوْدِ * ايِْٕنْدٖ ۏٖيْنْيٖ نْدَ سَالَ
sāla nḏa wēnye ı̄nḏe * hōḏi nḏa wēnye nḏāni

نأَِمَانِ مْسِوٗوْنٖ * ذِيْچَ نْدَ هِيْ سَالَ نَ
na sāla hii nḏa ẕı̄tʲa * msiwōne niamāni

ڠَانِ شٖيْهٖ چُتَمْويِْچَ * پٖيْفُ ٹوَْتَاكَچِئَ سَاسَ
sāsa ţwaṯākatʲia pēfu * tʲuṯamwı̄tʲa shēhe gāni

مْكٗيَمَانِ پيِْلِ ۏَ * مْفِراَدٗ چُتَمْويِْچَ
tʲuṯamwı̄tʲa mfiraḏo * wa pı̄li mkoyamāni

نْڈَانِ مَڠٖيْڠٗ كْوَ هُوْلَ * ۏَانْڠُ أُڤٖيْذٗ نِ پٖيْنْبٖ
pēm̱be ni uw̱ēẕo wāngu * hūla kwa magēgo nḑāni

Peace to you, and to you peace. The salaam is for those outside, the hodi is for those inside. And this greeting
is for war -- do not think it is for peace. Now we will burn incense -- what learnèd man shall we call? We'll call
an Mfirado, and then a man from Koyamani. A horn is my sign of strength -- I eat with molars inside.

2.4 Replicating manuscript poetry: Utenzi wa Mkunumbi

Harries (1967) is one of the few books of Swahili classical poetry to include the text in Arabic script
in addition to the Roman transcription, in this case a photocopy of a copy made by Sheikh Yahya Ali
Omar of the original manuscript . The Arabic script in that manuscript is less well-adapted to Swahili –
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for instance, o is not used consistently. Figure 2.4 shows stanzas 3-5 of the utenzi.

Figure 2.4: Stanzas 3–5 of Utenzi wa Mkunumbi

A letter-for-letter copy of the manuscript is shown below. In this case the automatically-generated tran-
scription was suppressed and replaced by Harries’ own transcription, which was added manually and
coloured green.

مْبَوَانَ نَاسِمْبَ شِكُوٖ * لوَِانَ زِ مْبِلِ دٗوْلَ ٣
dola mbili zaliwana * Shekuwe na Simba Bwana 3a/b

نَلَيْلِيَ مْتانَ * كُشِنْدَانَ كَمَتٖزٗ
kwa matezo kushindana * mtana na lailiya 3c/d

وَاتُ كَتَكَ شِكُوٖ * تَاتُ سِكُ زكِِتِمُ ٤
zikitimu siku tatu * Shekuwe kataka watu 4a/b

ننُُلِيَ كَيْ نْغُوبٖ * كِتُ چَاكٖ كُتُكُوَ
kutukua chake kitu * ng'ombe kainunuliya 4c/d

لَحَانِ اَسِيُ مٖمَ * نْدِيَانِ نْڠُوْبٖ كَتِيَ ٥
katia ng'ombe ndiyani * mwema asio lahani 5a/b

مْمُيَ نْڠُوبٖ مْپَانِ * كَبَئِينِ شِيْ سِمْبَ
Simba Shee kabaini * mbwanni ng'ombe mmoya 5c/d

3. Two powers were in conflict / Shekuwe and Bwana Simba / opposing one another for sport / by day and by
night.
4. When three days had passed / Shekuwe wanted men / to bring his offering / and he bought himself a cow.
5. And he sent the cow on the way / a good one without blemish / and Sheikh Simba observed it / [and said] What
is the point of a single cow?

An automatically-generated close transcription can be printed out separately if desired, as shown below.
In this case, an alternative layout has been selected, where the vipande are each in their own column,
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instead of both being on one line.

3a/b ḏōla mbili ziliwāna shikuwe nāsimba mbawāna
3c/d kamaṯezo kushinḏāna mṯāna nalayliya

4a/b zikiṯimu siku ṯāṯu shikuwe kaṯaka wāṯu
4c/d kuṯukuwa chāke kiṯu nḡūbe kay nunuliya

5a/b kaṯiya ngūbe nḏiyāni mema asiyu laḥāni
5c/d simba shii kabaı̄ni mpāni ngūbe mmuya

2.5 Replicating manuscript poetry: Kiswahili

Abdulkadir and Frankl (2013) presents an annotated edition of the first author’s poem, .كِسْوَاحِلِ It is
rare among published work on Swahili in including the original Arabic script of the poem. The following
is a letter-for-letter transcription of stanza 4 of Sheikh Mahmoud’s manuscript, with the exception that
the damma-with-tail occasionally used by him to signify o is denoted here with inverted damma, since the
font does not yet include that glyph. The full text of the poem is in Appendix D, with a slightly different
layout in Appendix F.
The layout includes an automatically-generated close and standard transliterations (the latter corrected
manually where necessary), and the English translation and notes from the paper. The Arabic text and
the close transcription are set out in columns, so that the close transliteration relates directly to the
kipande above it, while the standard transliteration and the English translation are set out on a single
line, so that they can be read in conjunction.
Different fonts can be used for each layer of the text (the transliterations use sans serif fonts, while the
translation uses a serif font in a smaller size), and each layer can be coloured (the standard transliteration
is in green, while the close transliteration and translation are in shades of grey. An epenthetic vowel
has been added in blue in kipande 4b. The footnotes are marked in red and appear at the bottom of the
page.

عَثْمَانِ مْوٖنْڠٗ پيَِ مُيَاكَ مَامَاكٖ نْدِمِ ٤
piya mwengo 'athumāni nḏimi māmāke muyāka
ndimi mamake Muyaka1 * pia Mwengo Athumani2 4a/b

I am the mother of Bwana Muyaka, and of Mwengo Athmani also,

وٖنْدَانِ وَاكٖ وٖنْڠِ نَ كَذَلكَِ زَهِدِ نَ
na wengi wāke wenḏāni na zahiḏi kadhalika

na Zahidi3 kadhalika * na wengi wake wendani 4c/d
and of Zahidi too, and many of his contemporaries,

1Bwana Muyaka was the outstanding Swahili poet of 19th century Mombasa. After his death many of his verses were recalled
by Mu’allim Sikujua Abdallah al-Batawi (died 1890) and transcribed with annotations by W.E. Taylor (1856-1927). After Taylor’s
death his papers were acquired by the library of the School of Oriental and African Studies (SOAS), London.
2Mwengo Athmani: this 18th century poet from Pate composed the Utendi wa Tambuka (The Epic of Heraklios).
3Zahidi: see El-Maawy (2008).
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قَرنِِ مُوْيَ مْبوَا وٗتٖ مَتَاكَ نَ كُوْتِ عالى
woṯe mbwā mūya qarini 'ālı̄ kūṯi na maṯāka

Ali Koti4 na Mataka5 * wote mbwa moya karini 4e/f
Ali Koti and Mataka, all from just one century,

نْيوتَ كَمَ كَوَا وَ مَاتوُْمبونِ لتُِوْكَ وَ
wa kawā kama nı̄ūṯa waliṯūka māṯūmbūni

walitoka matumboni * wakawaa kama nyota 4g/h
they emerged from my womb, and shone like stars.

2.6 Replicating manuscript poetry: Mama musimlaumu

The following is a stanza from another poem by Sheikh Mahmoud, مُسِمْلَؤُمُ .مَامَا In this transcription of
the first stanza of the manuscript, the close and standard transliterations have been suppressed, leaving
only the Arabic-script text and the English translation. Each kipande is centred, and the Arabic-script
text has been coloured green.

Figure 2.5: The first stanza of Mama musimlaumu

وَقَاتِ وَنْڠُ قَبْلَ كُنٖينَ امٕٖنِبِدِ ١
I have been compelled to talk before my time

هُمْلَئِتِ مَامَانْڠُ نمِٖوَانَٔٗ سَبَابُ
because I have seen them condemning my mother

امٖٔزهِٗتِ سِپْوٖكٖ هَانَ مَاكُوْسَ مَامَانْڠُ
my mother is blameless, she is not the only one who is guilty

امَُّتِ نْدَ هِلِ كُوسَ
this is everyone's fault

4Ali Koti of Pate: see Chiraghdin (1987: 31-7).
5Bwana Mataka’s full name is Muhammad bin Shee Mataka al-Famau (1825-1868). He was ruler of Siyu, as was his father. His

mother was Mwana Kupona, famous for the poem of advice written to her daughter. Bwana Mataka died in Mombasa’s fort while
imprisoned by the Busa‘idi.
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2.7 Replicating manuscript poetry: Utenzi wa Rasi ’lGhuli

This is a transcription of a stanza (2280) from the MS sample included in Leo van Kessel’s edition of
Utenzi wa Rasi 'lGhuli by Mgeni bin Faqihi (bin Faqihi, 1979). The published standard Swahili text is
shown in green. This ballad was composed around 1850, and at over 4,500 stanzas is the longest Swahili
ballad in existence. The copyist of this MS writes only 3 vowels, uses ain with dot to represent ng[w],
and tends not to mark nasalised or labialised consonants (e.g. كَذِرعََ in 2280d).

Figure 2.6: Stanza 2280 of Utenzi wa Rasi 'lGhuli

تَبَيِنِ مَبَنَيِ فَهَمُنِ نَخَدَقِ ٢٢٨٠
mabanayi tabayini nakhadaqi fahamuni 2280b/a
na khandaqi fahamuni * mpanaye tabaini 2280a/b

زَمَكُفَرِ كَذِرعََ عِشِرنِِ نذِِرعََ
kadhiraʾa zamakufari nidhiraʾa ʾishirini 2280d/c

ni dhiraa ishirini * kwa dhiraa za makufari 2280c/d

2.8 Replicating manuscript poetry: Qasida ya Burda

Qasidas are panegyric poems in Arabic eulogising the Prophet, often performed as part of a religious
ceremony. They have spread widely throughout the Muslim world, and are often adapted to local lan-
guages (Knappert, 1971; Sperl and Shackl, 1995). The Qasida ya Burda, البُردَْة ,قَصيْدَةُ was composed by
Muhammad bin Sa’idi al-Busiri in the 1300s, and rendered into Swahili verse by Sheikh Muhammad bin
Athman Hajji al-Hilali Mshela (1840-1930) (wa Mutiso, 1996). In the extract below, the Arabic verse is
in blue, and the Swahili verse is in green. The transliteration is given as foonotes to each line.

6 بدَِمٍ مُقْلَةٍ مِنْ دَمْعًاجَرىَ مَزجَْتَ * سَلَمٍ نذِِيْ جِيْرَانٍ نَذَكُّرِ أَمِنْ ١
7 سَلَمِ نذِِى هَپٗ وَليِٗكٗ * نْيٖمَ جِرنَِ نكَِڪُكُمْبُكَ
8 سٖيْمَا نهَِيٗ مَعَنَايٖ كْوَمْبَ * دَمِ كْوَ تٗزِ امُٖلِتَنْڠَنْيَ

6amin nadhakkuri jı̄rānin̲̲ nidhii salamin̲̲ * mazajta damʾa̲n̲ājaray min muqlaẗin̲̲ bidamin̲̲
7nikakukumbuka jirani nyema * waliyoko hapo nidhii salami
8umelitanganya tozi kwa dami * kwamba maʾanāye nihayo sēmā
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9 اضَِٕمٍ مِنْ الظَّامَاءِ فىِ الْبَرقُْ مَضَ وَأَوْ * كَاظِمَةٍ تلِْقَاءِ مِنْ الرِّيحُ هُبَّتِ أَمْ ٢
10 زَكٖ جَنِبُ كَظِمَ كُتٗكَ * كْوَكٖ كُپِتَ نؤُِپٖتٗ اَمَ
11 اظَِمَا هَپٗ كِيْزَ كُيْنُكَ * يَكٖ نوُْرُ كْوَ مِمِ نوُِ اَمَ

Figure 2.7: The first two stanzas of Qasida ya Burda

9am hubbati rrı̄ḥu min tilqai kāẓimaẗin̲̲ * waaw maḍa ālbarqu fii ālẓẓāmai min iḍamin̲̲
10ama niupeto kupita kwake * kutoka kaẓima janibu zake
11ama niwu mimi kwa nūru yake * kuynuka kı̄za hapo iẓamā



Chapter 3

Getting started

3.1 Website

The website1 allows you to experiment with Andika! regardless of the operating system (Microsoft
Windows, Apple Mac OS, GNU/Linux, Android, etc) on your computer or device. All you need to do is
install the Scheherazade font2 so that all the Arabic glyphs (characters) used in Swahili are available.
In the Roman to Arabic section of the website you can type into a box in Roman script and have the
input converted into Arabic script, or you can input a web address and have that whole page converted
into Arabic script. You can cut and paste the converted Arabic text into a word-processor. The Arabic
to Roman section of the website lets you convert Arabic script into standard Roman orthography.

3.2 Introducing Ubuntu

The website offers only limited functionality – to use Andika! fully, it is best to install it on your
own computer. Andika! was developed on GNU/Linux,3 a free, secure, and versatile operating system
which is not owned by any one company – much of the internet runs on GNU/Linux, and large internet
companies such as Google, Amazon and Facebook use it extensively.4

The specific “flavour” of GNU/Linux used is Ubuntu.5 Ubuntu was started by a South African, Mark
Shuttleworth, and the name is cognate with Swahili أُوتُ (utu, humanity), so it is apt for a project like
Andika! It is highly recommended to download Ubuntu6 and install it7 as your main operating system,
but if that is not possible the next best thing is to run it in a virtual machine on top of Microsoft Windows
or Apple Mac OS by installing VirtualBox8 and then installing GNU/Linux into that.
Microsoft Windows or Apple Mac OS, which are owned by single companies, offer only a single desk-
top (interface to the operating system). But with GNU/Linux is it possible to choose from a variety of
desktops. By default, Ubuntu comes with the Unity desktop9, but the instructions here are mostly for
the KDE desktop10, since that is what I use.11

Detailed instructions for installing Andika! and the other software it requires are in Appendix A.
1kevindonnelly.org.uk/swahili
2scripts.sil.org/cms/scripts/page.php?item_id=Scheherazade
3en.wikipedia.org/wiki/Linux
4Most of Andika! will work on Microsoft Windows or Apple Mac OS, but the crucial part (keyboard layout and activation)

will not, since keyboard handling differs between operating systems – I would be happy to accept appropriate layout files for
operating systems other than GNU/Linux.
5ubuntu.com
6ubuntu.com/download/desktop
7ubuntu.com/download/desktop/install-ubuntu-desktop
8virtualbox.org
9unity.ubuntu.com
10kde.org
11I would be happy to include details for other desktops if anyone sends them to me.

12
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3.3 Typing Swahili in Arabic script

If you simply want to type Swahili in Arabic script, it’s very easy to get started:

1. Download Andika! (A/6.1) in a zip file.
2. Unzip the file.
3. Move into the andika folder created.
4. Install the Scheherazade font so that all the Arabic glyphs (characters) used in Swahili are available
(A/7).

5. Install a keyboard so that the Arabic letters can be typed (A/8).
6. Configure the LibreOffice word-processor to handle Arabic script (A/9).

3.4 Converting and annotating Swahili in Arabic script

The above will not allow you to convert automatically from one script to the other – for that you need
to do the full installation in Appendix A. This will also allow you to transliterate, edit and annotate
Swahili documents in Arabic script – see Chapter 7 and Chapter 8.

3.5 Next steps

Chapter 4 reviews some font-related issues.
Chapter 5 explains the keyboard layout used in Andika!, and how to access the various glyphs it caters
for.
Chapter 6 sets out proposed conventions for standard spelling of Swahili in Arabic script, which are
used when converting between the standard Roman script and Arabic script and vice versa.
Chapter 7 demonstrates how to convert between both scripts, in either direction, and gives an overview
of how the conversion works.
Chapter 8 shows how Swahili poetry manuscripts in Arabic script can be transcribed to produce attrac-
tive output in various digital formats, including transliteration, translation, notes, emendations, variant
readings, and so on, with the added benefit that the contents of the manuscripts are then available for
computer analysis of language, vocabulary, word-frequency, etc.



Chapter 4

Fonts

4.1 Missing glyphs in Arabic fonts

In order to see Arabic script properly, the font you are using must contain Arabic glyphs (characters).
A number of fonts developed especially for Arabic are available,1 but many of them contain only the
glyphs needed to write standard Arabic.
If you are using Andika! to transcribe older manuscripts, it may be that these glyphs will be all you
need, since many Swahili writers in the past used the Arabic script to provide only an approximation to
the Swahili sounds, and depended on the linguistic knowledge of native speakers to interpret the text
correctly (Omar and Drury, 2002, p14-15).2 As a further example, a copy of stanza 6 of the Utenzi wa
Mwana Kupona (Mwana Kupona’s Ballad), as written by Muhammad Kijuma (c.1855–1945),3 is given
below:

Figure 4.1: Stanza 6 from Muhammad Kijuma’s manuscript of Utenzi wa Mwana Kupona

The following is a letter-for-letter transcription of stanza 6, along with an automatically-generated close
transliteration and a manually-added standard Roman transliteration and English translation:

سِوتُِ نَوُلمِِغُ سِكِتُ اَدَامُ مَانَ ٦
nawulimiḡu siwiṯu māna aḏāmu sikiṯu 6b/a

mwana adamu si kitu, na ulimwengu si wetu 6a/b
mankind is as nothing, and the world does not belong to us

اَتَسَلِيَا اَبَوُ مْتُ هَكُوْنَ وَلَوُ
abawu aṯasaliya walawu hakūna mṯu 6d/c

walau hakuna mtu ambao atasaliya 6c/d
and there is no person who will live forever

However, if you are not dealing solely with older manuscripts, and you wish to use the spelling conven-
tions proposed in Andika! in order to unambiguously represent current-day Swahili, and allow translit-
eration between Arabic script and the standard Swahili Roman script, then you will need the additional
glyphs. If you see squares or boxes in the Arabic script, or just the glyph for the isolated form when
initial, medial or final forms are required, the reason is that the font you are using is missing the glyphs
that it would make it useable with Swahili.
The missing glyphs are likely to be one or more of those in Table 4.2. The first seven glyphs are the
most important.
1For example, in the Ubuntu packages fonts-arabeyes or fonts-kacst, or on the web from the Open Font Library

(openfontlibrary.org/en/search?query=Arabic).
2The examples are: بنِْتِ وغَُ نغِِمَا (negema wangu binti), وَكُ مُولَ كِيَ ييِِ (nyenyekea Mola wako), and تَرَ اَسِيَابَركَِ * اكَِرَ هُنِنَ مْتُ (mtu

hunena akenda * asiyapanda kitanda)
3MS H58, Asia Africa Institute/CSMC, University of Hamburg.

14
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Glyph Unicode name Unicode number Notes
پ peh U+067E p
ڤ veh U+06A4 v
چ tcheh U+0686 ch
ڠ ain with three dots above U+06A0 g
ݝ ain with two dots above U+075D g in ng’
ٖ subscript alef U+0656 short e
ٗ inverted damma U+0657 short o
ػ keheh with two dots above U+063B used by some writers for ch
ٹ tteh U+0679 alveolar t (Mombasa)
ڈ ddal U+0688 alveolar d (Mombasa)
ۏ waw with dot above U+06CF w (North)
ژ jeh U+0698 zh (North)

Table 4.2: Glyphs commonly missing in fonts

At the time of writing, the only fonts which contain all of these additional glyphs in Table 4.2 are
Scheherazade4 (by Bob Hallissy and Jonathan Kew), Amiri5 (by Khaled Hosny), and the fonts from the
PakType project.6

Fonts containing all the glyphs in Table 4.2 apart from keheh are Droid Arabic Naskh7 and Droid Arabic
Kufi8 (by Pascal Zoghbi), and Lateef.9

4.2 Default fonts in Andika!

When typing Swahili in Arabic script, the fonts can be changed directly in LibreOffice. For typesetting
of existing manuscripts, Andika! uses four fonts as defaults when generating pdfs:

• Scheherazade for the Arabic transcription. A possible alternative here is Amiri.
• Linux Biolinum O10 for the close transcription into Roman script, since it is especially good at
handling diacritics. A possible serif alternative here is Gentium11 (by Victor Gaultney).
• Liberation Serif12 for English translations.
• GranadaKD in andika/fonts for poem titles in Arabic. This is a Kufic-style font from Arabeyes13
that has been adapted by me to add the characters in Table 4.2 except keheh.

These default fonts can be changed by replacing the name of the font in the relevant command in
convert/tex/fontdefs.tex. Thus, to change the transliteration font from Linux Biolinum O to Gentium, you
would first install Gentium:
sudo apt-get install fonts-sil-gentium

and then open convert/tex/fontdefs.tex in a text-editor14 and change the line:
4scripts.sil.org/cms/scripts/page.php?item_id=Scheherazade, available in the Ubuntu package fonts-sil-scheherazade,

but see also Appendix A/7.
5amirifont.org
6paktype.sourceforge.net, available in the Ubuntu package fonts-paktype.
7openfontlibrary.org/en/font/droid-arabic-naskh
8openfontlibrary.org/en/font/droid-arabic-kufi
9scripts.sil.org/cms/scripts/page.php?item_id=Lateef
10linuxlibertine.org
11scripts.sil.org/cms/scripts/page.php?site_id=nrsi&item_id=Gentium
12fedorahosted.org/liberation-fonts
13openfontlibrary.org/en/font/granada
14A text-editor is an application specialising in the editing of text. Word-processors should never be used to edit files in Andika!,
because they will quietly change the file in ways which will prevent it working. There are multiple text-editors such as Kate, Geany,
and Gedit available in Ubuntu.
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\newcommand\Tr[1]{{\fontspec[Scale=1, Color=666666]{Linux Biolinum O}#1}}

to:
\newcommand\Tr[1]{{\fontspec[Scale=1, Color=666666]{Gentium}#1}}

The Color command sets the colour of the font using the hex version of the RGB value15 (in this case,
dark grey) – delete it if you want the transliteration in black. The Scale command alters the size of the
font – if you want it a bit smaller than normal, enter (say) 0.8 instead of 1.
As a general point, the readability of diacritics (or even whether they are displayed at all) depends
crucially on the font – not all will be capable of showing all diacritics, or of placing them in the right
location, so if something is not looking right in your transliteration, try using Linux Biolinum O (sans-
serif) or Gentium (serif) as suggested.

4.3 Adding missing glyphs to Arabic fonts

If you are anxious to use a particular Arabic font that does not have all the glyphs required by Swahili,
it is possible to add them to the font using the font editor FontForge,16 originally developed by George
Williams. Appendix B shows how to use FontForge to add missing glyphs,17 and a version with screen-
shots is also available at the website for the book Design with FontForge.18

You can also develop your own fonts using FontForge, though the creation of an attractive font is a
highly specialised task requiring artistic flair as well as technical skill. The next version of the drawing
program Inkscape,19 0.49, will allow initial glyph designs to be created there and then imported into
FontForge for finalisation.20

4.4 Scheherazade and Amiri

The Scheherazade webpage21 notes that:

Scheherazade provides a “simplified” rendering of Arabic script, using basic connecting
glyphs but not including a wide variety of additional ligatures or contextual alternates (only
the required lam-alef ligatures). This simplified style is often preferred for clarity, especially
in non-Arabic languages, but may not be considered appropriate in situations where a more
elaborate style of calligraphy is preferred.

Scheherazade is the default in Andika! because it fits the proposed full vocalisation better. For instance,
Amiri places all the vowels at the same height from the main letter, eg يشَ كُبرٖٗ (kuboresha, to boost) com-
pared to Scheherazade ,كُبٗريٖشَ and ونَسَيَاَنسِْ (wanasayansi, scientists) compared to Scheherazade .وَنَسيَانْسِ
This can lead to the upper vowels from the current line of text colliding with the lower vowels from the
previous line.
However, Amiri may bemore appropriate for use with text that is not fully vocalised (eg quotation of Ara-
bic within Swahili), particularly since it includes more of the ligatures commonly used in Arabic, making
15colorspire.com/rgb-color-wheel
16fontforge.github.io
17Note that unless the font you are adapting is available under an open license, this may constitute a breach of copyright.
18designwithfontforge.com/en-US/Adding_Glyphs_to_an_Arabic_Font.html
19inkscape.org
20understandingfonts.com/blog/2011/11/typography-extensions-in-inkscape-0-49. In the meantime, this functional-
ity can be accessed by using the “bleeding edge” packages available from Inkscape Trunk – launchpad.net/~inkscape.dev/
+archive/ubuntu/trunk.
21scripts.sil.org/cms/scripts/page.php?item_id=Scheherazade
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for more attractive text. For instance, Amiri َِ ُمئ ولَتِ (walitumia, they used), compared to Scheherazade ,وَلتُِمئَِ
has the letters ltm combined in one ligature.



Chapter 5

A keyboard layout for Swahili in Arabic script

5.1 Introduction

The keyboard layout proposed here is a work-in-progress, and can be adjusted in the light of experience
– I would be happy to receive any suggestions for improvement. As well as describing the keyboard and
explaining the conventions governing the layout, this chapter also includes information on how to edit
the layout to suit individual needs.
The Andika! keyboard allows Swahili in Arabic script to be typed directly into a GNU/Linux computer
using a standard English (UK or US) keyboard. Input speed is comparable to typing in Roman script.
As well as allowing contemporary Swahili to be easily typed in Arabic script, the keyboard will enable
most older manuscripts to be transliterated letter-for-letter.
The complete keyboard layout is depicted in Figure 5.1.1

Figure 5.1: Keyboard layout for writing Swahili in Arabic script

As can be seen from Figure 5.1, up to four glyphs may be accessed from one key. To access the contents
of each key, the Shift and AltGr keys are used in combination where appropriate, as shown in Figure 5.2.

Figure 5.2: Accessing the glyphs on the keys

5.2 Governing principles for the layout

The basic governing principle behind the keyboard layout is that the relevant Arabic glyph will usually
be produced by pressing the same key that produces the Roman glyph. It is thus very easy to use:
1I am grateful to Wikimedia for the original layout image.

18
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just switch your keyboard to use Arabic script – in KDE, Ctrl+Alt+K (see Appendix A/8.1 for further
information) – and start typing almost as if the keyboard is being used to type Roman script. Some
examples are given in Table 5.1.2

Arabic Keystrokes Roman English
مِيمِ m, i, Shift+i, m, i mimi I, me

سَاسَ s, a, Shift+a, s, a sasa now
لَكِينِ l, a, k, i, Shift+i, n, i lakini but

نمِٖفِيكَ n, i, m, e, f, i, Shift+i, k, a nimefika I have arrived

Table 5.1: Typing examples

The other main principle behind the layout is the consistent placement of glyphs that are related by
shape or sound in either script:

• The digraphs dh gh th sh zh are on the same keys as d g t s z, and are accessed using the Shift
key.
• The pharyngeal consonants ظ ط ض ص are on the same keys as z t d s, and are accessed using the
AltGr key.
• Similar Arabic glyph shapes are placed on the same key where possible – for instance ى ي are on
the y key, and ۏ و are on the w key.
• Long and short vowels are located on the same key, with the long vowel accessed by Shift, so for
instance the u key produces ُ and Shift+u produces .و
• The vowel carriers ؤ ئ إ أ are all accessed using theAltGr key.
• The alveolar consonants ڈ ٹ used in Mombasa Swahili are accessed using the AltGr+Shift keys.
• The glyphs ي و are repeated on w y for use when they represent semi-vowels.
• The palatal digraph ch is accessed using the c key, and an alternate representation used by some
writers,ػ, is accessed using Shift+c.
• The occasionally-used digraph kh is accessed using the X key.
• Non-alphabetic characters from the UK keyboard are currently available viaAltGr andAltGr+Shift,
in case they might be of use.

Further information on the glyphs accessible from each key is available in Table 6.1 (consonants) and
Table 6.2 (vowels).

5.3 Changing the layout

The layout of the keyboard is specified in the file layout/tz. Once copied to the appropriate place (see
Appendix A/8), the layout is available for use. The file (reproduced in Appendix E) is a simple text file,
and can be easily adapted to add new glyphs or change the position of existing glyphs – see Appendix C
for instructions on doing this.

2For an explanation of the penultimate long vowels accessed by the Shift keys, see Chapter 6.



Chapter 6

Writing contemporary Swahili in Arabic script

6.1 Introduction

The spelling conventions suggested here for writing contemporary Swahili in Arabic script are based
on those developed by Sheikh Yahya Ali Omar, as evidenced in his own manuscripts and in Omar and
Frankl (1997). However, I am wholly responsible for the conventions set out here, and for any unwitting
misinterpretation! In particular, the issue of vowel sequences1 (Section 6.5 below) is a complex one,
and may need revision based on input from first-language speakers who are literate in Swahili in Arabic
script. I would be happy to hear from anyone who has any comments on the conventions.

6.2 General principles

Word segmentation is as for standard Swahili in Roman script. This means that items such as نَ يَ زَ لَ
na, ya, za, la are written separately from the following word, even though in older manuscripts they
may be written attached to that word.
All short vowels are marked. Although short vowels are usually omitted in Arabic, this is inadvisable
in Swahili because of the different structure of the language, and also because Swahili has five vowels
instead of three.
The penultimate syllable of a word has its stress marked by writing it with a long vowel. ا is used for a,
ي for e and i, and و for o and u.2 This also helps to delimit individual words in the Arabic script.
Initial vowels use the vowel-carriers أ (AltGr+A, for a, o, u) or ٕ ا (AltGr+\, for e, i), eg أَنَسٖيمَ (anasema,
he is speaking), أُڠَالِ (ugali, porridge), اذِِٕينِ (idhini, permission).3 The order of typing is: vowel carrier,
then short vowel, then long vowel (if applicable).
Arabic sounds in loanwords should ideally use the original Arabic glyph, but they can also be written
as an Arabic transliteration of the Roman letter, eg ذ instead ofض or 4.ظ

6.3 Representation of consonants

The representation of Swahili vowels in Arabic script is set out in Table 6.1.

Roman Arabic Keystrokes Example

b ب b كِبُورِ kiburi (arrogance)

1I have tried to build on the discussion in Omar and Frankl (1997): Appendix B: The Hamza in Swahili Arabic script.
2The short vowels a, i, u may be omitted when they occur before a long vowel, eg ساسَ instead of سَاسَ (sasa, now), but this is

not recommended.
3Omar and Frankl (1997, p69) recommends omission of the hamza, presumably in order to limit the number of diacritics in

the text, but the current convention in Andika! is to write it.
4Note that the Roman to Arabic converter will always do this, since standard Swahili in Roman script does not preserve these

distinctions.
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ch چ c چُونڠوَ chungwa (large orange)
ch (aspirated, Mombasa) چه c, h چهُونڠوَ ch’ungwa (medium-sized orange)
d د d كُدَنڠَانيَ kudanganya (to deceive)

d - alveolar d (Mombasa) ڈ AltGr+Shift+d ٹوُنڈُ tundu (chicken coop)
dh ذ Shift+d ذَهَابُ dhahabu (gold)
dh (pharyngeal) ض AltGr+d ضِيكِ dhiki (distress)
dh (pharyngeal) ظ AltGr+z أَظُهُورِ adhuhuri (noon)

f ف f فيِڠٗ figo (kidneys)

g ڠ g ڠُنِئَ gunia (sack)
gh غ h غَضَابُ ghadhabu (anger)
h ه h هَاكٗ hako (he is not here)
h (pharyngeal) ح Shift+h حَسَن Hasan (Hasan [name])
[k]h خ x خَبَارِ [k]habari (news)
j ج j جَانَ jana (yesterday)
k ك k كُوكُ kuku (large hen)
k (aspirated, Mombasa) كه k, h كهُوكُ k’uku (medium-sized hen)
l ل l كُلِيمَ kulima (to dig)
m م m مِيمِ mimi (I)
n ن n نَانِ nani (who?)
ng’ نݝ n, Shift+n نݝٗومبٖ ng’ombe (cattle)

p پ p كُپَاكَ kupaka (to paint)
q ق q وَقْفُ waqfu (consecrated)
r ر r كُرُودِ kurudi (to come back)
s س s كُسِمَامَ kusimama (to stand)
s (pharyngeal) ص AltGr+s صَحِيبُ sahibu (friend)
sh ش Shift+s كُشِيكَ kushika (to hold)
t ت t فتِِينَ fitina (intrigue)
t (aspirated dental, Mom-
basa)

ته t, h تهُوپَ t’upa (bottle)

t (alveolar, Mombasa) ٹ AltGr+Shift+t ٹوُنڈُ tundu (chicken coop)
t (pharyngeal) ط t كُطَهِريِشَ kutahirisha (to purify)
th ث Shift+t ثَمَنِينِ thamanini (eighty)
v ڤ v كُڤِيمبَ kuvimba (to swell)
z ز z كُزيِمَ kuzima (to extinguish)
zh (Northern) ژ Shift+z ژيِنَ zhina (name)
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w و w كُوَ kuwa (to be)
w (labio-dental) ۏ AltGr+Shift+w ۏيِنٗ wino (ink)

y ي y يَاكٗ yako (your)
ʕ (pharyngeal) ع ‘ (single quote) مَعَانَ ma’ana (meaning)
hamza (vowel-carrier) ء AltGr+Shift+h تَاءٗ tao (arch)
hamza (marks long vow-
els used as vowel-carriers)

ٔ Shift+ , (comma) كُپِكِئَ kupikia (to cook for)

sakani (marks a conso-
nant without a following
vowel)

ْ Shift+ . (full stop) أَسْلَارِ askari (soldier)

shada (marks a doubled
consonant in Arabic
words)

ّ Shift+ ‘ (single
quote)

وَالنَّهَارِ wa-nnahari (and day)

NOTE: In the Keystrokes column, the comma stands for followed by.

Table 6.1: Representation of consonants

6.4 Representation of vowels

The representation of Swahili vowels in Arabic script is set out in Table 6.2.

Roman Arabic Keystrokes Example

a-... أَ AltGr+a, a أَسٗومَ asoma (he reads)
...-a-... َ a بَهَريِنِ baharini (in the sea)
...-aCV ا َ a, Shift+a سَاسَ sasa (now)
...-aV ء ا َ a, Shift+a, مَفَاءَ mafaa (usefulness)

AltGr+Shift+h تَاءِ tai (vulture)
بَاءٗ bao (plank)

e-... ٖٕ ا AltGr+\, e انٕٖدٖلٖئَ endelea (go on!)
...-e-... ٖ e كٖلٖيلٖ kelele (shout)

...-eCV ي ٖ e, Shift+e نجٖيمَ njema (good)

...-eV ئ ٖ e, AltGr+e كُپٖئَ kupea (to sweep)
كُپٗكٖئَ kupokea (plank)

i-... ِ ٕ ا AltGr+\, i اسِِٕپٗكُوَ isipokuwa (unless)
...-i-... ِ i كِتَابُ kitabu (book)
...-iCV ي ِ i, Shift+i مَشِيزِ mashizi (soot)
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...-iV ئ ِ i, AltGr+i كُتِئَ kutia (to place)

o-... ٗ أ AltGr+a, o اكٔٗتٗوبَ Oktoba (Oktober)
...-o-... ٗ o كِلِيمٗ kilimo (cultivation)

...-oCV و ٗ o, Shift+o مْكٗونڠَ mkonga (elephant’s trunk)

...-oV ؤ ٗ o, AltGr+o كُپٗؤَ kupoa (to cool)

u-... أُ AltGr+a, u أُليِمِ ulimi (tongue)

...-u-... ُ u كُشُكُورُ kushukuru ( to give thanks)

...-uCV و ُ u, Shift+u كُومِ kumi (ten)

...-uV ؤ ُ u, AltGr+u كُسُڠُؤَ kusugua (to rub)

NOTE: In the Roman column, C stands for consonant or consonant cluster and
V for vowel, and the entries refer respectively to (1) initial, (2) non-initial and
non-penultimate, (3) penultimate followed by a consonant, (4) penultimate
followed by a vowel. For a discussion of vowel-sequences, see Section 6.5. In
the Keystrokes column, the comma stands for followed by.

Table 6.2: Representation of single vowels

6.5 Vowel sequences

Vowel sequences have matching vowel-carriers inserted between them, as set out in Table 6.3.

Vowel Carrier Arabic Keystrokes
e, i yeh+hamza ئ AltGr+Shift+I or E or Y
o, u waw+hamza ؤ AltGr+Shift+O or U or W
a alef+hamza ء ا or أ Shift+A, AltGr+Shift+H

Table 6.3: Vowel-carriers

6.5.1 Stressed+unstressed vowel sequences

When the vowel is first in the vowel sequence and is also stressed (which will only happen when it is in
penultimate position in the word), a vowel-carrier is inserted after it. Where a is concerned, the hamza
on the carrier is written as a full letter rather than a diacritic.

kupea (to sweep) → kupeءya → كُپٖئَ
kupokea (to receive) → kupokeءya → كُپٗكٖئَ
kutia (to place) → kutiءya → كُتِئَ
kupoa (to cool) → kupoءwa → كُپٗؤَ
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kusugua (to rub) → kusuguءwa → كُسُڠُؤَ
kutoa (to produce) → kutoءwa → كُتٗؤَ
mafaa (usefulness) → mafaaءa → مَفَاءَ
tai (vulture) → taaءi → تَاءِ
bao (plank) → baaءo → بَاءٗ

Since the vowel-carrier accompanies the stress, there is no need to add another long vowel to mark the
stress. Thus كُپٖئَ (kupea, to sweep), and not ,كُپٖيئَ and كُتٗؤَ (kutoa, to produce), and not .كُتٗوؤَ

6.5.2 Unstressed+stressed vowel sequences

When the vowel e, i, o, u is second in the vowel sequence and is also stressed (i.e. again appearing
in penultimate position), it has a matching vowel-carrier as in Table 6.3 inserted before it. Since the
vowel-carrier comes before the stress, the stressed vowel is marked as normal with a long vowel.

shairi (poetry) → shaءyiri → شَئِيرِ
kiini (pith) → kiءyini → كِئِينِ
kuita (to call) → kuءyita → كُئِيتَ
shauri (advice) → shaءwuri → شَؤُورِ
meupe (white [class 6]) → meءwupe → مٖؤُوپٖ
kuona (to see) → kuءwona → كُؤٗونَ

However, where the second (stressed) vowel of the sequence is a, the vowel-carrier matches the preced-
ing vowel unless that preceding vowel is itself a, in which case the hamza on the carrier is written as a
diacritic rather than as a full letter.

viazi (potatoes) → viءyazi → ڤِئَازِ
akaacha (then he left behind) → akaءaacha → أَكَأَاچَ

6.5.3 Unstressed vowel sequences

In vowel sequences where there is no stress (i.e. none of the vowels in the sequence appear in penultimate
position), the vowel-carrier matches the first vowel. Again, in the case of a, the hamza on the carrier is
written as a diacritic rather than as a full letter.

tuondoke (let us leave) → tuءwondoke → تؤُٗندٗوكٖ
kuandika (to write) → kuءwandika → كُؤَندِيكَ
maandishi (manuscripts) → maءaandishi → مَأَندِيشِ

6.5.4 Longer vowel sequences

Longer sequences are handled in line with the principles above.

kuua→ kuءwuءwa → كُؤُؤَ
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6.6 Comparing conventions

Table 6.4 summarises the differences between the writing systems used in Sheikh Yahya’s manuscripts,
Omar and Frankl (1997), and Andika!

Feature Manuscripts Article Andika!
Sakani is marked on long vowels ✓ × ×
All short vowels are marked ✓ × ✓
Sakani on consonants denotes syllabicity only × ✓ ×
Distinction between syllabicity and prenasalisation ✓ ✓ ×

6.6.1 Sakani on long vowels

In Sheikh Yahya’s manuscripts, و ي carry a sakani when used to mark length/stress in the penultimate
syllable, eg مَزيِْوَ (maziwa, milk). However, in Omar and Frankl (1997), sakani is not used here (eg .(مَزيوَ
The suggested spelling in Andika! reflects this (though users can of course mark sakani if they wish).

6.6.2 Marking short vowels

In Sheikh Yahya’s manuscripts, all short vowels are marked, and Andika! follows this. However, Omar
and Frankl (1997) proposed that marking these is unnecessary in certain situations:

• If the short (unstressed, non-penultimate) vowel they represent is identical to a preceding short
vowel. For example, in ثَمنين (thamanini, eighty) the second a is omitted because it is preceded by
an a (fataha).
• If the short vowel they represent is identical to a preceding or following stressed (penultimate)
vowel represented by ا و .ي For example, in ثَمنين (thamanini, eighty) the last i (kasiri) is omitted
because it is preceded by ,ي and in ذهابُ (dhahabu, gold) the first a (fataha) is omitted because it
is followed by .ا
• Where all the vowels in a word are identical, except for stress. For example: تپكاز (tapakaza,
scatter), فكير (fikiri, think), شكور (shukuru, give thanks).

However, the suggested spelling convention in Andika!, as in Sheikh Yahya’s own manuscripts, is that
all short vowels are marked, thus: ,ثَمَنِينِ ,ذَهَابُ ,تَپَكَازَ ,فكِِيرِ .شُكُورُ There are a few practical reasons for this:

• Short e, o need to be marked anyway, since Arabic script has no way otherwise of distinguishing
ي meaning i from ي meaning e, or و meaning o from و meaning u.
• Omitting short vowels may conceivably save time when writing, once the rules above are mastered,
but this is unlikely to apply when typing – it is probably faster simply to type more or less what
would be typed when using Roman script, including short vowels.
• The omission of short vowels means that transliteration into Roman script would require post-
editing to add vowels. It might be possible to automate the application of the above rules to avoid
this, but the resulting system would likely be cumbersome, and simply typing the short vowels is
a more practical solution.

6.6.3 Sakani on consonants

Arabic sukun marks the absence of a vowel after a consonant. In Sheikh Yahya’s manuscripts, sakani is
used consistently for this purpose (alongside its use on long vowels). Thus: أُنَڤْيٗوٖيزَ (unavyoweza, how
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you can), كْوَ (kwa, to, by, for). Its most common occurrence is on a nasal before another consonant: انِْٔڠَوَ
(ingawa, although), نْجٖيمَ (njema, good).

Its use on nasals means that sakani can also denote syllabicity, and in Omar and Frankl (1997) its function
appears to be limited solely to that. The aim, as with the omission of short vowels, was most likely to
limit the number of diacritics in the text.
The suggested convention in Andika! currently is to follow the manuscript practice, and use sakani
on the first consonant of multi-consonant clusters. However, since sakani is not strictly necessary if all
vowels are being marked, this convention is open to change. (If users feel that marking sakani leads to
clutter, they can of course omit it).

6.6.4 Distinction between syllabicity and prenasalisation

Although the Roman orthography does not distinguish these two sounds, both Sheikh Yahya’s manuscripts
and Omar and Frankl (1997) make a distinction between a syllabic nasal followed by a voiced plosive
(eg m̩b) and a prenasalised voiced plosive (eg nɓ). The former is written with a preceding ْ,م and the
latter with a preceding ,ن as in مْبَيَ (mbaya, bad [Class1]) compared to نبَايَ (mbaya, bad [Class 9]).

Andika! will of course allow this distinction to be made in the Arabic script should a writer wish to do
so. However, the Roman to Arabic converter cannot do this (since the distinction is not reflected in the
standard orthography), and will always convert mb to ,مْب so automatically-converted text will need
post-editing to reflect this distinction if the user wishes to make it.



Chapter 7

Converting from one script to the other

7.1 Introduction

Andika! includes a number of options to convert between Arabic and Roman scripts. Because Andika!
is a work in progress, it is a good idea to check the output before re-using it in other contexts, since it
may require some manual editing – for instance, Arabic script does not have capital letters, so capitals
(other than most sentence-intial capitals) need to be added by hand to Roman output.

7.2 Cut-and-paste converters

The simplest option is to use the cut-and-paste converters on the website.1 If you have followed the
instructions in Appendix A/16 these will also be available on your own machine.2

To use these converters, type or paste text into the input box. Input is truncated to 900 characters, but if
your text is longer than this you can convert it in chunks. the truncation limit can be changed by editing
or commenting out the line:
$mystring=strip_tags(substr($mystring, 0, 900));
in convert_rom_ar.php and:
$input=strip_tags(substr($input, 0, 900));
in convert_ar_rom.php.
If you have large amounts of text to convert, the command-line converter should be used – see Section 7.3
below.

7.2.1 Arabic to Roman

The Arabic to Roman converter transliterates Arabic script into standard Roman orthography. The cor-
respondence should be perfect if the input text follows the spelling conventions for Arabic script (Chap-
ter 6).3 Where this is not the case (eg with text copied from manuscripts), the converter transliterates
the Arabic text as best it can.
If you have installed the webpages locally, you can replace the standard Roman transliteration with a
close transliteration containing diacritics by replacing $standard with $close at the end of convert_ar_-
rom.php.
Note that when converting from Arabic to Roman script, Firefox’s spellchecker will underline every
word in the Arabic script entry area. To avoid this, turn off as-you-type spellchecking: click on the
Open Menu button, select Preferences → Advanced, and on the General tab, untick Check my spelling
as I type in the Browsing section.
1kevindonnelly.org.uk/swahili/rom_ar.php and kevindonnelly.org.uk/swahili/ar_rom.php.
2andika/rom_ar.php and andika/ar_rom.php.
3If you take the Roman output and paste it into the Roman to Arabic converter, you should get your Arabic input back as the

output from that.

27
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7.2.2 Roman to Arabic

The Roman to Arabic converter transliterates standard Roman orthography into Arabic script.
The default is to show sakani on a consonant where it does not have an accompanying vowel (eg kwa,
kuboreshwa, sayansi). This can be changed by ticking Do not show sakani (sukun) on consonants - then
no sakani will be shown.
The default is to show numerals in Western-Arabic form (1234567890). This can be changed by ticking
Convert numerals to Arabic-Indic forms - then numerals will be shown as ١٢٣٤٥٦٧٨٩٠.
Some writers use sakani on و and ي when used as long vowels in the penultimate syllable. The default
is not to show this, but this can be changed by ticking Show sakani (sukun) on و and ي as long vowels
Andika! is not a translator - non-Swahili words are simply transliterated letter-for-letter from Roman
script into Arabic script. English c is transliterated as ,ڮ and x asكْس. Examples: Shrewsburyشْرٖوسبُري, Cre-
ative Commons License لڮِٖنْسٖ ڮٗممٗنْس .ڮرئَٖتِيڤٖ A sakani is used where it would occur in Swahili (depending
on the settings above), but is not applied elsewhere.
Andika! is not a spelling or punctuation corrector - any errors in the text entered will be carried over
into the transliteration. The conversion may contain lines with out-of-sequence words if the source
contains a mixture of Swahili and another language with letters that do not occur in the standard Swahili
Roman orthography (the Swahili will be converted to RTL Arabic script, but the non-Swahili letters will
be passed through as LTR Roman script). The transliteration equivalents chosen here mean that line
continuity is not a problem where the “other language” is English. However, be aware that problems
may occur if the “other language” is French, German, or something else.
Note that the converter will always use the ”commonest” Arabic letter. For instance, it will convert dh
to ذ instead of toض or ,ظ which might be the original Arabic letter in the word. There is no way around
this, since the standard Swahili Roman orthography does not preserve these distinctions, and the only
option in such cases is to edit the output afterwards.

7.2.3 Convert a webpage

The website also includes a tool to transliterate entire webpages from Roman script to Arabic script.
Although it should work on most webpages, most testing has been done on Wikipedia pages.
To use the tool, simply enter the webpage address in the box – the initial http:// can be omitted if desired.
Only a subset of characters are allowed in the web address: alphanumeric characters (a-z, 0-9), full-stops
(.), hyphens (-), underscores (_), single quotes (’), colons (:) and slashes (/). Non-existent web-addresses
will produce a blank conversion page.
While there should be no problems transliterating the main text of the webpage, some peripheral ”page
furniture” (eg menus, lists of links, etc) may not be transliterated properly. All links on the converted
page will go to unconverted (Roman script) pages.

7.3 Command-line converter

Cutting and pasting does not make sense for long documents. Andika! therefore includes a converter
which will act directly on the document, provided it is laid out in a particular way – see Section 7.3.3.
The document can be in either Arabic or Roman script, in odt (libreOffice Writer) or txt (plain text)
format, and can be converted to pdf, odt or txt format, in three possible layouts, with or without Roman
transliteration.
The converter can be used in twomodes: via a point-and-click interface (Section 7.3.1), or via a command
typed directly into a terminal (Section 7.3.2). The latter option also makes it possible to automate the
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use of the converter if you have a number of documents that need conversion.
The converter also offers the option of importing the text of the document into a database table. This is
the option recommended for any serious editorial work, and is dealt with in detail in Chapter 8.
It is recommended that files to be converted are stored in andika/convert/inputs – they can each be
put in their own folder beneath that if desired. The converted documents, along with related files, will be
stored in andika/convert/outputs in a folder named after the document. Thus, converting a document
called mkunumbi.odt to pdf format will result in a file mkunumbi.pdf in the folder andika/convert/
output/mkunumbi. Note that each invocation of the converter will create output that overwrites the
previous output, so if you want to keep multiple layouts of a particular converted document, you need
to save the output separately.
It is a good idea to keep the input filename lower-case and all-one-word. In contrast to Microsoft Win-
dows, Ubuntu will consider files with capitalised names as different files from the lower-case equivalent,
and filenames containing spaces may not be handled as anticipated. If you need to include multiple
words in the filename, link them with an underscore.
In pdf output, lines can sometimes appear ill-aligned when you change the desired layout. This is due
to LaTeX having to compile the pdf again to apply the new layout. It can be fixed by simply repeating
the import.
With an odt input file, if you get an error message similar to the following:

Warning: array_combine() expects parameter 2 to be array, null given in /srv/www/andika/convert/convert.php
on line 163
Warning: Invalid argument supplied for foreach() in /srv/www/andika/convert/convert.php
on line 166

it means that you have two blank lines at the end of the file instead of one.

7.3.1 Point-and-click interface

To start the converter in this mode, open a terminal and enter:
convert/convert.sh

A series of windows will open, allowing you to make the following choices:

1. The document (file) to be converted. For poetry, the document needs to be in a specific layout –
see Section 7.3.3 below.

2. The script in which the document is written (Arabic or Roman).
3. The genre of the document (poetry or prose).
4. The type of output required (pdf, odt, txt, or insertion into a database table). If database insertion
is chosen, no further selections need be made.

5. For poetry, the layout required (two vipande per line, separated by space; two vipande per line,
separated by asterisk; or one kipande per line). Only the latter two layouts are available for odt
and txt poetry output. For prose, there is only one layout (the line in Arabic script followed by the
line in Roman script), and this will be applied automatically.

6. Whether or not the Roman script (whether original text or generated transliteration) should be
included in the output. The default is to include it.

Note that in the case of two vipande separated by a space, the transcription below them applies to each
kipande separately; in the case of two vipande separated by an asterisk, the transcription below them
applies to the whole line of two vipande. The stanza numbering reflects this. The two versions of a
quatrain from the Utenzi wa Jaafari (Ballad of Jaafari) in Figure 7.1 and Figure 7.2 show the differences.
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يَنْڠُ مَتٖمْبٖزِ كهٖنْدَ نْدُزَنْڠُ پُلِكَنِ ١
kʿenḏa maṯembezi yangu pulikani nḏuzangu 1b/a

چَلٗنِجِريَِ قِصَ زَنْڠُ خَبَرِ نوَِپٖ
qiṣa chalonijiriya niwape khabari zangu 1d/c

Figure 7.1: Vipande separated by a space

يَنْڠُ مَتٖمْبٖزِ كهٖنْدَ * نْدُزَنْڠُ پُلِكَنِ ١
pulikani nḏuzangu * kʿenḏa maṯembezi yangu 1a/b

چَلٗنِجِريَِ قِصَ * زَنْڠُ خَبَرِ نوَِپٖ
niwape khabari zangu * qiṣa chalonijiriya 1c/d

Figure 7.2: Vipande separated by a star

7.3.2 Command-line input

In this mode, the converter is launched by running:
php convert/convert.php

followed by the options in the order above (filename, script, genre, output, layout, transliteration) sep-
arated by +. For instance, the command:
php convert/convert.php convert/inputs/machozi.txt+roman+poetry+pdf+vip-star+TRUE

will convert the document machozi.txt, a poem in Roman script (Knappert, 1972, p.163), into a pdf with
the layout of two vipande to the line, separated by an asterisk, and including the transliteration (in this
case, the original standard Roman orthography).
All options are entered in lower-case, though “Prose/Poetry” and “Arabic/Roman” can use capitals if
desired.
Part of the output from the point-and-click interface will be the above list of +-separated options, so that
they can be cut-and-pasted for future use. This is useful if you are repeatedly converting one document,
since you can re-run the command once (using up-arrow and then Return) rather than have to click
through the screens of the interface.

7.3.3 Layout of the input document

The documents to be converted can be in either txt or odt format.
Poems in traditional metres should be laid out one kipande to the line, with a blank line between stanzas
and one (odt) or two (txt) blank lines at the end.
An alternative format for longer poems (for example, tenzi) is available, which may be useful in helping
to pinpoint your location in the transcription. After the blank stanza-separation line, each stanza can
be preceded by a line giving the number of the stanza as written in the manuscript. The format for this
is hash (#) followed directly (i.e. with no intervening space) by the manuscript number – an example
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of this format is available in the file andika/convert/inputs/jaafari/jnum.odt. The hash symbol
and Roman numerals are accessible from the Swahili keyboard by holding down AltGr and pressing
the hash and numeral keys. Note that any stanza numbers added in this hash line will be ignored by
the conversion to pdf, odt or txt in favour of its own stanza numbering (the scribe or the copyist may
misnumber stanzas, so it is better to let the computer do it). However, when converting to a database
table, these numbers will be imported into the table (in the msno field) alongside the stanza number
calculated by the computer (in the stanza field) – see Section 8.2 for more information.
Prose will be converted by paragraph. Again, the document should end with one (odt) or two (txt)
blank lines, but there should be no blank line between paragraphs. Where a manuscript has been tran-
scribed line by line, each line in the trascribed document will therefore equate to a paragraph, and be
transliterated separately to give an interlinear transliteration.
Poems in free metres, or prose poems, should be treated as prose.

7.3.4 Converting pdfs

Documents in pdf format can also be converted, but need first to be converted to text. To do this, ensure
that the package poppler-utils is installed:
sudo apt-get install poppler-utils

Then move into the directory where the pdf is located, and run:
pdftotext file_to_be_converted.pdf

replacing file_to_be_converted with whatever the filename is. This will produce an equivalently-named txt
file.
This step is not included in the converter because typically the resulting text file will require some
editing before it is fit for use – in particular, headers and footers on the pdf page will usually interrupt
the run of the text, and need to be removed.
Once the text file has been tidied, it can then be converted as explained above.

7.4 General notes on usage

7.4.1 Adjusting the import’s stanza numbering

By default, the conversion process numbers stanzas from 1 onwards. However, if you are handling an
excerpt and want the numbering to reflect the actual stanza numbers of the excerpt, it is easy to do
this.4 Open the file in a text editor (not in a word-processor):
kate convert/convert.php
and locate the line:
$stanza_no=0;

Edit the number so that it is set to one below the lowest stanza number of the excerpt – for instance, for
an excerpt beginning at stanza 138 you would edit the line to read:
$stanza_no=137;
Save the file and run the conversion.
Remember to reset the line to 0 when you have finished.
4If you are importing into a database, you can instead import the excerpt without editing convert/convert.php and adjust the

stanza numbering directly in the poem table - see Section 8.2.3.
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7.4.2 Warning when using the convert tools

If you get a series of warnings like the following when using the convert tools :

Warning: array_combine(): Both parameters should have an equal number of elements in
/var/www/andika/convert/convert.php on line 175
Warning: end() expects parameter 1 to be array, boolean given in /var/www/andika/convert/convert.php
on line 178
Warning: key() expects parameter 1 to be array, boolean given in /var/www/andika/convert/convert.php
on line 179
Warning: reset() expects parameter 1 to be array, boolean given in /var/www/andika/convert/convert.php
on line 180
Warning: Invalid argument supplied for foreach() in /var/www/andika/convert/convert.php
on line 184

it means that you have mistakes in your input file (eg you have typed only 5 vipande in a stanza when
all the others have 6).

7.5 How the conversion works

This section gives an overview of how each script is converted into the other. It is not necessary to
be aware of this in order to use the conversion tools. More details can be gleaned from inspecting the
file andika/includes/fns.php, where the functions (self-contained pieces of code) which handle the
conversion are located. The procedure used here could no doubt be further developed, and I would be
happy to take suggestions for improvements.
The conversion procedure is built on applying a series of regular expressions (regexes)5 to the text, giving
a versatile framework where the output can be fine-tuned to suit an individual user’s requirements.

7.5.1 Arabic to Roman

Arabic to Roman conversion is handled in two stages. The first produces an intermediate “Romanised”
conversion, and then the second “smoothes” the initial conversion to produce standard Roman orthog-
raphy, and/or a close transcription. The benefit of using two stages is that different smoothers can be
developed for different transliteration systems.
First, the function ar2rom() converts each Arabic glyph to a Roman or Unicode equivalent (the latter
when the equivalent English glyph might be represented with a diacritic).
Thus سَاسَ (sasa, now) will have the following regexes applied to it:
$text=preg_replace("/\x{0633}/u", "s", $text);
to convert seen (U+0633) to s
$text=preg_replace("/\x{064E}/u", "a", $text);
to convert fatha (U+064E) to a
$text=preg_replace("/\x{0627}/u", "L", $text);
to convert alef (U+0627) to L
The output from the function for this word will therefore be saLsa.
L is used to designate alef (long a), w to designate waw (long u), and y to designate yeh (long i). Thus
رَفيِكِ (rafiki, friend) will be converted to rafiyki, and كُومِ (kumi, ten) to kuwmi.
5en.wikipedia.org/wiki/Regular_expression
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In cases where the Arabic glyph might be represented in Roman with a diacritic or by more than one
glyph, the Unicode designator is carried across. Thus, in خَبَارِ ([k]habari, news), the initial kh is handled
by the regex:
$text=preg_replace("/\x{062E}/u", "U+062E", $text);

and the output after this first stage would be U+062EabaLri.
In the second stage, the functions standardise() or close() are applied to the output of the first stage.
standardise() will apply regexes such as the following to the words above:
$text=preg_replace("/U\+062E/", "h", $text);
to convert U+062E to h: U+062EabaLri→ habaLri
$text=preg_replace("/a?L/", "a", $text);
to delete L preceded by a: habaLri→ habari, saLsa→ sasa
$text=preg_replace("/([ei])y([^aeiou])/", "$1$2", $text);
to delete y preceded by e or i and followed by a non-vowel: rafiyki→ rafiki
$text=preg_replace("/([ou])w([^aeiou])/", "$1$2", $text);
to delete w preceded by o or u and followed by a non-vowel: kuwmi→ kumi.
It then applies a (very simplistic!) regex to capitalise words occurring after a full-stop, since Arabic has
no capitalisation.
close() will apply slightly different regexes:
$text=preg_replace("/U\+062E/", "hU+0331", $text);
to convert U+062E to ẖ: U+062EabaLri→ ẖabaLri
$text=preg_replace("/a?L/", "ā", $text);
to convert L or aL to ā: ẖabaLri→ ẖabāri, saLsa→ sāsa
$text=preg_replace("/iy([bcdfghjklmnpqrstvwyz'U])/", "U+0131U+0304$1", $text)
to convert iy followed by a consonant, semi-vowel or Unicode codepoint to ı:̄ rafiyki→ rafık̄i (the two
Unicode codepoints designate a dotless i and a macron)
$text=preg_replace("/uw([bcdfghjklmnpqrstvwyz'U])/", "ū$1", $text);
to convert uw followed by a consonant, semi-vowel or Unicode codepoint to ū: kuwmi→ kūmi.

7.5.2 Roman to Arabic

Conversion from standard Roman orthography (or a close transcription) to the suggested standard Arabic
orthography is mainly done with one function, rom2ar(), but there are a number of helper functions that
tweak the output.
The first helper function, prep_rom(), adds a long vowel in the penultimate syllable, converting sasa
(now) into saLsa. Then the function rom2ar() converts each Roman glyph (including glyphs with dia-
critics in a close transcription) to the Unicode designator for the Arabic glyph.
Thus saLsa will have the following regexes applied:
$text=preg_replace("/s/", "U+0633", $text);
to convert s to seen
$text=preg_replace("/a/", "U+064E", $text);
to convert a to fatha
$text=preg_replace("/L/", "U+0627", $text);
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to convert L to alef
The output from the function for this word will therefore be .سَاسَ
The ẖ in the close transcription ẖabāri (news) will have it converted to khah by the following regex:
$text=preg_replace("/ẖ/", "U+062E", $text);

giving ,خَبَارِ but the h in the standard spelling, habari, will be converted to heh by the regex:
$text=preg_replace("/h/", "U+0647", $text);

giving .هَبَارِ
In most cases of standard h, heh will be the correct choice, but in the case of this particular word khah
is probably better, since it is the glyph used in the original Arabic loan. Currently, the only way around
this is to manually edit the output of the converter, but future plans for Andika! include adding a list
of preferred spellings to prep_rom(), so that habari is converted to ẖabari, and it is the latter which is
then passed to rom2ar().
On a more general point, converting an existing close transcription (perhaps one in a published paper
or book) into the suggested Arabic spelling will of course hardly ever regain the original Arabic spelling
(whatever that was) on which that transcription was based. However, even a partial conversion may be
useful in providing an Arabic text that can be edited to reflect the original spelling, rather than starting
to type out the original from scratch. If the Arabic spelling in the original has well-defined features, it
may also be worthwhile to edit rom2ar() to reflect those features, so that the conversion will be as close
as possible to the original, thus limiting the amount of editing to be done.
The suggested spelling in Andika! is to show sukun on consonants that are not followed by a vowel (eg
,كْوَ kwa, by), but the prep_rom() function includes an option to turn this off (giving .(كوَ
Likewise, the suggested spelling in Andika! is not to show sukun on waw or yeh (eg كُومِ and not ,(كُوْمِ but
there is a helper function, waw_yeh_sukun(), to turn that on.
The final helper function, convert_numbers(), gives the user the option of changing Roman numerals into
Western Arabic ones.



Chapter 8

Typesetting poetry

As noted in Chapter 1, a key aim of Andika! is to facilitate the production of digital versions of classical
Swahili manuscripts. This chapter deals with the tools provided to do that – they are based on the
concept of importing each word of the text into a database table, and then adding material such as
notes on individual words or sections, variant readings and emendations, translations, etc. The enriched
text can then be output in a number of formats allowing for both print and online publication – see
Section 8.6. This approach also facilitates the automatic production of word frequency lists, glossaries,
concordances, n-grams, and so on, which open the way for detailed linguistic analysis of the text.
This chapter focusses on the possibilities for typesetting traditional poetry in Arabic script. However,
the tools can also be used for prose in Arabic script – this aspect could be developed further if there is
demand for it.

8.1 Creating the input document

The first step is to manually transcribe the manuscript letter-for-letter into a LibreOffice odt document
– virtually all the Arabic glyphs likely to be used in a manuscript are already on the layout described in
Chapter 5, and it is actually faster to type the Arabic text into the computer than it is to type in a close
transliteration.
Each kipande of a poem in traditional metre should be placed on its own line, and each stanza should
be separated by a blank line. The LibreOffice document should end with one blank line.
Particles such as نَ يَ زَ لَ (na, ya, za, la) are best written according to the manuscript rendering. In
many instances the author or copyist may have attached them to the following word, or (in the case
of non-connecting letters like (زَ placed them very close to it. But where there is a larger space in the
manuscript between the particle and the following word, it may be appropriate to write it separately
from that word in the transcription. These decisions are subjective, and may produce some inconsistency
in the transcription, but they will reflect the manuscript more faithfully. Connection or disconnection
of the particles (in line with standard Roman orthography) will be handled by annotating the entries in
the database.
Samples of input files are in andika/convert/inputs and subfolders.

8.1.1 Checking the input file

It is a good idea to check your input file every few stanzas or so by using the convert tools to output a
pdf with transliteration. This will help you to note and correct typos as you go along.

8.2 Importing the contents into a database table

Once the manuscript is transcribed in the input file, it can be imported into a database table. This is
done by using the conversion tools, but specifying database import instead of output in a particular
document format. To use the point-and-click interface (Section 7.3.1), open a terminal and run:
convert/convert.sh

35
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choose your poem, and then select Insert into database on the Output screen. To use the command-line
interface (Section 7.3.2), run the following command (replacing vita_vikuu with the name of the poem)
:
php convert/convert.php convert/inputs/vita_vikuu/vita_vikuu.odt+Arabic+Poetry
↪→ +db+kip-line

In both cases, a database table of the same name as the poem (in the above case, vita_vikuu) will be
created in the andika database, and each kipande of the poem will be imported into that table. During
this import, the Arabic text is transliterated into standard Roman orthography, and also into a close
transliteration which more closely reflects the Arabic glyphs.
To view the database table, you can access it using phpPgAdmin: in a browser, enter localhost/
phppgadmin and log in to the PostgreSQL server. In the left panel, click the + beside andika, and then
Tables, and then click on Browse alongside the name of the poem (in this case, vita_vikuu). You should
see the first part of the contents of the table, and for each kipande of the poem, there will be:

• A computer-assigned index number (poemline_id).
• The stanza number as written on the original manuscript (msno). If the original stanza numbers
were not entered on the input document (see Section 7.3.3), a zero will be entered here instead. The
difference between this and the following stanza is that human scribes or copyists make mistakes
– they may miss out a number, or give two stanzas the same number. However, for manuscript
work (see Chapter 9) it may be useful to record this number in any case.
• The stanza number as generated by the software (stanza). This will always be correct (i.e. increment
by 1 for each stanza in the poem). The default import numbers the stanzas from 1 onwards, and for
simplicity, that is retained in the examples in this section, but it is easy to change the numbering
to reflect the actual stanza numbers – see Section 7.4.1.
• The location of the line in the stanza (loc). This is in the form of a lowercase Roman letter: a, b, c,
d, etc.
• The Arabic text (arabic). Some cells in the Arabic column may appear empty, but this seems to be
a display bug in phpPgAdmin – if you press Edit you can see the text is there, and a select query
will also show it.
• The close transcription (close).
• The standard transcription (standard).

8.2.1 The import process hangs

If the database import process hangs (i.e. appears to be doing nothing), this is because you have the
relevant poem table open in SQL Workbench (for example, to review the import, or add annotations).
If SQL Workbench is showing data from an Andika database table, it places a lock on the table which
prevents any other program accessing it for some operations (re-creating a table, renaming a field in
the table, etc). If you then try to run another import (eg to add some more stanzas you have just typed
out), the import will hang because the script convert/create_poemlines.php cannot delete that table and
re-create it. To allow the import to proceed, all you need to do is close SQL Workbench. You can then
reopen it after the import is complete.

8.2.2 Saving a particular import

Each time a poem text is imported, the import process will delete and then recreate the poem table
containing the vipande and their transliteration. There is no real need for a backup, because the table
(unlike the words table – see Section 8.3) is simply a copy, in a different format of the input document.
However, if for some reason you want to preserve a specific conversion (perhaps for archival purposes),
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you can save (dump) the database table before re-running the conversion. To create a file which can be
loaded into a PostgreSQL database, open a terminal and run:
pg_dump -U dbuser --table=poem_name > poem_name.sql andika

If I wanted to do this for the poem inkishafi, I would run:
pg_dump -U kevin --table=inkishafi > inkishafi.sql andika

To create a file which can be opened in a spreadsheet, run:
psql -U dbuser -d andika
(replacing dbuser with your database user)
\copy (select * from poem_name) to 'poem_name.csv' with delimiter ',' csv header
(replacing poem_name with the name of the poem)
\q

You can do the same thing with phpPgAdmin.

1. On the Tables screen of the andika database, click on the name of the poem.
2. Click on the Export button at the top of the page.
3. For a backup which can be loaded into PostgreSQL:
(a) Tick Structure and data.
(b) Select SQL from the Format drop-down list.

4. For a backup which can be opened in a spreadsheet:
(a) Tick Data only.
(b) Select CSV from the Format drop-down list.

5. Tick Download, and then click Export.
6. Select a location in which to save the file (you may want to create a directory in which to store
the backups), and rename it as appropriate (you may want to add dates to the filenames).

Andika! makes automatic backups for the next stage of import, splitting lines into words (see Sec-
tion 8.3.1).

8.2.3 Adding stanzas to a poem import

This is an unlikely scenario, but is included here for completeness. Suppose (a) your copy of a poem was
missing a page, (b) you have come across another copy of that poem which contains the missing page,
and (c) you no longer have access to your typed out (odt) version of the poem, but you want to include
the new stanzas in the poem table without retyping the whole poem.
Assume you have 5 new stanzas which fit in after stanza 115 of the existing poem as (new) stanzas 116
to 120. You would:

1. Type out the new stanzas as a separate document, and import that as a separate poem (say, newbits).
2. Adjust the numbering of the newbits table to reflect their proper position in the existing poem:

update stanza set stanza=stanza+115
This will change the stanza numbers from 1 to 116, 2 to 117, and so on.1

1Alternatively, you can edit convert/convert.php – see Section 7.4.1.
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3. Make space for the new stanzas by moving the numbering of the existing poem stanzas forward:
update stanza set stanza=stanza+5 where stanza>115 This will change the stanza numbers
from 116 to 121, 117 to 122, and so on.

4. Copy the new stanzas from from the newbits table into the poem table:
insert into poem select * from newbits

8.3 Splitting lines into words

Now that the text of the poem is stored in a table (poem_name), the next step is to split each kipande of
the poem into words, and store those in another table (poem_name_words), which will allow each word
to have individual annotations added to it. To do this, open a terminal and run:
php db/import_words.php name_of_the_poem

replacing name_of_the_poem with whatever your poem name is. In the example, you would run:
php db/import_words.php vita_vikuu

Note that once the poem is imported into the database, the code relating to annotation and other editorial
work is located in the directory db, and not in convert.
The import process will create a new table, name_of_the_poem_words (in this case, vita_vikuu_words), which
you can again inspect using phpPgAdmin. Each word has an entry of its own, consisting of fields similar
to those used for the poem table (see above):

• An index number (word_id).
• The stanza number in which the word occurs, as written on the original manuscript (msno).
• The stanza number in which the word occurs, as generated by the software (stanza).
• The location of the kipande in the stanza where the word occurs (loc)
• The position the word occupies in the kipande, eg first word, second word or whatever (position).
• The Arabic text (arabic).
• The close transcription (close).
• The standard transcription (standard).

However, other fields are also created to hold annotations for data such as variants, general notes, an
English translation, and so on (see Section 8.4).

8.3.1 Re-running word-splitting: backups

Note that each time import_words.php is run (eg as you complete another batch of stanzas), it will delete
and then recreate this words table. Since you may well have devoted considerable time to editing the
table and adding annotations (see Section 8.4), it is important not to lose these! So import_words.php
does the following things:

1. Creates (or, in the case of a re-import, re-creates) a backup of the words table, which will include
all your annotations and edits. The name of this table is poem-name plus _backup, e.g. vita_vikuu_-
backup.

2. Archives any pre-existing backup (from earlier imports) in a table named poem-name plus _backup
plus date plus time. An example would be inkishafi_backup_2017_11_23_16_45_35, indicating that
this archive backup was made at around 4.45pm on 23 November 2017.
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3. Does the new import, as explained above in Section 8.3.
4. Adds your annotations and edits from the backup into the new import (see Section 8.4 below).

In the normal course of events, you should never need to use the archive backups, but they are there
to cover a case where something goes wrong with the import and you immediately re-run it. This could
lead to data loss – the first import run creates a backup table with all your annotations, but the second
then deletes that good backup table and creates a new one based on the faulty words table, where the
annotations may be missing. The result is that your backup table no longer cotains your annotations!
The archive backups allow you to recover from this situation with your annotations intact, because you
can copy fields manually from them to your words table by using an SQL query like:
update inkishafi_words w set (edclose, edstan, emend, variant, note, english) =
↪→ (b.edclose, b.edstan, b.emend, b.variant, b.note, b.english)
↪→ from inkishafi_backup_2017_11_23_16_45_35 b
↪→ where w.stanza=b.stanza and w.loc=b.loc and w.position=b.position;

The above query will copy the contents of the listed annotation fields from the archive backup table
into the words table. IMPORTANT! If you run this query in SQL Workbench, you then need to commit
(save) this update by selecting SQL → Commit, or by pressing Alt+M.
If you find that you are doing a lot of re-importing and this is leading to a good few archive backups,
you can simply delete all but the most recent, provided your words import has gone smoothly.

8.3.2 Renumbering stanzas during word-splitting

A problem can arise during word-splitting (Section 8.3.1) if between two imports you have renumbered
the stanzas by changing the stanza_no counter (Section 7.4.1). For instance, if you (a) import a set of
excerpted stanzas with stanza_no set to 0 (the default), (b) add annotations, (c) realise that you should
have set the stanza_no to (say) 275, because the excerpted stanzas begin at 276, and (d) reimport after
having adjusted the stanza_no to read stanza_number=275, then although the annotations you made
previously will be in the backup, they cannot be re-integrated into the new words table because they
no longer have the same stanza number.
For the above case, you can resolve this by running the following :
update poem_words w set (edclose, edstan, emend, variant, note, english, noshow) =
↪→ (b.edclose, b.edstan, b.emend, b.variant, b.note, b.english, b.noshow) from poem_backup b
↪→ where w.stanza-275=b.stanza and w.loc=b.loc and w.position=b.position;

The above query subtracts 275 from the stanza numbers in the new excerpt table, so that they now
match the numbers in the backup table, and then copies the annotation fields from the backup table to
the words table. IMPORTANT! If you run this query in SQL Workbench, you then need to commit (save)
this update by selecting SQL → Commit, or by pressing Alt+M.

8.4 Annotations

It is possible to create as many fields in thewords table as are required to handle various annotation types,
and the content of each of these fields can be selected and edited via code, which means that a versatile
framework exists for any editorial apparatus. The most important annotation types are described below,
but others will be discussed in Chapter 10, when we look at computer-aided analysis of the poem text.
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8.4.1 edclose field

This field holds an edited version of the close transliteration, which can be used when you want to
override the output given by the automatic close transcriber. For instance, suppose that in the Mwana
Kupona text (Figure 4.1) you wanted to rewrite ghain (غ) where it is used to represent ng. You could
do this by adding an edclose entry nawulimingu alongside the close entry nawulimigū. When the poem
is typeset, an entry (if there is one) in the edclose field will replace the equivalent one in the close field.
The edclose field also allows the re-use of a specific existing close transliteration – for instance, if you
are typing out a manuscript which has already been published, and you need to replicate the close
transliteration from that publication. In this case, you would add an edclose entry alongside each close
entry to reflect that existing close transliteration.

8.4.2 edstan field

This field holds an edited version of the standard transliteration, which can be used when you want to
override the output given by the automatic standard transcriber. When the poem is typeset, an entry (if
there is one) in the edstan field will replace the equivalent one in the standard field.
This can be used in a number of situations:

• To make spelling corrections where the automatic transcriber gets things wrong, e.g. to change
akanyyamaa to akanyamaa. (eg changing ḡ to ng, or i to e), the edclose field currently handles
two other types of edits: and insertion of additional letters.
• To segment the transliteration to reflect standard Swahili word boundaries, e.g. to separate par-
ticles like نَ يَ زَ لَ (na, ya, za, la), etc that have been written connected in the Arabic text. For
example, in 1c of vita_vikuu, you could add na khubuzi in the edstan field alongside the standard
field nahubuzi.
• To connect elements that have been written separately in the Arabic text. To do this, enter ∼ in
the edstan field alongside the standard field element to be joined, and move the element to the
proper cell. For instance, in 1g of kiswahili, standard Swahili requires nimewatendani (what have
I done to you?) instead of ni mewatendani. So against ni we put a ∼ in the edstan field, and edit
the edstan field of mewatendani to read nimewatendani.
• To add epenthetic vowels to support proper scansion, you can use \In{text here} (more infor-
mation on annotation fonts is given in Section 8.5.1 below). For instance, in 1c of vita_vikuu an
epenthetic vowel can be added to the transliteration of مِلْحِ (milḥi, and salt) to give miliḥi by
editing the equivalent edstan field to read na mil\In{i}ḥi.
• To allow the re-use of a specific existing standard transliteration – for instance, if you are typ-
ing out a manuscript which has already been published, and you need to replicate the standard
transliteration from that publication. In this case, you would add an edstan entry alongside each
standard entry to reflect that existing standard transliteration.

With some writers (e.g. Sheikh Yahya), the standard trancriber will result in text that is very close
to standard Swahili in Roman script, because their Arabic script marks distinctions that reflect the
phonology of Swahili. Other writers (usually from earlier periods) have used the Arabic script as an
approximation of the phonology of Swahili (see Chapter 4) so the standard transliteration will reflect
standard Swahili in Roman script less well. In these cases, instead of re-typing entries into the edstan
field, it may be easier to copy the contents of the standard field to edstan, and edit that (or delete entries
where they are identical) – this may help reduce typos due to mistyping. The following SQL query will
accomplish this:
update poem_word set edstan=standard;
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8.4.3 emend field

This field can be used where the copyist has written an incorrect word that requires emendation. When
the poem is typeset, an entry in this field will replace the equivalent entry in the standard field, and will
be marked in the output by a dotted underlinebelow the word. For example, in the Inkishafi one kipande
reads نكَِبِيَاپُ مَانَ نسِِكِيَ (nisikia maana nikwambiapo), which is one syllable longer than the expected
11. This can be resolved by adding sikia in the emend field alongside nisikia, and the line will then be
output . . . . .sikia maana nikwambiapo.
Note the distinction between the emend field and the edstan field. The former is used where the copyist
has made an error that needs to be corrected. The latter is used where the the written text only approxi-
mates standard Swahili, and needs to be rectified – an example would be where the Inkishafi text above
reads nikabiyapu, and we need to change that to nikwambiapo to reflect modern standard Swahili.

8.4.4 variant field

This field allows the recording of variant readings (variae lectiones) of the word in different manuscript
versions of the same poem. For instance, 6a of vita_vikuu reads: أَسِيْسِ نْجٖيْمَ نَسٖيْفُ (nasef̄u njem̄a asıs̄i,
and a good, stout sword). If you have another manuscript B where this kipande reads: أَسِيْسِ نْزُوْرِ نَسٖيْفُ
(nasef̄u nzūri asıs̄i), in the variant column against njēma we put (for instance):
B: \AS{ِنْزُوْر}, nzūri

which will be converted to a footnote giving:
B: ,نْزُوْرِ nzūri.

8.4.5 note field

This field holds notes on the meaning or reference of the word, or any other material which may help
to elucidate its meaning or usage. There is no practical limit on the length of these notes (the longest
possible content that can be stored in any one field is about 1 GB). Appendix D demonstrates how
Andika! caters easily for a significant number of notes – for more information the relevant database
table, kiswahili_words, can be inspected.
To refer to other footnotes within notes, add a reference label to the source footnote:, e.g.
\label{fn:mynote}This is a footnote that we also want to refer to later.

In the referring footnote, call that reference:
This footnote makes the same point we already made earlier - see footnote \ref{fn:mynote}.

8.4.6 english field

This field holds an English translation of the whole kipande, placed against the first word of each kipande.
See the kiswahili_words table for examples.

8.4.7 noshow field

This field can be used to switch off the display of the standard transliteration for words or lines in the
poem. It will be discussed in more detail in Section 8.8 below.
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8.5 Adding and editing the annotations

The best tool for adding the annotations to be added directly to the table is SQL Workbench (Ap-
pendix A/12.2), since it allows direct entry into the individual fields. Open SQL Workbench and connect
to the andika database. In the top panel, enter an SQL query to show the whole of the vita_vikuu_words
table in order of stanza and kipande:
select * from vita_vikuu_words order by stanza, loc, position;
(note that the semi-colon at the end is essential)
Move the cursor somewhere inside the query and press Ctrl+Return. You can now edit individual cells
in order to add annotations.
IMPORTANT! Remember to press the Save icon or select Data → Save Changes to Database to save
any material you add. Even though you can see your edits in SQL Workbench, they are not written into
the database until you save them!

8.5.1 Specifying fonts in the annotations

Changes from the default font can be marked in any of the annotation types, and it is recommended
to make such changes directly in the annotation, rather than try to edit the output file afterwards. The
alternate fonts use the font definitions as set up in the file andika/convert/tex/fontdefs.tex, and
you can add more to that list using the patterns seen there (see also Section 4.2). To apply the font
changes, the LaTeX command format is used: a backslash, then the abbreviation for the desired font,
and then the text inside braces. Likely font changes that might be applied are:

• Arabic script: \AS{text here} – Scheherazade. To use Amiri, use \Am{text here}

• transliteration: \Tr{text here} – Linux Biolinum O in grey.
• inserted letters: \In{text here} – Linux Biolinum O in blue.
• standard Swahili: \Swa{text here} – Linux Biolinum O in green.
• English: \E{text here} – Liberation Serif in grey italics, smaller than the default.
• English italics: \Eit{text here} – Liberation Serif in black italics.
• standout type in footnote: \FN{text here} – Liberation Serif in green italics.

8.5.2 Inserting citations in the annotations

All the annotation fields can include citations, but they are perhaps most likely in the note field. The
citations use a LaTeX package called biblatex, which has already been installed (Appendix A/13).2 This
draws on a list of the citations you wish to use, which need to be in BibTeX format – see andika/bib/
andika.bib for an example of a short bibliography file. It is possible to write this file using just a text ed-
itor, but it is easier to use a frontend such as JabRef, which has already been installed (Appendix A/14).
With a frontend, you simply type the bibliographic details of the citation into a series of dialogue boxes.
Each citation is referred to by a “key” – I use the name of the first author and the year, so the key for
Sacleux’ Dictionnaire would be Sacleux1939, but you can use anything you like.
Using this dictionary as an example, we can then refer to a citation in the note by using:
\textcite{Sacleux1939}
where the work is a subject:

Sacleux (1939) was a major achievement in Swahili lexicography.
2The older bibtex package does not support citations in footnotes.
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and using:
\parencite{Sacleux1939}
where the work is referred to parenthetically:

This word is found mainly in northern dialects (Sacleux 1939).

The author-year citation style is default, but it can be changed. However, since citation management
and style is a wide-ranging topic not directly relevant to Andika!, this aspect is not dealt with here.
The bibliography file has to be called andika.bib, and has to be in the andika/bib directory. You can
either add your citation details to that file, or delete it and start your own andika.bib. If you need to
use a bibliography file of a different name in a different location, you can delete the existing andika.bib
and set up a symbolic link to your own file. For instance, if your bibliography file were called thesis.bib,
and it was located in /home/USER/thesis (where USER is your username), you would run the following
commands in a terminal open at andika:
rm bib/andika.bib
(delete the existing andika.bib file)
ln -s ~/thesis/thesis.bib bib/andika.bib
(create an andika.bib link (alias or shortcut) to your bibliography file – remember that ∼ stands for
/home/USER)
It is worth noting that in cases where citations are not printed properly, it is virtually always the case
that there is an error in the bibliography file, or that the key being used is incorrect.3

8.5.3 Adding annotations in batches

When working on a long poem, it is often more convenient to add annotations in batches of (say) 20.
This means that your work can be reviewed easily, and typos corrected, without having to scroll through
the whole words table in SQL Workbench, and it also means that generation of the pdf for checking will
be faster, since it only includes a subset of the poem’s stanzas.
To do this, set the query in SQL Workbench to call only the relevant items from the words table. In the
following query, you are working on stanzas 80-100 of jaafari, and need to see only the standard and
edstan fields so that you can add an English translation and any notes that are appropriate:
select word_id, stanza, loc, position, standard, edstan, english, note from jaafari_words
↪→ where stanza between 80 and 100 order by stanza, loc, position;

Skipping ahead a little (see Section 8.7.1), to print out only this batch of stanzas, use the option MtoN :
db/output_pdf.php jaafari 80to100

8.6 Output to pdf

Once the database table holding the words of the poem has been edited to include all the annotations
required, it can be output in a variety of formats. The most important is the pdf format,4 since the LaTeX
typesetting system produces a very attractive, beautifully laid-out text equally suitable for traditional
printing or digital distribution. A variety of layouts is possible (see also Chapter 9) but the default is to
print two vipande to the line, with an asterisk between them.
3I recently spent almost an hour trying to work out why the entry for Abdulkadir and Frankl (2013), key Abdulkadir2013,

was not appearing correctly - there were definitely no mistakes in the bibliography entry. Yet LaTeX reported it could not find
that entry. I tried various increasingly complicated fixes, until eventually I noticed that I had typed the key as Adbulkadir2013
when citing the work. When a problem like this arises, we tend to think that the most likely cause is a fault in the software, but
it is far more likely to be a fault in the wetware connecting the chair to the computer.
4Output to html will be added at a later stage.
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To print your annotated poem in the default layout to a pdf file, run:
php db/output_pdf.php poem_name

The generated pdf will be located in a folder with the same name as your input document – in this case
andika/db/outputs/poem_name.
To demonstrate the layout options, we will use one stanza from the beginning of the Utenzi wa Jaa-
fari. The input document for this is in convert/inputs/egoutput.odt. After converting to database format,
importing the words, and adding an English translation, we can run:
php db/output_pdf.php egoutput

to give andika/db/outputs/egoutput/egoutput.pdf – see Figure 8.1.

يَنْڠُ مَتٖمْبٖزِ كهٖنْدَ * نْدُزَنْڠُ پُلِكَنِ ١
pulikani nduzangu * kenda matembezi yangu 1a/b

Listen, my brothers, I went on a journey.

چَلٗنِجِريَِ قِصَ * زَنْڠُ خَبَرِ نوَِپٖ
niwape habari zangu * qisa chalonijiriya 1c/d

Let me give you my story, an account of what happened to me.

Figure 8.1: Default output

8.7 Output: global display options

The default output in Figure 8.1 can be adjusted in a number of ways by passing various options to
output_pdf.php. Those in this section are “global” options, in that they apply to the poem as a whole.
The next section (Section 8.8) will explain some further options which are “local”, in that they can be
applied to individual words or lines in the poem.

8.7.1 Stanzas to be printed

By default, all stanzas of the poem will be printed out. However, you can print out a contiguous subset
of stanzas by using the option MtoN, where M is the number of the first stanza in the set, and N is the
number of the last stanza in the set. For instance, the following command will print out only stanzas 80
to 100 of the poem jaafari:
php db/output_pdf.php jaafari 80to100

8.7.2 Font size

The default font size for the output is 10pt, which is good for printing. However, if you need a slightly
larger font, you can use the option 12pt to increase font size to 12 pt.
php db/output_pdf.php egoutput 12pt
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يَنْڠُ مَتٖمْبٖزِ كهٖنْدَ * نْدُزَنْڠُ پُلِكَنِ ١
pulikani nduzangu * kenda matembezi yangu 1a/b

Listen, my brothers, I went on a journey.

چَلٗنِجِريَِ قِصَ * زَنْڠُ خَبَرِ نوَِپٖ
niwape habari zangu * qisa chalonijiriya 1c/d

Let me give you my story, an account of what happened to me.

Figure 8.2: Output with larger font size

8.7.3 Changing the location of annotations

By default, all annotations are output as footnotes – since they refer to individual words in the text,
having them on the same page is easier to read. But if you need endnotes instead, you can use the
option endnote to remove the annotations from the bottom of the page, and move them into their own
section after the poem:
php db/output_pdf.php egoutput endnotes

To compare the difference in output, look at Appendix D and Appendix F.

8.7.4 Colours

The Arabic script is printed in green, but this can be changed in output_pdf.php by editing the line:
$colour1="mygreen";

to use one of the default colours (red, green, blue, cyan, magenta, yellow, black, gray, white, darkgray,
lightgray, brown, lime, olive, orange, pink, purple, teal, violet), or a new default colour can be set up
at the bottom of convert/tex/fontdefs.tex.
The first line of Arabic script can be printed in a different colour by using the option firstcolour:
php db/output_pdf.php egoutput firstcolour

giving the output in Figure 8.3. Again, the colour can be adjusted in output_pdf.php by editing the line:
$colour2="blue";

or a new default colour can be set up at the bottom of convert/tex/fontdefs.tex. This option is useful for
setting off lines in Arabic when they occur in the same stanza as lines in Swahili (e.g. in the Burda – see
Section 2.8).
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يَنْڠُ مَتٖمْبٖزِ كهٖنْدَ * نْدُزَنْڠُ پُلِكَنِ ١
pulikani nduzangu * kenda matembezi yangu 1a/b

Listen, my brothers, I went on a journey.

چَلٗنِجِريَِ قِصَ * زَنْڠُ خَبَرِ نوَِپٖ
niwape habari zangu * qisa chalonijiriya 1c/d

Let me give you my story, an account of what happened to me.

Figure 8.3: Option: firstcolour

If no colour other than black is desired in the output, use the option nocolour (see Figure 8.4):
php db/output_pdf.php egoutput nocolour

يَنْڠُ مَتٖمْبٖزِ كهٖنْدَ * نْدُزَنْڠُ پُلِكَنِ ١
pulikani nduzangu * kenda matembezi yangu 1a/b

Listen, my brothers, I went on a journey.

چَلٗنِجِريَِ قِصَ * زَنْڠُ خَبَرِ نوَِپٖ
niwape habari zangu * qisa chalonijiriya 1c/d

Let me give you my story, an account of what happened to me.

Figure 8.4: Option: nocolour

8.7.5 Alignment

As Figure 8.1 shows, the default alignment for the poem text is centred, but this can be changed to
right-justified by using the option alignright (see Figure 8.5):
php db/output_pdf.php egoutput alignright

يَنْڠُ مَتٖمْبٖزِ كهٖنْدَ * نْدُزَنْڠُ پُلِكَنِ ١
pulikani nduzangu * kenda matembezi yangu 1a/b

Listen, my brothers, I went on a journey.

چَلٗنِجِريَِ قِصَ * زَنْڠُ خَبَرِ نوَِپٖ
niwape habari zangu * qisa chalonijiriya 1c/d

Let me give you my story, an account of what happened to me.

Figure 8.5: Option: alignright

The option alignleft is also available, but this is best applied where the Arabic script is not being
printed out (see Section 8.7.6).
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8.7.6 Omitting tiers

Even if an English translation has been added to the words table, it can be omitted by using the option
noenglish (see Figure 8.6):
php db/output_pdf.php egoutput noenglish

يَنْڠُ مَتٖمْبٖزِ كهٖنْدَ * نْدُزَنْڠُ پُلِكَنِ ١
pulikani nduzangu * kenda matembezi yangu 1a/b

چَلٗنِجِريَِ قِصَ * زَنْڠُ خَبَرِ نوَِپٖ
niwape habari zangu * qisa chalonijiriya 1c/d

Figure 8.6: Option: noenglish

The standard transcription can also be omitted by using the option nostandard – adding this to the
noenglish option means that only the Arabic script will be printed (see Figure 8.7). This may be useful
if the Arabic script is being relegated to an appendix, with the standard transcription and/or the English
translation being extracted and typeset separately to form the main text. Since the only remaining tier
is written right-to-left, it may also be appropriate to apply the option alignright. Multiple options can
be passed (in any order) to output_pdf.php by linking them with a plus sign:
php db/output_pdf.php egoutput nostandard+noenglish+alignright

يَنْڠُ مَتٖمْبٖزِ كهٖنْدَ * نْدُزَنْڠُ پُلِكَنِ ١
چَلٗنِجِريَِ قِصَ * زَنْڠُ خَبَرِ نوَِپٖ

Figure 8.7: Option: nostandard+noenglish+alignright

Note that if the standard transcription is suppressed, any footnote numbers attached to it (for variant
readings or notes) will be attached to the Arabic script instead. Also note that no emendations at all will
be shown, since they are assumed to apply only to the standard transcription.
The complement of the example in Figure 8.7 is where you want to print only the standard transcription
and the English translation – the noarabic option will suppress the output of the Arabic script (see
Figure 8.8). Since the remaining tiers are written left-to-right, it may also be appropriate to apply the
option alignleft.
php db/output_pdf.php egoutput noarabic+alignleft

pulikani nduzangu * kenda matembezi yangu 1a/b
Listen, my brothers, I went on a journey.

niwape habari zangu * qisa chalonijiriya 1c/d
Let me give you my story, an account of what happened to me.

Figure 8.8: Option: noarabic+alignleft
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8.7.7 Displaying the close transcription

In the case of older manuscripts where the Arabic script is more of an approximation to the Swahili it
represents, it may be helpful to provide a close transcription as well. This will be printed in the same
colour as the Arabic script above it, and the option close-lr will print it left-to-right (see Figure 8.9).
php db/output_pdf.php egoutput close-lr

يَنْڠُ مَتٖمْبٖزِ كهٖنْدَ * نْدُزَنْڠُ پُلِكَنِ ١
pulikani nduzangu * kʰenda matembezi yangu
pulikani nduzangu * kenda matembezi yangu 1a/b

Listen, my brothers, I went on a journey.

چَلٗنِجِريَِ قِصَ * زَنْڠُ خَبَرِ نوَِپٖ
niwape khabari zangu * qisạ chalonijiriya
niwape habari zangu * qisa chalonijiriya 1c/d

Let me give you my story, an account of what happened to me.

Figure 8.9: Option: close-lr

The option close-rl is also available, and will print the close transcription right-to-left; that is, the close
transcription of each word will appear directly under the Arabic script for that word (see Figure 8.10).
php db/output_pdf.php egoutput close-rl

يَنْڠُ مَتٖمْبٖزِ كهٖنْدَ * نْدُزَنْڠُ پُلِكَنِ ١
yangu matembezi kʰenda * nduzangu pulikani
pulikani nduzangu * kenda matembezi yangu 1a/b

Listen, my brothers, I went on a journey.

چَلٗنِجِريَِ قِصَ * زَنْڠُ خَبَرِ نوَِپٖ
chalonijiriya qisạ * zangu khabari niwape
niwape habari zangu * qisa chalonijiriya 1c/d

Let me give you my story, an account of what happened to me.

Figure 8.10: Option: close-rl

Simultaneously suppressing the standard transliteration will leave only the close transcription – see
Figure 8.11. In this case, as noted above (Section 8.7.6), any annotations giving notes or variants will
be attached to the Arabic script. Note that in this case there is no Roman numbering of the stanzas – if
this is required, an alternative method is suggested below.
php db/output_pdf.php egoutput close-rl+nostandard
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يَنْڠُ مَتٖمْبٖزِ كهٖنْدَ * نْدُزَنْڠُ پُلِكَنِ ١
yangu matembezi kʰenda * nduzangu pulikani

Listen, my brothers, I went on a journey.

چَلٗنِجِريَِ قِصَ * زَنْڠُ خَبَرِ نوَِپٖ
chalonijiriya qisạ * zangu khabari niwape

Let me give you my story, an account of what happened to me.

Figure 8.11: Option: close-rl+nostandard

8.8 Output: local display options

The output options described in Section 8.7 are “all or nothing” – they apply to the whole poem. Andika!
provides a further mechanism to control output when you wish an option to apply only to particular
words or vipande. This is based on the noshow field (Section 8.4.7). By default, this field is empty for each
word, but if a tag is entered in the field, the display of that word can be controlled in detail. Currently,
this covers the transcription output only, but it could easily be extended to handle other aspects of the
display.
The principle can be demonstrated by looking at how to suppress the standard transcription for a word
– let us assume that we want to suppress the printing of matembezi in 1b. To do this, open the words
table in SQL Workbench and put something (anything) in the noshow field – the only condition is that
the something should be less than 10 characters long (you are also recommended to make it at least two
characters long, so that you can’t confuse it with the vipande notation). To focus on what we are doing,
the SQL query will pick out only those fields relevant to this task:
select word_id, stanza, loc, position, arabic, close, standard, noshow from
↪→ egoutput_words order by stanza, loc, position;

In the noshow field alongside matembezi, enter something so that the entry looks like Figure 8.12, and
then press the Save icon or select Data → Save Changes to Database to save this edit.

Figure 8.12: Making an entry in the noshow field

Running output_pdf.php will then print the text with that word missing from the transcription (see Fig-
ure 8.13):
php db/output_pdf.php egoutput



CHAPTER 8. TYPESETTING POETRY 50

يَنْڠُ مَتٖمْبٖزِ كهٖنْدَ * نْدُزَنْڠُ پُلِكَنِ ١
pulikani nduzangu * kenda yangu 1a/b
Listen, my brothers, I went on a journey.

چَلٗنِجِريَِ قِصَ * زَنْڠُ خَبَرِ نوَِپٖ
niwape habari zangu * qisa chalonijiriya 1c/d

Let me give you my story, an account of what happened to me.

Figure 8.13: Suppressing the transcription for a word

In order for omitted words to be shown as having been omitted, output_pdf.php has a preset to mark
them. In SQL Workbench, change “blah” to “omit”, and then save the edit. Running output_pdf.php again
will now show the omitted word’s location with three grey Xs (see Figure 8.14):

يَنْڠُ مَتٖمْبٖزِ كهٖنْدَ * نْدُزَنْڠُ پُلِكَنِ ١
pulikani nduzangu * kenda XXX yangu 1a/b

Listen, my brothers, I went on a journey.

چَلٗنِجِريَِ قِصَ * زَنْڠُ خَبَرِ نوَِپٖ
niwape habari zangu * qisa chalonijiriya 1c/d

Let me give you my story, an account of what happened to me.

Figure 8.14: Omitting a word

8.8.1 Suppressing a line of transcription

It is difficult to envisage an editorial situation in which omitting a single word might be useful, but
suppressing a transcription for all the words in a line might be so in some cases. An example might
be stanzas which contain lines in either Arabic and Swahili (e.g. the Burda) – here you might want to
present the Arabic without transcription and the Swahili with. This can be achieved by making an entry
in the noshow field against all of the words in the line you want no transcription for. If we want to
suppress the transcription for the first line of the sample stanza, for instance, we can enter “ar” against
all of the words in both vipande5 (see Figure 8.15 – in effect, by doing this we are applying the global
nostandard option to that line alone. This gives the output in Figure 8.16. Note that the stanza/kipande
information in the margin is no longer printed, since there is no transcription for it to apply to,
5Strictly speaking, marking the words in just one kipande will suppress the transcription in both – i.e. marking the words in

kipande c will suppress the transcription in d as well as that in c. This is to make the display neater, but it is possible to suppress
only one kipande in the line instead of both – see the note in the output_pdf.php code.
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Figure 8.15: Marking the words of the first line in the stanza

يَنْڠُ مَتٖمْبٖزِ كهٖنْدَ * نْدُزَنْڠُ پُلِكَنِ ١

چَلٗنِجِريَِ قِصَ * زَنْڠُ خَبَرِ نوَِپٖ
niwape habari zangu * qisa chalonijiriya 1c/d

Let me give you my story, an account of what happened to me.

Figure 8.16: Suppressing a line

The “ar” entry is a preset which suppresses both the standard transcription and any English translation.
If you want to retain the translation, you can use another preset, “areng”. Replacing “ar” with “areng”
in the words table, and adding the firstcolour option (Section 8.7.4) gives the output in Figure 8.17. (Of
course, the “nocolour” option can also be applied to change all colours to black.) It would possible to
expand this system to add other actions – for instance, you could add a new trancription system purely
for Arabic, and set “ar” to include processing to insert that specially devised trancription into the close
(or a new) field. If there were a (hypothetical) Swahili commentary on a Farsi poem, the Farsi lines
could be marked “fa”, and a new transcription system devised for Farsi.

يَنْڠُ مَتٖمْبٖزِ كهٖنْدَ * نْدُزَنْڠُ پُلِكَنِ ١
Listen, my brothers, I went on a journey.

چَلٗنِجِريَِ قِصَ * زَنْڠُ خَبَرِ نوَِپٖ
niwape habari zangu * qisa chalonijiriya 1c/d

Let me give you my story, an account of what happened to me.

Figure 8.17: Suppressing a line but retaining a translation

8.8.2 Swapping in the close transcription

However, short of creating a new close transcription, another possibility is to use the existing one
provided by Andika!, perhaps editing it as necessary by making entries in the edclose field (see Sec-
tion 8.4.1). You can do this by using the option swapclose, which inserts the close transcription instead
of the standard transcription in any line where the words have an entry in the noshow field. (Note that
swapclose will have no effect if there is no entry in the noshow field - in that case, the standard tran-
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scription will be printed out as normal.) The example in Figure 8.18 uses the “areng” entry against the
words in line 1 – the English translation could also be suppressed by changing that entry to “ar”.
php db/output_pdf.php egoutput swapclose

It is worth noting that swapping in the close transcription can be used for any lines where there is a
relevant entry in the noshow field – i.e. it does not just apply to vipande a and b.

يَنْڠُ مَتٖمْبٖزِ كهٖنْدَ * نْدُزَنْڠُ پُلِكَنِ ١
pulikani nduzangu * kʰenda matembezi yangu 1a/b

Listen, my brothers, I went on a journey.

چَلٗنِجِريَِ قِصَ * زَنْڠُ خَبَرِ نوَِپٖ
niwape habari zangu * qisa chalonijiriya 1c/d

Let me give you my story, an account of what happened to me.

Figure 8.18: Swapping in the close transcription

8.8.3 Making entries in the noshow field

It is easy to run an SQL query to add tags to each noshow field:
update egoutput_words set noshow='ar';

to delete all of them:
update egoutput_words set noshow='';

or to change one to another:
update egoutput_words set noshow='ar' where noshow='areng';

To simplify adding tags to each noshow field, Andika! provides a helper script, manage_noshow.php. (It
is also possible to use SQL queries directly on the words table itself, but the script makes things a little
faster.) Arguments are passed to the script in the following order:

1. Name of the poem (i.e. the words table shorn of _words).
2. The action to be taken. Two actions are possible: fill (to insert tags), and clear (to remove them).
3. The stanzas to be targetted. There are two possibilities: all, which will apply a tag to the words
in every stanza in the poem, or a list of stanzas. The latter is a comma-separated list of numbers
with NO spaces, which can also include ranges separated by a hyphen. For instance, 2,5,6 would
target those three stanzas, while 4,6-8,10-13,17,20 would target the stanzas 4, 6, 7, 8, 10, 11, 12,
13, 17 and 20.

4. The locations (vipande) to be targetted. This is a comma-separated list of lower-case letters with NO
spaces, which can also include ranges separated by a hyphen. For instance, a,b or a-b would target
vipande a and b, while c-d,g-h would target vipande c, d, g and h. This argument can be omitted
if you are using the default tag “ar” – if vipande within the stanza are not specified, the “ar” tag
will be applied to the words in every kipande in that stanza. HOWEVER, if you are specifying a tag
other than “ar”, you must include this argument.

5. The tag to be inserted, e.g. ar, areng, omit, or a tag of your own devising. This argument can be
omitted, in which case the default tag “ar” will be used. With the clear action, no tag is necessary,
but if one is given it will be ignored.
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Some examples follow:
Add an “ar” noshow tag to every word in the table poem_words (remember that the “ar” tag is applied by
default if no tag is specified):
php db/manage_noshow.php poem fill all6

Delete all noshow tags from the poem_words table:
php db/manage_noshow.php poem clear all7

Add an “ar” tag to every first line (specifying “ar” is optional):
php db/manage_noshow.php poem fill all a,b ar8

Add an “areng” tag to every third line:
php db/manage_noshow.php poem fill all e-f areng9

Change all tags in the third line (“areng”) to another (“mytag”):
php db/manage_noshow.php poem fill all e-f mytag10

Add an “ar” tag to every word in stanzas 1, 3 and 5:
php db/manage_noshow.php poem fill 1,3,511

Add an “areng” tag to every word in stanzas 2, 4 and 6 – assuming 6 vipande in each stanza (remember
that if you are using a tag other than the default “ar” you not only have to specify that, you also have
to specify the vipande):12

php db/manage_noshow.php poem fill 2,4,6 a-f areng13

Add an “ar” tag to the first line of stanzas 6, 7, 8, 11, 12, 13 and 21:
php db/manage_noshow.php poem fill 6-8,11-13,21 a-b14

6SQL: update poem_words set noshow='ar';
7SQL: update poem_words set noshow='';
8SQL: update poem_words set noshow='ar' where loc in ('a', 'b');
9SQL: update poem_words set noshow='areng' where loc in ('e', 'f');
10SQL: update poem_words set noshow='mytag' where loc in ('e', 'f'); or: update poem_words set noshow='mytag'

where noshow='areng';
11SQL: update poem_words set noshow='ar' where stanza in (1, 3, 5);
12If you accidentally omit the vipande locations, there’s no harm done – no changes will be made to the table.
13SQL: update poem_words set noshow='areng' where stanza in (2, 4, 6) and loc in ('a', 'b', 'c', 'd', 'e',

'f');
14SQL: update poem_words set noshow='ar' where stanza in (6, 7, 8, 11, 12, 13, 21) and loc in ('a', 'b');



Chapter 9

Typsetting multiple versions of the same poem

[Draft – to be revised]
Information on aligning stanzas and printing them out, with especial attention to tenzi.

9.1 Set up a manuscript information table

First, run:
php ms/create_mslist.php <name of poem>

which sets up a table to hold key information about the MSs: the name of the table holding the database
version of that MS, the code (id) for that MS, and the colour you want the MS text printed in. Once the
table is set up, add this information manually (eg using SQL Workbench). MS identifiers can be entered
in either uppercase or lowercase, but they will be changed to all lowercase by init_runord.php (because
having single capitals as table names causes problems in PostgreSQL).

9.2 Set up a running order table

Then create a table to hold the running order for all the MSs, and fill it with one of the MS’s stanza
numbers.
php ms/init_runord.php <name of poem> <MS code>

It doesn’t particularly matter which MS you choose to input as the reference MS here, but it’s probably
best to input whatever one you consider ”primary”, since it will be the one against which data from the
other MSs is entered. The primary MS might be the longest, or the most important, the most ”poetic”,
or whatever.

9.3 Add manuscript data to the running order table

For each MS other than the primary one, manually align its stanza numbers to those of the primary MS:
php ms/runord.php <name of poem> Yn[-n] action Xn

This assumes that you have inspected the different MSs, and know which stanzas in each you want to
select or align. Using the options passed in to the script, stanza numbers will be inserted or deleted to give
a ”running order” of the ”best bit” stanzas from all the MSs (sequential), or giving analogue stanzas from
each MS (parallel). The combined MS will be printed with the provenance of the different stanzas noted
by means of font, fontsize, or colour. For ballads (tenzi), for instance, you can use db/stacktenzi.php.
X will usually be the reference MS, and Y is the MS you want to align with it. The MS ids can be given as
either lowercase or uppercase - the latter is easier to read, but the MS ids will be changed to lowercase
anyway.
n is a number or range of numbers (n-n) specifying (for Y, the new MS) the stanza or stanza span to be
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inserted (the splice), or (for X, the reference MS) the insertion point (the target).
Yn[-n] insert Xn – insert stanza n or stanzas n-n from Y AFTER the insertion point Xn. This generates a
gap in stanza numbers for X that occur after the insertion point.
Yn[-n] prefix Xn – insert stanza n or stanzas n-n from Y BEFORE the insertion point Xn. This generates
a gap in stanza numbers for X that occur before the insertion point.It is recommended to use ”insert”
preferentially, and keep ”prefix” for situations where space needs to be created at the head of the table,
eg to allow stanzas to be added which precede the reference MS’s running order.
Yn[-n] align Xn – paste stanza n or stanzas n-n from Y alongside existing stanzas in X, starting at the
insertion point Xn.
After each action, a unified running order is produced, which represents the consolidated order of all
stanzas in all the MSs. This can be used in two ways:
(a) Aligned (stacked): Step through the running order, and for each stanza number print out aligned
stanzas from each MS. This provides output where all the MSs can be compared in detail.
(a) Sequential: Step through the running order, and for each stanza number print out the equivalent
reference MS stanza. Where one does not exist, print out the equivalent stanza from one of the other
MSs. This provides output where the story content can be more fully appreciated.
Although X will usually be the reference MS, it can be any of the MSs - for instance, if MS A starts at
stanza number 1, which is equivalent to stanza 5 in MS B, you would run (see below):
php ms/runord.php <name of poem> B1-4 prefix A1

to insert the first 4 stanzas from B in front of the existing A stanzas. If you then had another MS C where
stanza 3 was equivalent to stanza 1 of B, you could then run:
php ms/runord.php <name of poem> C1-2 prefix B1

to insert the first 2 stanzas from C in front of the existing B stanzas.



Chapter 10

Computer-aided analysis of poem texts

[Draft – to be revised]
Using queries on the words table to assist the analysis of the poem, adding new annotations as necessary.

10.1 Additional annotation fields

10.1.1 root field

Recording the root of the word is useful for building concordances, frequency lists, etc. Instead of having
to search for different forms of the word, it is possible to search on the root and have all forms presented.
For Bantu words, use the stem minus any elements such as class prefixes, verbal -a or verbal extensions.
Thus fik would find akafika (he arrived), watafikia (they will arrive at), mfiko (arrival), and so on.
For Arabic words, use the triconsonantal root 1.(جذر) Thus klm would find katakalama (he spoke),
kalima (word), and so on.
Ideally, the roots would be filled in automatically during import by looking up the word against a
digital Swahili dictionary, such as the one used for my Swahili verb segmenter.2 That dictionary is not
yet extensive enough for that purpose.

1en.wikipedia.org/wiki/Semitic_root
2kevindonnelly.org.uk/swahili/segmenter. The dictionary here is a heavily-customised version of Beata Wójtowicz’s

English-Swahili dictionary at freedict.org.
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Appendix A

Installing Andika!

I am grateful to Natalie Kontny, Student Assistant on Project C07, The Place of Swahili Manuscripts in
East African Collections, at the University of Hamburg’s Centre for the Study of Manuscript Cultures,1
for road-testing these instructions and helping to write them up.

A/1 How much of this do I need to do?

If you simply wish to be able to type Swahili in a word-processor, you need not go through the full
installation procedure in this appendix. After installing Ubuntu, you only need to follow Appendix A/6.1,
move into the unzipped download, and then follow Appendices A/7 to A/9.
However, if you wish to transcribe, edit and annotate Swahili documents in Arabic script, providing
Roman equivalents as well, then you will need to carry out the full installation procedure here. The
reason there is so much to install is that Andika! tries not to reinvent the wheel – rather, it combines
already-existing best-of-breed software to do new things.
Most of the install is carried out by typing in commands directly. This is because this method is much
faster and more succinct than explaining how to point-and-click through various dialogue boxes.

A/2 Ubuntu Linux

Andika!was developed on Ubuntu 14.04,2 a variety of GNU/Linux,3 a secure and free operating system.
“Free” here means not only that it is available at no cost (free as in beer), but also that the user is free
to copy, change and distribute it without fear of copyright lawsuits (free as in freedom).4 Ubuntu is a
user-friendly packaging of a wide variety of software which is suitable for any computing need – the
name is a Southern Bantu cognate of the Swahili utu, and means “humanity” or “humanness”: it is
intended to emphasise that the free software concept of sharing brings out the best in all of us.
You can download the current 64-bit5 version of Ubuntu 14.04 from http://www.ubuntu.com/download/
desktop6 You can install Ubuntu as the sole operating system on a computer (highly recommended),7
or install it alongside an existing operating system so that you can “dual-boot” into either operating
system.8

Another possibility is to run Ubuntu inside your existing operating system, as a “virtual machine”. This
will work well on most machines, though there may be issues with some, and it is always less efficient
than running Ubuntu directly “on the metal”. Notes on installing a virtual machine are in Appendix A/4.
1www.manuscript-cultures.uni-hamburg.de/Projekte_e.html
2ubuntu.com
3en.wikipedia.org/wiki/Linux
4fsf.org
5Most modern machines should be 64-bit capable.
6Although versions such as 15.04 are now available, it is best to stick to 14.04, since this is a Long Term Support release which

will be supported for 5 years.
7ubuntu.com/download/desktop/install-ubuntu-desktop
8Doing an internet search on “dual-boot Ubuntu” should produce a number of guides, such as the one at linux.about.com/

od/LinuxNewbieDesktopGuide/ss/The-Ultimate-Windows-81-And-Ubuntu-Dual-Boot-Guide.htm
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A/3 Conventions

Unless otherwise indicated, lines in
monospaced font
are commands to be typed in.
Unless otherwise indicated, all commands should be activated by pressing Return at the end of the
command.
The symbol ↪→ at the beginning of a line means that it is a continuation of the previous command, and
therefore Return should only be pressed after the end of this line.
Keys separated by + should be pressed simultaneously. Thus Ctrl+X means “press the Ctrl key at the
same time as the X key”.
When a command starts with sudo, you will be asked to type in your superuser (administrative) pass-
word, which you should have been asked to set up when you first installed Ubuntu, before the command
is allowed to proceed. Note that you will get no feedback from the password entry (the line will stay
blank) until you press Return.
If at any point the system suggests adding other packages (called dependencies) based on the ones you
are installing, accept those suggestions by pressing Y or typing yes.
Unless otherwise indicated, it is assumed that all commands are run from the suggested base directory
of the Andika! software, /var/www/andika – see Section A/6.

A/4 Running Ubuntu as a virtual machine

As noted above, this option is less versatile than a proper install of Ubuntu, so the following notes do
not attempt to cover every issue.9

Install the version of Oracle’s VirtualBox software10 appropriate for your operating system. Once in-
stalled, open VirtualBox Manager and click the icon forNew. Fill in Andika against Name, Linux against
Type and Ubuntu (64 bit) against Version. Click Next. As the memory amount, set 2000Mb if you have
at least 3Gb memory in your machine – raise the level if you have more memory (if you have less mem-
ory you will need to accept that VirtualBox may not run very well. Click Next. Tick Create a virtual
harddrive now. Click Next. Tick VDI. Click Next. Tick Dynamically allocated. Click Next. Set 40Gb
as the virtual hard drive size if you have a hard drive of at least 300Mb. Click Create.
You have now set up a virtual machine, and the next step is to install Ubuntu on it. Click the new Andika
entry in the left-hand pane so that it is highlighted. Click the icon for Start. You will be asked to select
a startup disk. Click the folder icon to the right of the textbox to navigate to wherever you stored your
download of Ubuntu 14.04. Click OK. Click Start. The Ubuntu boot process will start, and after a couple
of minutes you should see an screen with two large icons on it. Click Install Ubuntu. Click through the
screens, accepting the defaults. It is important to make a note of your username and password. After
about 20 minutes, you should have a new Ubuntu install using the Unity desktop.
However, the screen resolution is limited to 800x600. To get higher resolutions, you need to install
VirtualBox’s Guest Additions. In the running Andika instance of Ubuntu, press Ctrl+Alt+T to get a
command-line terminal. Update the lists of software packages on the machine:
sudo apt-get update
entering your password when requested (the one you entered during the Ubuntu install). Then upgrade
any software packages to the most recent available versions:
sudo apt-get upgrade
9In particular, running Ubuntu as a guest on an Apple Mac OS X host throws up some keyboard problems – it is unclear how you

access the | (pipe) and \(backslash) keys on an Apple keyboard when you need to use them in Ubuntu. In an Apple UK keyboard
they are accessed respectively by Shift+Alt+L and Shift+Alt+/, but these keystrokes do not work in virtual machines.
10virtualbox.org
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Note that this may take 15-20 minutes, depending on your system. Install software that the system will
use to build other software:
apt-get install dkms
apt-get install build-essential

Now, click Devices on the menu-bar of the VirtualBox software on your host machine, and select Install
Guest Additions. A CDROM icon will appear on the Ubuntu desktop – click on it to install the additional
software. Once completed (which may take 5 minutes or so), shutdown the Ubuntu Andika instance by
closing the window it is running in. Then restart Andika again from VirtualBox. If you now resize the
Andika window, or select Fullscreen mode in VirtualBox, you should get the full resolution possible on
your screen.

A/5 Change the desktop to KDE

Once you have Ubuntu installed (whichever method you choose), you can go on to install Andika!.
Ubuntu comes by default with a desktop called Unity,11 but a variety of different Linux desktops are
available, of which perhaps the most popular is KDE.12 Since KDE is easier to work with, it is a good
idea to change the desktop to KDE (though this is not essential).
Open a terminal (Ctrl+Alt+T on Unity), and update all software:
sudo apt-get update
sudo apt-get upgrade

Then install KDE:
sudo apt-get install kubuntu-desktop

Note that this may take some time to complete.
Log out of Unity by pressing the wheel icon at the top right of the screen, and at the login screen select
KDE as your preferred desktop by clicking on the Ubuntu symbol above the login box.
Once you have logged in to KDE, right-click the K on the lower left of the screen and select Switch to
Classic Menu Style. You can then bring up a terminal by selecting K → System → Konsole. You can
also drag the menu entry to the panel at the bottom of the screen to allow for faster access.

A/6 Download Andika!

A/6.1 Option 1: snapshot

The Andika! software is available from the ThinkOpen website. The second-best option is to download
an archive by going to http://thinkopen.co.uk/git/andika, and clicking on the ZIP or TAR buttons. Save
the archive to your home directory (/home/USER – USER here stands for the username you set up when
you installed Ubuntu; replace it with your actual username) and uncompress it to create an andika folder
there:
cd ~
(The tilde is a shortcut for /home/USER.)
For a zip file:
unzip -q andika-xxxxxx.zip
The xxxxxx segment needs to be replaced with whatever is in the name of the file you download.
For a tar file:
11unity.ubuntu.com
12kde.org
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tar -xf andika-xxxxxx.tar
The xxxxxx segment needs to be replaced with whatever is in the name of the file you download.

A/6.2 Option 2: easy update

The above option will give you a snapshot of Andika! at the time you downloaded it, but since Andika!
is a work-in-progress, it is likely to change. A much better option, if you want to keep up with any
changes, is to use Git, which keeps track of changes made to files. Many free and open-source software
projects use Git to ensure that software developers and users can always access the most up-to-date
version of the software they are working on or using.
Git is installed by default in Ubuntu. You can run:
sudo apt-get install git
if you want to check that it is installed. If so, you should get a message saying:
git is already the newest version
If not, it will be installed.
Move to your home directory (/home/USER – USER here stands for the username you set up when you
installed Ubuntu; replace it with your actual username) and download Andika!:
cd ~
(The tilde is a shortcut for /home/USER)
git clone https://github.com/donnekgit/andika.git

After a minute or two, Andika! will be downloaded into an andika folder in /home/USER.
In the future, if you want to update Andika!, you can open a terminal in the andika folder and type:
git pull
Git will automatically update those parts of Andika! which have been changed.

A/6.3 Move the andika directory

We are going to move the working directory for Andika! to a location which will allow you to access a
local copy of the website pages (kevindonnelly.org.uk/swahili) should you wish (see Section A/16 below).
The /var/www directory is the default location for storing webpages on your machine.
sudo mv andika /var/www/
(note the final slash)
Give yourself ownership of the /var/www directory (by default, ordinary users are not allowed to access
this):
sudo chown -R USER.USER /var/www/

Remember, USER here stands for your username, which you set up when you installed Ubuntu. For
instance, here I would type:
sudo chown -R kevin.kevin /var/www/

Set up a link from your /home/USER directory to the /var/www/ directory:
ln -s /var/www/ web

If you go to your home directory in a file manager (in KDE K→ System→Dolphin; in Unity, the second
icon on the left-hand side, the one with a file on it), you will see an entry for web. If you click this, it
will actually take you to /var/www/. This makes access to the webpage directory quicker and easier.
Move into the andika directory for the rest of the installation:
cd web/andika
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You can check the layout of the directories and files by listing them:
ls

A/7 Install fonts

A number of default fonts is used in printing the output from Andika!, and these need to be installed.
The most important font, Scheherazade,13 created by Bob Hallissy and Jonathan Kew, is a Naskh-style
font used for the Arabic text. The version available by default from Ubuntu is somewhat old, so it is
preferable to use SIL’s own package collection to get the latest package. SIL has a page with instructions
on how to do this for the Unity desktop,14 but as usual it is quicker to use the terminal.
Fetch the authentication key:
wget http://packages.sil.org/sil.gpg

Add the key:
sudo apt-key add sil.gpg

Add the SIL repository to the list of repositories used by your Ubuntu install:
sudo add-apt-repository "deb http://packages.sil.org/ubuntu trusty main"

If you are not using 14.04 (codenamed Trusty Tahir), change trusty accordingly. To find the codename
of your version, use:
lsb_release -sc

Update the software package lists to include software from the new repository:
sudo apt-get update

Remove the authentication key:
rm sil.gpg

We can now install all the fonts:
sudo apt-get install fonts-sil-scheherazade fonts-hosny-amiri fonts-liberation
↪→ fonts-linuxlibertine

Amiri,15 created by Khaled Hosny, is an alternate Naskh-style font – it is not currently used in Andika!,
but could be a possible alternative to Scheherazade – see Section 4.4.
Liberation Serif16 in the fonts-liberation package is a tidy font used for the English translation in poetry.
Linux Biolinum O17 in the fonts-linuxlibertine package is especially good at handling diacritics, so it is a
good choice for a close transcription into Roman script.
Use your desktop’s font installation utility18 to install the GranadaKD font in andika/fonts – this is a
Kufic-style font from Arabeyes19 that has been adapted by me to add the characters necessary for it to
be used for Swahili. It is used in Andika! for poem titles.
All of the fonts used by Andika! can be changed – see Section 4.2.
13scripts.sil.org/cms/scripts/page.php?item_id=Scheherazade
14packages.sil.org
15amirifont.org
16fedorahosted.org/liberation-fonts
17linuxlibertine.org
18In KDE, K → System → System Settings → Font Management.
19openfontlibrary.org/en/font/granada
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A/8 Set up a new language and keyboard

Move the keyboard definition file to the appropriate location.
sudo cp layout/tz /usr/share/X11/xkb/symbols/

A/8.1 Activate the new keyboard in KDE

Click on K→ Settings→ System Settings.
In the settings dialogue, click on Input Devices→ Keyboard.
On the Layouts tab, tick Configure layouts, and then click Add.
Fill in the pop-up dialogue as shown in Figure A.1.20

Figure A.1: Setting up the Swahili keyboard for KDE

Click OK, and then Apply to exit.
You should now see an additional marker in the system tray at the bottom right of your screen, which
will be the abbreviation for the default language on your desktop. For instance, if you have UK English
as the default, you will see gb. Click on this, and it will change to tz, showing that the keyboard for
Swahili in Arabic script is now operational. You can quickly switch between the two keyboards by
pressing Ctrl+Alt+K.
Close the System Settings box.
Note that if you make changes to the keyboard layout, you need to re-apply the layout – see the end of
Appendix C.

A/8.2 Activate the new keyboard in Unity

If you have decided to stick to Unity as your desktop, click the System Settings icon in the Launcher,
or click the system icon in the top right-hand corner and select System Settings.
Click Text entry in the Personal section.
20Swahili (Kenya) can be chosen instead of Swahili (Tanzania) if preferred.
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Click on the + at the bottom of the left-hand pane, Input sources to use.
Roll down to Swahili (Tanzania).
Click on it and then click Add.
Close the Text entry box.
There should be a new icon on the menu bar. Either Click on the language chooser icon on the menu
bar and choose Swahili from the list. Alternatively, press Super (usually the key with a Windows logo
on it)+ Space.

A/8.3 Interaction with the unlock screen in KDE

If you have the unlock screen activated, this means that when you leave your machine for some time, it
will power down the screen and then, when you resume work, present a login box so that you can unlock
the desktop. A problem arises if you changed the keyboard to Swahili before leaving your machine –
since the machine was powered down with that keyboard active, the login box will only allow you to
type Arabic glyphs, which means that you cannot type in your (Roman glyph) password!
The easiest way to deal with this is to disable the unlock screen by going to K → Settings → System
Settings → Power Management → Advanced Settings, and unticking Lock screen on resume.
If for some reason you wish to retain the lock screen, you can recover from this situation whenever it
occurs by pressing Crtl+Alt+F5 to get a terminal login. Type your username and password to log in.
Open the configuration file for the keyboard:
nano ~/.kde/share/config/kxkbrc

Find the line:
LayoutList=gb,tz
and change it to:
LayoutList=gb

Save the file: Ctrl+X, Y, Return.
(The example here uses the UK English keyboard, gb – replace this with whatever your own default
keyboard is.)
Press Ctrl+Alt+F7 to return to the unlock screen. Click the login box, and you should be able to login
as normal. However, you will need to re-add the Swahili keyboard as shown above.

A/9 LibreOffice

LibreOffice, installed by default in Ubuntu, is a suite of office software (word processor, spreadsheet,
presentation program, etc). The version used here is 4.2.4.2.

A/9.1 Configure the word-processor

Open LibreOffice Writer.
Click on Tools → Options → Language Settings → Languages.
Under Default languages for documents, tick Complex text layout (CTL), and select Arabic (Oman) in
the dropdown. Click OK.
Click on Tools → Options → Language Settings → Complex Text Layout.
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If you wish to use both Arabic-Indic numerals (on the numeral keys) and Western-Arabic numerals
(AltGr+numeral), ensure Arabic or System is chosen here. The other two settings will convert Western-
Arabic numerals to their Arabic-Indic equivalents.
Tick Visual under Cursor control, and then OK.
Right-click on the toolbar, and under Visible buttons select LTR. Do the same to select RTL. Two new
buttons will now appear in the Formatting toolbar, one for left-to-right typing, and one for right-to-left
typing.
Shortcuts are Ctrl+Shift+A for LTR and Ctrl+Shift+D for RTL.

A/9.2 Install a template

Andika! includes in andika/libreoffice a template (andika.ott) where styles for Swahili in Arabic script,
Swahili in Roman script (standard spelling or close transcription) and translation are already set up –
all these styles are right-justified. Installing the template is optional, but it will make typing out Swahili
poetry much simpler.
Click on File → Templates → Manage.
On the Documents tab, double-click My Templates and then click Import.
Navigate to andika/libreoffice/andika.ott and click on it – it should now be listed there as a template.
If you want to set it as the default (nothing has been changed from the stock default apart from the
addition of the three extra styles), click on it and then click Set as default.
To use the template without setting it as default, select File → New → Templates → andika.
Close the Templates box, and then restart LibreOffice Writer.
To use the styles, place the cursor in the line you wish to format, press F11 to open the Styles and
Formatting list, and select the relevant style by double-clicking on its name – the new styles are at the
bottom of the list.
Arabic style is RTL, Scheherazade 24pt. You may wish to make the font size smaller. In unvocalised
Arabic, reading the text is possible at quite small font sizes. In Swahili, however, the vowel signs are
essential, so the same reductions in font size are not possible. In typesetting poetry, the lines are usually
short, and accuracy is improved by having a large font size.
Roman style is LTR, right-justified, Liberation Serif 12pt.
Translation style is LTR, right-justified, Liberation Serif 12pt, italic.
Obviously, the appropriate writing system (Arabic or Roman) also has to be selected on the keyboard
before typing (see Appendix A/8).

A/10 PHP

PHP is a computer language which is used to convert text from one script to the other, and also for the
import and export of text to and from the database.

A/10.1 Install PHP

sudo apt-get install php5 php5-cli
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To test the install:
php --version
(note: two dashes)
You should get a message giving details about the version of PHP you’ve just installed.

A/10.2 Configure PHP

sudo nano /etc/php5/cli/php.ini

This command will open the system file php.ini in a lightweight text editor called nano, where you have
to change some settings. Use the arrow keys on the keyboard to move around, and the Home and End
keys to move to the beginning or end of a line.
Press Ctrl+W, then type
max_execution_time
into the searchline and press Return. Change the line to read:
max_execution_time = 300

Again press Ctrl+W, type
error_reporting
and press Return. Change that line to:
error_reporting = E_ALL & ~E_NOTICE & ~E_DEPRECATED

A bit lower down from that (you can scroll down using the mouse), there is a display_errors line. Change
it to read:
display_errors = On

Below that there is a log_errors line. Change it to read:
log_errors = Off

To save the file, press Ctrl+X, then press Y to confirm you want to save the modifications, and press
Return to close the file.

A/11 PostgreSQL

PostgreSQL is a database which is used to store the words of the text for editing and enhancement.

A/11.1 Install PostgreSQL

sudo apt-get install postgresql postgresql-client postgresql-common

↪→ postgresql-contrib php5-pgsql

To test the install:
psql

You should get an error message saying that the role named after your username does not exist.

A/11.2 Set up a database user

On Ubuntu, PostgreSQL uses peer authentication by default. This means that creating a database user
with the same name as your system (Ubuntu) user will mean you can log in to the database without
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entering a password.21 The terminal prompt should tell you what your username is – it is of the form
user@computer. Alternatively, you can run:
whoami
to find out your username.
sudo -i

The prompt will change to show that you are now root (the superuser, or administrator).
su - postgres
(note the space on either side of the dash)
The prompt will change to show that you are now the postgres master user.
Create a new database user with the same name as your system user (replace USER with your system
username):
createuser -P -s -e USER

You will be asked to enter a password – note that you will get no feedback (the line will stay blank).
Press Return and you will be asked to enter the password again. Press Return and you should get a
message beginning CREATE ROLE, meaning that the new user has been created.
exit
to cease being the postgres user.
exit
to cease being the superuser.

A/11.3 Set Andika! to use your database user

nano andika/config.php

Change:
user=kevin password=kevindbs
to read:
user=USER password=yourpassword
and save the file (Ctrl+X, Y, Return).
Remember to replace USER with your username.

A/11.4 Create the andika database

createdb andika

This creates the andika database, owned by your new user.
Andika! comes with starter data in andika/db/starter/andika.sql, which can be imported into the new
database:
psql -d andika < db/starter/andika.sql

If you chose a username other than dbmaster, use that instead.
21If for security reasons you wish to enter a password each time your user accesses a database, open the configuration file: sudo

nano /etc/postgresql/9.3/main/pg_hba.conf. Find the line: local all all peer and change it to read local all all md5.
Save the file: Ctrl+X, Y, Return. Restart PostgreSQL: sudo service postgresql restart. You will now need to enter your
database password even to connect to the database under your system username.
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A/11.5 Connect to the andika database

psql -d andika

The prompt should change to andika=#.
\dt
(= display tables)
This should show a list with 18 rows, each representing a database table holding poem information in
the andika database. To look at the table for the poem kiswahili:
select * from kiswahili;
(note: the semicolon at the end is an integral part of the command)
This will show everything in the kiswahili table. Exit the data display and go back to psql:
q

To see something more selective:
select * from kiswahili where stanza=1 order by stanza, loc;
(again, remember the semicolon at the end)
You should get a listing of the vipande in the first stanza of the poem Kiswahili from the Abdulkadir and
Frankl paper, in order of kipande. Exit the data display and go back to psql:
q

\q
to exit psql.

A/12 Database interfaces

Tomake it easier to read and edit the contents of the PostgreSQL database, it is best to install an interface.
Two of these will be installed, each differing in their capabilities. The first is a web-based interface called
phpPgAdmin, which first requires a webserver (Apache) to be installed. The second interface is called
SQL Workbench, and it requires a computing language called Java to be installed.

A/12.1 phpPgAdmin

Install Apache

sudo apt-get install apache2 apache2-utils phppgadmin

Start the webserver:
sudo service apache2 start

If you want to get rid of the (harmless) message Could not reliably determine the server’s fully qualified
domain name, using 127.0.1.1. Set the ‘ServerName’ directive globally to suppress this message, issue the
following commands:
echo "ServerName localhost" | sudo tee /etc/apache2/conf-available/servername.conf
sudo a2enconf servername
sudo service apache2 restart

Test the install – open a web browser (preferably Firefox) and type:
http://localhost
into the address bar. A page should open, telling you that Apache is installed and working.
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Configure phpPgAdmin

Activate the phpPgAdmin configuration file:
sudo cp /etc/apache2/conf.d/phppgadmin /etc/apache2/conf-enabled/phppgadmin.conf

Restart the webserver:
sudo service apache2 restart

In the web browser, type
http://localhost/phppgadmin
into the address bar.
You should see the phpPgAdmin homepage. On the left side there is a list of servers (in this case, there
should only be one listed). Click on PostgreSQL and you should get a login form.
Fill in the username and password for PostgreSQL (which you created in Appendix A/11.2) and click
Login.
The default session time for PHP is set to 24 minutes (1440 seconds). This means that if you do not use
phpPgAdmin for 24 minutes, it will ask you to log in again before you can continue using it. If you find
that this interrupts your workflow, you can change the setting in the PHP configuration file:
sudo nano /etc/php5/apache2/php.ini

Press Ctrl+W, then type:
session.gc_maxlifetime

and press Return. Change the line to read:
session.gc_maxlifetime = 144000

This will allow you 40 hours before logging you out, which should be sufficient.

Test phpPgAdmin

In the left-hand panel you should get a list of your current databases – there should only be two: andika
and the system database postgres. (The right-hand panel shows you the same two databases.)
Click the + beside andika in the left-hand panel. It should open to show Schemas, public, Tables etc.
Click on Tables. The right-hand panel should now show you all the tables inside the andika database,
similar to what you saw in Section A/11.5.
Click on kiswahili and you will see the data fields in that table. To see the contents of the database you
can click on the Browse button.
To see the data fields of each item in more detail, click on the Edit button beside each row in the table
– changes to the fields can be made and saved here.
To make a database query, click the SQL link at the top right of the phpPgAdmin window. This will
open another smaller window. In the large textbox, type:
select * from kiswahili where stanza=1 order by stanza, loc;
(again, remember the semicolon at the end)
Click Execute, and in the first window you should see a listing of the vipande in the first stanza of the
poem, in order of kipande, as you did in Section A/11.5. In this case, though, the contents are a lot easier
to read!
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A/12.2 SQL Workbench

Install Java

Andrei Alin22 maintains links to up-to-date versions of Java in his software repository.
Check that the helper script add-apt-repository is installed:
sudo apt-get install software-properties-common

Add the new software repository:
sudo add-apt-repository ppa:webupd8team/java

Update the software package lists to include software from the new repository:
sudo apt-get update

Install the Java installer:
sudo apt-get install oracle-java8-installer

This installs a script that then downloads and installs Oracle Java 8 – it may therefore take a fewminutes.
To test the install:
java -version
This should return some text telling you that the Java version is 1.8.0.
Set the Java environment variables:
sudo apt-get install oracle-java8-set-default

Install JDBC

JDBC (Java DataBase Connector) is a driver which will allow SQL Workbench to connect to the Post-
greSQL database.
sudo apt-get install libpostgresql-jdbc-java

Install SQL Workbench

Create a directory to hold the files:
mkdir sqlworkbench

Go to the website sql-workbench.net, click on the link for Build 116 (or whatever the current stable version
is), and download the generic package. Save it in the andika directory.
Unzip the download into the new directory:
unzip -q Workbench-Build116.zip -d sqlworkbench

Make the launch script executable:
chmod +x sqlworkbench/sqlworkbench.sh

Launch SQL Workbench:
sqlworkbench/sqlworkbench.sh

If you wish, you can make a desktop shortcut or menu entry to make launching SQL Workbench easier.

Configure SQL Workbench

A Select Connection Profile box should come up.
22webupd8.org
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Change New profile to read andika.
Click the drop-down arrow on the Driver line and select PostgreSQL. Click Yes, when you’re asked
whether you want to edit the driver definition.
On the Manage Drivers popup, click on the red postgresql entry already there and then click X to delete
it. Click on the folder icon and navigate to /usr/share/java/postgresql-jdbc4-9.2.jar (which you installed
in Section A/12.2. Click Open, and then OK.
Check that the URL line reads jdbc:postgresql://localhost:5432/andika – if not, edit it to make it so.
Enter your PostgreSQL username and password (Section A/11.2), and then click OK. You should get a
connecting message.

Test SQL Workbench

The main screen consists of a top pane where you type database queries, and a bottom pane where the
results will appear.
In the top pane, type:
select * from kiswahili where stanza=1 order by stanza, loc;
(remember: the semicolon at the end is an integral part of the command)
Move the cursor somewhere in the middle of that query and press Ctrl+Return. In the bottom pane,
you should see a listing of the vipande in the first stanza of the poem, in order of kipande, as you did in
Sections A/11.5 and A/12.1.
The main benefit of SQL Workbench compared to phpPgAdmin is that a result set can be directly edited
– this makes it easy to add data. To try this, select one of the cells under the english column, type
something in, and press Return. A yellow diamond will appear in the leftmost column, showing that
the record has been edited but not saved yet. To save it you need to click the disk icon, or select Data
→ Save changes to database and click OK when asked to confirm.
You can check the change was made by running the same query in phpPgAdmin’s SQL box (see Section
A/12.1) :
select * from kiswahili where stanza=1 order by stanza, loc;

To delete the change, click the cell in SQL Workbench, press Backspace and then Return, and then
save as before.
Close SQL Workbench, clicking Yes to save the new andika connection profile you have set up.

A/13 LaTeX

LaTeX is a typesetting system that is capable of creating very complex layouts. It is used in Andika! to
provide attractive output.
sudo apt-get install texlive texlive-xetex texlive-generic-extra texlive-humanities
↪→ texlive-lang-arabic texlive-latex-extra texlive-bibtex-extra kile kbibtex biber

Note that these packages will take perhaps 20 minutes to download and install.

A/14 JabRef

JabRef23 is a bibliography manager.
23jabref.org
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sudo apt-get install jabref

A/15 YAD

YAD (Yet Another Dialogue),24 maintained by Victor Ananjevsky, is used by Andika! to provide a point-
and-click interface to the conversion script. To install it, we need to add another of Andrei Alin’s25
repositories.
Add the new software repository:
sudo add-apt-repository ppa:webupd8team/y-ppa-manager

Update the software package lists to include software from the new repository:
sudo apt-get update

Install YAD:
sudo apt-get install yad26

A/16 Access the Andika! website locally

Although not essential to use Andika!, it may be useful to have access to a local copy of the website
(kevindonnelly.org.uk/swahili).
First, tell the webserver installed earlier (Apache – see Section A/12.1) where to find the Andika!
webpages.
Open a configuration file:
sudo nano /etc/apache2/sites-available/andika.conf

Type the following lines into the file:

<VirtualHost *:80>
ServerName andika
DocumentRoot /var/www/andika/
</VirtualHost>

Save and exit the configuration file:
Ctrl+X, Y, Return
Activate the configuration:
sudo a2ensite andika

Restart the webserver:
sudo service apache2 restart

Then tell your web browser that the new website is on your machine, so it doesn’t have to look for it
on the web.
Open a configuration file:
sudo nano /etc/hosts

After the line:
127.0.0.1 localhost
24sourceforge.net/projects/yad-dialog/
25webupd8.org
26You may also wish to install Andrei’s own Y-PPA-Manager – sudo apt-get install y-ppa-manager. This is not used by

Andika!, but is a very useful system tool to keep track of the software repositories on your machine.
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add the following line:
127.0.0.1 andika

Save and exit the configuration file:
Ctrl+X, Y, Return
In a web browser, type:
http://andika/index.php
into the address bar. You should get the Andika! website loading from the files on your hard disk (in
/var/www/andika), instead of from the internet.



Appendix B

Editing fonts

I am grateful to Khaled Hosny1 for his advice on using FontForge to edit Arabic glyphs, which
has been incorporated in these instructions.

B/1 Introduction

Most Arabic fonts are missing some glyphs that are essential to allow them to be used for writing
Swahili. This appendix deals with how to edit these fonts to add the missing glyphs. This will entail
editing the font with FontForge2 (originally developed by George Williams). A version of this howto
with screenshots is available at the website for the book Design with FontForge.3

B/2 Install FontForge

There are two options here – the easiest is to use a pre-compiled package.

B/2.1 Use a pre-compiled package

The FontForge package included in Ubuntu 14.04 by default is too old, so it is preferable to install the
more up-to-date package from the FontForge Personal Package Archive (PPA).4

Check that the helper script add-apt-repository is installed:
sudo apt-get install software-properties-common

Add the FontForge PPA (which will also add the authentication key):
sudo add-apt-repository ppa:fontforge/fontforge

Update the package list:
sudo apt-get update

Install FontForge:
sudo apt-get install fontforge

B/2.2 Compile from the source code

Installing the pre-compiled package as above will be sufficient for most purposes, so you do not usually
need to do anything else. In some cases, though, (perhaps because you want access to a feature not
1khaledhosny.org
2fontforge.github.io/en-US
3designwithfontforge.com/en-US/Adding_Glyphs_to_an_Arabic_Font.html
4https://launchpad.net/~fontforge/+archive/ubuntu/fontforge
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yet available in the pre-compiled package) you may wish to compile your own version from the code
available on GitHub.5

Install preliminary software

Install packages to allow the building of software:
sudo apt-get install build-essential automake flex bison

Install the unifont package to get a full display of the reference glyphs. Unifont6 includes glyphs for all
Unicode codepoints, and FontForge will use it if it is installed.
sudo apt-get install unifont

Install other required packages:
sudo apt-get install packaging-dev pkg-config python-dev libpango1.0-dev
↪→ libglib2.0-dev libxml2-dev giflib-dbg libjpeg-dev libtiff-dev uthash-dev

Build libspiro

FontForge uses libspiro7 (by Raph Levien) to simplify the drawing of curves.
Download the code:
git clone https://github.com/fontforge/libspiro.git

Run the following commands in sequence (that is, wait for each one to complete before running the
next):

cd libspiro
autoreconf -i
automake --foreign -Wall
./configure
make
sudo make install
cd ..

Build libuninameslist

FontForge uses libuinameslist8 to access attribute data about each Unicode code point.
Download the code:
git clone https://github.com/fontforge/libuninameslist.git

Run the following commands in sequence (that is, wait for each one to complete before running the
next):

cd libuninameslist
autoreconf -i
automake --foreign
5github.com/fontforge/fontforge
6savannah.gnu.org/projects/unifont
7github.com/fontforge/libspiro
8github.com/fontforge/libuninameslist
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./configure
make
sudo make install
cd ..

Build FontForge

Download the code:
git clone https://github.com/fontforge/fontforge.git

Run the following commands in sequence (that is, wait for each one to complete before running the
next):

cd fontforge
./bootstrap
./configure
make
sudo make install
cd ..

Make the system aware of the new libraries:
sudo ldconfig

B/3 Make a working copy of the font

The font we will add glyphs to is Graph9 (regenerated by Nadim Shaikli). A version of the following
howto which includes images is available on the Design with FontForge website.10

Download the font from the webpage into the andika directory. Unzip it, and delete the zip file:
unzip -q graph.zip -d fonts && rm graph.zip

Launch FontForge (in KDE, go to K → Graphics → FontForge). Note that FontForge is built using the
programming language Tcl,11 and it therefore behaves slightly differently from other software you may
be used to. For instance, every action requires at least one click (so the submenus for menus don’t appear
as you move across the menu bar – you have to click each one).
The first time you open FontForge, it will ask to you load a font. Navigate to andika/fonts, select ae_-
Graph.ttf, and click OK. FontForge will display a chart of every glyph in the font, each in its own cell.
The smaller cell above it is a reference glyph – not all reference glyphs will have a font glyph, since few
fonts contain glyphs for every single Unicode code point. Where the font glyph is missing, the cell will
contain a grey X.
Save it as an sfd file which will become your working copy: select File → Save, edit the suggested name
to read GraphSwa.sfd and click Save.

B/4 Rename the font

If you do not rename the font, your adapted font will not install separately from the original – you will
have to uninstall the original font first. It is also sensible to rename the font if you are going to distribute
9openfontlibrary.org/en/font/graph
10http://designwithfontforge.com/en-US/Adding_Glyphs_to_an_Arabic_Font.html
11tcl.tk/
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your adaptations – if the original author of the font has reserved the font name under the Reserved Font
Name (RFN) mechanism, that original name can only be used with the original author’s version of the
font.
If you adapt a font that was originally under an open license (eg GPL12 or OFL13) and then distribute
it, you must retain the original author’s copyright notices and licensing information, although you can
append a note at the end of the copyright notice covering your contribution.
Note that adapting a font that was originally under a closed license (eg most fonts by Microsoft, Adobe,
Bitstream, Linotype, etc), may be a breach of copyright, depending on the terms of the license.
Select Element → Font Info, and in the PS Names panel, change Fontname, Family Name, and Name For
Humans to GraphSwa.
In the TTF Names panel, the names for Family and Fullname are taken from the PS Names entries, and
should already be showing GraphSwa (you can’t edit them directly). Change the entries for Preferred
Family and Compatible Full to GraphSwa. These name changes will now allow you to install this font
alongside the original one if you wish.
If desired, in the TTF Names panel you can also place a ”Swahili glyphs added by” message after the text
already in the entry for Designer.
Click OK to save these changes. You will get a message about generating a new UniqueID (XUID) for
the font – click Change.

B/5 Add the glyph for the isolated form of peh

We will add the missing glyph peh (U+067E) to the Graph font.
Go to the Arabic section of the font chart: select View → Go to, click the dropdown box and select
Arabic, then click OK.
Clicking on a cell in the font chart will show its Unicode number and name in blue at the top of the panel.
Go to position 1662 (0x67e) U+067E “uni067E” ARABIC LETTER PEH. The cell below the reference
glyph contains a grey X, showing that the font does not include this glyph.
We will make peh by copying beh (U+0628) and swapping its single dot for three dots.
Click on the beh cell (position 1576), then right-click and select Copy. Then right-click on the peh cell
and select Paste. Now that beh is now copied into the peh cell, the next thing is to change the dot.
Find a glyph with three dots – sheen (position 1588, U+0634) will do. Double-click on the cell – this
will open a glyph design panel. Press V to ensure the pointer tool (arrowhead) in the toolbox is selected,
and press Z and enlarge the panel to give you a good view of the glyph.
Click and drag so that the nodes of the three dots above sheen change colour from pink to beige. If you
accidentally include or omit a node, deselect or select it by pressing Shift and clicking. Press Alt+C to
copy.
Go back to the font chart and double-click on the peh cell – this will load peh into another tab in the
glyph design panel, alongside the sheen tab.
Click and drag to highlight the dot below peh, then press Delete. Press Alt+V to paste in the three dots,
which will likely appear above the body of peh. Leave the dot nodes highlighted so that you can invert
and move them more easily.
Invert the dots: select the flip tool (two triangles with a red dashed line between them) from the toolbox.
12gnu.org/copyleft/gpl.html
13scripts.sil.org/OFL-FAQ_web
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(Alternatively, right-click in the middle of the dots, and select Flip the selection from the popup.) Click
on one of the dot nodes and drag the mouse slightly left or right.
Move the inverted dots: press V to select the pointer tool again, click on one of the dot nodes, and drag
them down below the body of the glyph. Position them centrally, above the ArabicBelow mark.
Close the glyph design panel. There should now be a new glyph for peh in the font chart. Save the
adapted font (File → Save).

B/6 Add the glyphs for the connected forms of peh

However, this is only the isolated (standalone) form of the glyph. If you try to use your adapted font,
you will find that initial, medial and final forms are not available. These have to be created separately.
”The[se] forms are built as unencoded glyphs (glyphs whose encoding is -1 in FontForge conventions).
Th[ey] have no predefined slots.” (Khaled Hosny)
Select Encoding → Add Encoding Slots and enter the number of the glyphs you want – in this case
3. FontForge will add the same number of slots at the very end of the font, and you will be moved
there in the font chart. The last three cells (positions 65537, 65538, 65539) have a question mark as a
reference glyph, and it is in those cells that you will add the unencoded glyphs by repeating the process
in Appendix B/5 above.
Note that if by mistake you start typing when the font chart still has focus, you get moved to the European
section at the top. To get back to the bottom, select View → Go to, click the dropdown box and select
Not a Unicode Character, and then click OK.

B/6.1 Create the final form

Roll the font chart up a bit until you come to a set of Arabic glyphs at position 65152 (U+FE80) onwards.
At U+FE90 (position 65168) you will see a behfinal glyph – click on it and press Ctrl+C to copy it.
Roll down to the third last cell in the chart (position 65537), click on it, and press Ctrl-V to paste in the
behfinal glyph.
Right-click on the cell and select Glyph Info. The naming convention is to use the number of the isolated
glyph + a suffix for the form, so change Glyph Name to uni067E.fina, and click OK. The question mark
in the reference cell will change to peh.
Get the three dots: double-click on sheen (U+FEB5) to load it into the glyph design panel, select the
three dots and press Ctrl+C.
Double-click on the new pehfinal to load it into the glyph design panel, click and drag to highlight the
nodes of the dot and press Delete.
Ctrl+V to insert the three dots from sheen, flip them, and move them into position below the glyph
body. Press Ctrl+S to save the revised font chart.

B/6.2 Create the initial and medial forms

Copy the initial form U+FE91 (position 65169) to the penultimate cell (position 65538), delete the
single dot and paste in the three dots.
Right-click the cell, select Glyph Info, change Glyph Name to uni067E.init, and click OK.
Copy the medial form U+FE92 (position 65170) to the last cell (position 65539), delete the single dot
and paste in the three dots.
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Right-click the cell, select Glyph Info, change Glyph Name to uni067E.medi, and click OK.
Select File → Save to save the revised font chart.

B/6.3 Add the lookups

The isolated form has to be mapped (linked) to its initial, medial and final forms.
Select Element → Font Info → Lookups.
Click on the + beside the entry ’init’ Initial Forms in Arabic lookup 2. This will open a submenu of the
same name. Click on this submenu.
The Edit Data button on the right will now become available – click it.
In the Lookup Subtable panel that pops up, ensure that the Unicode button is checked. Roll the list of
characters down until you come to the end.
In the box beside Default Using Suffix, enter the relevant suffix (in this case, init), and then click Default
Using Suffix.
A new mapping will be added to the list of characters, from uni067E (the isolated form of peh) to
uni067E.init (the initial form). Click OK.
Do the same for the submenus under the entries ’medi’ Medial Forms in Arabic lookup 2 and ’fina’ Terminal
Forms in Arabic lookup 2, choosing medi and fina as the relevant suffix.
Click OK again to close the panel, and save the font chart (Ctrl+S).
Note that Default Using Suffix only seems to work on glyphs in the Unicode 06 (Arabic) block – glyphs in
Unicode 07 (Arabic Supplement), eg ain with two dots, may have to be added manually by clicking the
line marked New and typing in the names.

B/7 Generate the adapted font

Select File → Generate Fonts.
In the dropdown showing PS Type 1 (Binary), select TrueType, and check that the filename reads Graph-
Swa.ttf.
Navigate to where you want to save the font, and then click Generate. Click Yes and Generate to the
two information messages that come up. You can then use your normal font installation procedure (in
KDE, K → System → System Settings → Font Management) to install the adapted font.

B/8 Next steps

You will need to carry out the above process to add all the missing glyphs listed in Table 4.2.
Note that if you make changes to a font, you need to restart LibreOffice in order to use the changed
font, because it will see only the previous version of the font, and not the new changes.
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Changing the Andika! keyboard layout

C/1 Introduction

The layout of the Andika! keyboard is specified in the file layout/tz. The file (reproduced in Appendix E)
is a simple text file, and can be easily adapted to add new glyphs or change the position of existing glyphs.
Each line follows the pattern below:
key <AC03> { [Arabic_dal, Arabic_thal, Arabic_dad, Arabic_ddal] };

The key number (in this case AC03, for the D key) is followed by a sequence of 4 glyph names (in this
case representing د ذ ض .(ڈ The sequence specifies the glyph that will be output when (respectively)
the user presses D, Shift+D, AltGr+D, and AltGr+Shift+D.
Some lines have less than four entries. For instance, the P key only has one entry :(پ)
key <AD10> { [Arabic_peh] };

because that is the only glyph output by that key, and the S key only has three entries س) ش :(ص
key <AC02> { [Arabic_seen, Arabic_sheen, Arabic_sad] }

giving the glyphs that will be output by pressing S, Shift+S and AltGr+S.
If it is desired to block one of the slots, to enforce a particular keypress for a glyph, the entry NoSymbol
can be used. Thus in the line for the 5 key:
key <AE05> { [Arabic_5, NoSymbol, KP_5, percent] };

the output will be ٥ for 5, nothing for Shift+5, Western 5 forAltGr+5 and a percent sign forAltGr+Shift+5.
Without the NoSymbol, the output would be ٥ for 5, Western 5 for Shift+5, a percent sign for AltGr+5
and nothing for AltGr+Shift+5.
Glyph names are available for some, but by no means all, of the possible glyphs.1 Where no name is
available, the Unicode codepoint can be used instead. Thus, in the line for the n key:
key <AB06> { [Arabic_noon, U075D] };

willن be output when the N key is pressed, and the glyph represented by Unicode 075D ,ݝ) ainwith two
dots above) will be output when Shift+N is pressed. It would be possible to use nothing but Unicode
codepoints in the file, but using the glyph names makes it a bit easier to read.
From the above, it will be obvious that adjusting the location of a particular glyph merely consists of
moving it to the desired slot on the desired key. For example, if the user wanted ض to appear when
Shift+D is pressed, and ذ when AltGr+D is pressed, all that needs to be done is to open the file:
sudo nano layout/tz

and change the line:
key <AC03> { [Arabic_dal, Arabic_thal, Arabic_dad, Arabic_ddal] };
1http://wiki.linuxquestions.org/wiki/List_of_Keysyms_Recognised_by_Xmodmap
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to:
key <AC03> { [Arabic_dal, Arabic_dad, Arabic_thal, Arabic_ddal] };

Then save the file by pressing Ctrl+X, Y, and Return.
Likewise, adding a new glyph to the keyboard is as simple as deciding which slot on which key it should
occupy, and then inserting the Unicode codepoint (or the glyph name where one exists) at that slot. For
instance, if the user needs to access the glyph rreh (ra with tah as a diacritic, Unicode 0691), and decides
to put it on the R key so that it will be output when AltGr+R is pressed, all that needs to be done is to
change the line:
key <AD04> { [Arabic_ra] };

to:
key <AD04> { [Arabic_ra, NoSymbol, U0691] };

(Remember that if NoSymbol is omitted here, rreh will appear when Shift+R is pressed.)
In either case, the new layout has to be activated. So, after saving the file, copy it to the correct location:
sudo cp layout/tz /usr/share/X11/xkb/symbols/

Delete the cache files relating to the old layout (new ones will be created when the new layout is
activated):
sudo rm /var/lib/xkb/server-*

Then remove the tz keyboard layout using your desktop’s language setup utility and re-add it. For KDE,
this simply means going to K→ Settings→ System Settings→ Input Devices→ Keyboard→ Layouts
tab, unticking Configure layouts, clicking Apply, and then reticking Configure layouts and clicking
Apply again.
The new layout should then be ready for use.



Appendix D

Annotated poem, كِسْوَاحِلِ (Kiswahili), 12pt, footnotes
Abdulkadir and Frankl (2013) presents an annotated edition of the poem كِسْوَاحِلِ by Mahmoud Ahmad
Abdulkadir (Ustadh Mau).
The following is a letter-for-letter transcription of the author’s manuscript as reproduced there, with the
exception that the damma-with-tail occasionally used by him to signify o is denoted here with inverted
damma (eg in تَمَانِ نَ كُوَانَٔٗ in 1d), since the font does not yet include that glyph. The layout also includes
an automatically-generated close transliterations, a standard transliteration based on that in the paper,
and the English translation and notes from the paper. The notes also include citations, with the references
printed at the end of the document.
The document was generated automatically from a database table which held all the data about the
poem (words, translation, notes, etc) – see Chapter 8, and the kiswahili table in the andika/db/starter/
andika database included in the Andika! download.
The font-size is 12pt, and notes appear as footnotes. For comparison, the same poem is printed in Ap-
pendix F in a font-size of 10pt, with notes appearing as endnotes.
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كِسْوَاحِلِ
kiswāhili1

Mtungaji: Ustadh Mau (Mahmoud Ahmad Abdulkadir), 2003

الرهيم الرحمن الله بسم
bismi llähi arraḥmani arraḥı̄mi
bismillahi arrahmani arrahimi

لنِِ حَتَ تَانْيَامَا مٖػوْكَ نِ كُنْيَمَا ١
ṯānyāmā ḥaṯa lini kunyamā ni mekʲūka 1b/a

kunyamaa nimechoka * t'anyamaa hata lini 1
I am weary of staying silent. For how much longer am I to remain dumb?

تَمَانِ نَ كُوَانَٔٗ هُنِئٖپُوْكَ وَنَنْڠُ
kuwaona na ṯamāni wanangu huniepūka 1d/c

wanangu huniepuka * kuwaona natamani 1
My own children avoid me, though I long to see them.

وٖنْدَانِ وَ نِ سِوَنْڠُ كُنِشِكَ والوُْبَاكِ
siwangu ni wa wenḏāni wālūbāki kunishika 1f/e

walobaki kunishika * siwangu ni wa wendani 1
And those who remain to embrace me are not my own, but are the offspring of others.

زتَِ هُنِپِجَ مْبُوْنَ مٖوَتٖنْدَانِ نِ مِمِ
mbūna hunipija ziṯa mimi ni mewaṯenḏāni 1h/g

mimi nimewatendani * mbona wanipija zita 1
What have I done to you? Why do you wage war on me?

أُسْوَاحِلِنِ وَ وَانَ دَمُ وَ مِمِ وَنَانْڠُ ٢
wāna wa uswāḥilini wanāngu mimi wa ḏamu 2b/a

wanangu mimi wa damu * wana wa Uswahilini 2
My own flesh and blood, the children of Swahililand,

نَانِ نِ كُنِيُوَ يَا هَامُ هَوَنَ أَصِلِ
yā kuniyuwa ni nāni aṣili hawana hāmu 2d/c

asili hawana hamu * ya kuniyuwa ni nani 2
are uninterested in knowing who I am,

1From Abdulkadir and Frankl (2013).

1
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مَجِرنَِ وَ وَنَ نَ قَؤُمُ وَمٖنَتِيَ
na wana wa majirani wamenaṯiya qaumu 2f/e

wamenatia kaumu * na wana wa majirani 2
and have left me to other peoples, and to the children of neighbours.

زتَِ هُنِپِجَ مْبُوْنَ ڠَانِ كُوْسَ لَنْڠُ كُوْسَ
mbūna hunipija ziṯa kūsa langu kūsa gāni 2h/g

kosa langu kosa gani * mbona hunipija zita 2
What kind of fault is my fault? [O my children] why do you continue waging war on me?

پُنْڠُوَنِ سِنَ وَلَ سِتَاسَ مَامٖنُ مِمِ ٣
wala sina punguwani mimi māmenu siṯāsa 3b/a

mimi mamenu sit'asa * wala sina punguwani 3
I am your mother and am not yet infertile, nor has my ability to reproduce diminished.

زسِِوَنِ كُنْڠِنٖ نَ مَمْبَاسَ وَ مٖزَا نِ
na kungine zisiwani ni mezā wa mambāsa 3d/c

nimezaa wa Mambasa * na kungine zisiwani 3
I have given birth to children in Mambasa, and in the other islands [of the Swahili],

وَدِنِ زيُِوْنْڠُوْزِ نَ سِيَاسَ وَنَ نزِٖ
na ziyūngūzi waḏini nize wana siyāsa 3f/e

nizee wanasiasa * na ziongozi wa dini 3
to politicians and to religious leaders,

زتَِ وَ مَاشُجَا نَ فَنِ كُلَ وَ مَافنُْدِ
na māshujā wa ziṯa māfunḏi wa kula fani 3h/g

mafundi wa kula fani * na mashujaa wa zita 3
to craftsmen in every field, and to war heroes.

عَثْمَانِ مْوٖنْڠٗ پيَِ مُيَاكَ مَامَاكٖ نْدِمِ ٤
piya mwengo 'athmāni nḏimi māmāke muyāka 4b/a

ndimi mamake Muyaka2 * pia Mwengo Athumani3 4
I am the mother of Bwana Muyaka, and of Mwengo Athmani also,

2Bwana Muyaka was the outstanding Swahili poet of 19th century Mombasa. After his death many
of his verses were recalled by Mu’allim Sikujua Abdallah al-Batawi (died 1890) and transcribed with
annotations by W.E. Taylor (1856-1927). After Taylor’s death his papers were acquired by the library
of the School of Oriental and African Studies (SOAS), London.

3Mwengo Athmani: this 18th century poet from Pate composed the Utendi wa Tambuka (The Epic of
Heraklios).
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وٖنْدَانِ وَاكٖ وٖنْڠِ نَ كَذَلكَِ زَهِدِ نَ
na wengi wāke wenḏāni na zahiḏi kadhalika 4d/c

na Zahidi4 kadhalika * na wengi wake wendani 4
and of Zahidi too, and many of his contemporaries,

قَرنِِ مُوْيَ مْبوَا وٗتٖ مَتَاكَ نَ كُوْتِ عالى
woṯe mbwā mūya qarini 'ālı̄ kūṯi na maṯāka 4f/e

Ali Koti5 na Mataka6 * wote mbwa moya karini 4
Ali Koti and Mataka, all from just one century,

نْيوتَ كَمَ كَوَا وَ مَاتوُْمبونِ لتُِوْكَ وَ
wa kawā kama nı̄ūṯa waliṯūka māṯūmbūni 4h/g

walitoka mtumboni * wakawaa kama nyota 4
they emerged from my womb, and shone like stars.

كِدَنِ نَ أُكِسٗوْمٖ نْڠَلِيَ انِْكِشَافِ ٥
ukisōme na kiḏani inkishāfi ngaliya 5b/a

Inkishafi7 angalia * ukisome na kidani 5
Look at Inkishafi. Read it attentively

مْوٖنْدانِ كْوَامْبِيَاءٗ نِ كْوٖلٖيَ تَاكَاپُوْ نْدِپُوْ
ni kwāmbiyao mwenḏāni nḏipuu ṯākāpuu kweleya 5d/c

ndipo takapo kwelea * nikwambiyao mwendani 5
and then you will understand, my dear friend,

اصَِلَانِ هَزفِِ نَ زِمٖسَلِيَ توُْنْڠٗ نِ
na hazifi aṣilāni ni ṯūngo zimesaliya 5f/e

ni t'ungo zimesalia * na hazifi asilani 5
what I am telling you. These verses are of enduring worth and will never die.

وَالوُْپتَِ وَنَانْڠُ نِ نْيَانِ نِ وَالوُْزتِنُْڠَ
ni wanāngu wālūpiṯa wālūziṯunga ni nyāni 5h/g

walozitunga ni nyani * ni wanangu walopita 5
Who were those who composed them? They were my children who have passed on.

4Zahidi: see El-Maawy (1973).
5Ali Koti of Pate: see S. Chiraghdin (1987, pp.31-7).
6Bwana Mataka’s full name is Muhammad bin Shee Mataka al-Famau (1825-1868). He was ruler of

Siyu, as was his father. His mother was Mwana Kupona, famous for the poem of advice written to her
daughter. Bwana Mataka died in Mombasa’s fort while imprisoned by the Busa‘idi.

7The Inkishafi, according to W.E. Taylor (Stigand 1915, pp96-105), is “a great, if not the greatest,
religious classic of [the Swahili-speaking peoples]”. The poem, concerned with the decay of Pate (for-
merly a flourishing town in northern Swahililand), may remind some readers of Thomas Gray’s Elegy
written in an English churchyard (London 1751).
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دِنِ ػِرَاڠُ پيَِ نَ مْڤِتَ وَ مَالٖنْڠَ نَ ٦
na piya kʲirāgu ḏini na mālenga wa mviṯa 6b/a

na Malenga8 wa Mvita * na pia Chiraghudini9 6
And the Bard of Mambasa, and Chiraghdin too,

ادُُنِ هَاوَكُكِرِ ولزِفِوَُتَ نْيايُو
hāwakukiri uḏuni nyāyuu ūlizifuwaṯa 6d/c

nyayo walizifuata * hawakukiri uduni 6
they followed in my footsteps, they did not submit to lower standards.

هُفَلِييانِ لَكِنِ هُتٖتَ نْنَابَهَانِ
lakini hufalı̄yāni nnābahāni huṯeṯa 6f/e

Nabahani10 huteta * lakini hufaliyani 6
al-Nabhany reproves, but to what effect?

اَمٖئِكِتَ انِْڠَا اوَُنْدَانِ پْوٖكٖ نْدِيٖ
ingā ameikiṯa nḏiye pweke uwanḏāni 6h/g

ndiye pweke uwandani * ingawa ameikita 6
He remains alone in the field, yet he stays strong.

اكُِنڠُوْنِ سِيَاكُوْمَ وٖزَ نَ كُزَا بَادٗ ٧
siyākūma ukingūni bāḏo kuzā na weza 7b/a

bado kuzaa naweza * siyakoma ukingoni 7
I am still able to give birth. I have not yet reached the limit,

فوُٗنِ مُمٖئِتٗوَ مُمٖنِپُوْزَ لَكِنِ
mumeiṯowa fuwoni lakini mumenipūza 7d/c

lakini mumenipuuza * mumeitowa fuoni 7
but you have all despised me. You have left me high and dry,

8The Bard of Mambasa refers to Ustadh Ahmad Nassir Juma Bhalo, see S. Chiraghdin (1971).
9Shihabdin Chiraghdin (1934-1976). See the biography by his daughter – L. Chiraghdin (2012).

10In an unpublished commendation from 12 June 1974 J.W.T. Allen writes about Ahmad Sheikh
Nabhany: “I am privileged to have a wide circle of friends and acquaintances among Swahili scholars of
Swahili. I have some knowledge of their rating of themselves and I can name perhaps half a dozen (still
living) who are always referred to as the most learned. To me they are walking dictionaries and mines
of information and Ahmed is unquestionably one of them. He comes of a family of scholars whose
discipline is as tough as any degree course in the world. They have no time for false scholarship or
dilettantism. That this profound learning is almost wholly disregarded by those who have been highly
educated in the western tradition affects almost everything written today in or about Swahili. When I
want to know some word or something about Swahili, I do not go to professors, but to one of the bingwa
known to me. One of these could give a much greater detail of assessment, but of course his opinion
would not carry the weight of one who can put some totally irrelevant letters after his name”. For a
biography see Said (2012).
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كَانوُْنِ كُنِپانْڠِيَ مٖئِتُوكٖزَ وَنْڠِنٖ
kunipāngiya kānūni wangine meiṯūkeza 7f/e

wangine meitokeza * kunipangia kanuni 7
now others have come forward to regulate me,

مُلِپُوْنوَِتَ نْيِنْيِ كُبُوْنِ مُسَمِيَاتِ
nyinyi mulipūniwaṯa musamiyāṯi kubūni 7h/g

musamiati kubuni11 * nyinyi muliponiwata 7
compiling standardized dictionaries.

جَردَِنِ ػنَْڠَلِيَ كِسِكِتِكَ هُلِيَ ٨
kʲangaliya jariḏani huliya kisikiṯika 8b/a

hulia kisikitika * changaliya jaridani 8
I weep and lament when I look at the learned journals,

وَڠٖنِ نِ سِوَنَانْڠُ اَنْدِكَ وَنَاءُ وٖنْڠِ
siwanāngu ni wageni wengi wanau anḏika 8d/c

wengi wanaoandika * si wanangu ni wageni 8
for many of those who contribute are not my children, they are strangers [to me].

نْيَانِ نِ تنُْڠٗ وَپٖكَ كَذَلكَِ اذَِاعَانِ
wapeka ṯungo ni nyāni idhā'āni kadhalika 8f/e

idhaani kadhalika * wapeka t'ungo ni nyani 8
It is much the same with the media. Who are the ones who send in their compositions?

مْڤِتَ مْبوا كُوَ لػَِ پْوان هَاوَتوُْك وٖنْڠِ
likʲa kuwa mbwā mviṯa wengi hāwaṯūk pwān 8h/g

wengi hawatoki p'wani * licha kuwa mbwa Mvita 8
Many do not come from the coast, although they may have a Mambasa address.

شُلٖنِ زسُِوْمٖشْوَاءٗ زتَِابُ نَ انَڠَلِيَ ٩
zisūmeshwao shuleni angaliya na ziṯābu 9b/a

angalia na zitabu * zisumeshwao shuleni 9
Look at the textbooks which are studied at our schools.

11For almost a century the principal publisher of standardized Swahili dictionaries has been the Oxford
University Press (OUP). Clearly OUP has to be profitable, and profitable is what, over the years, their
dictionaries of standardized Swahili have been. However, if one considers excellence in research and
scholarship not one of the OUP’s standardized Swahili lexicons can begin to compare with the Oxford
English Dictionary (‘more than 600,000 words over a thousand years’). Fortunately for Swahili and for
Swahili studies there exists the monumental Dictionnaire swahili-français, compiled by Charles Sacleux
(Sacleux 1939). Sacleux’s chef d’oeuvre (‘unprecedented in historical depth, dialectological detail and
philological knowledge’) can now be accessed electronically, courtesy of Swahili Forum (uni-leipzig.de/
~afrika/swafo/index.php/sacleux). Heartfelt thanks are due to Thilo Schadeberg and Ridder Samsom.
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شَانِ سِ وَلَ سُوْدِ سِ رجََبُ نَ هَازَانْدِكْوِ
si sūḏi wala si shāni hāzānḏikwi na rajabu 9d/c

hazandikwi na Rajabu * si Sudi wala si Shani 9
They are written neither by Rajabu, nor by Sudi nor by Shani.

سُكَانِ اَشِشِيٖؤٗ كَتِبُ نْدِيٖ ْنْجُوْرڠٖٗ
ashishiyeo sukāni njūroge nḏiye kaṯibu 9f/e

njoroge12 ndiye katibu * ashishiyeo sukani 9
The author is Njoroge, he is the helmsman.

هُفُوَتَ نْيُوْمَ نَاءٗ وٖنْدانِ وَاكٖ نَ ػاَرٗ
nao nyūma hufuwaṯa kʲāro na wāke wenḏāni 9h/g

Charo13 na wake wendani * nao nyuma hufuata 9
Charo and his colleagues follow.

نْدِيَانِ هُرُدِ ػٖنْدَ كُوْنْڠَمَانٗ هُوَلكِْوَا ١٠
kʲenḏa huruḏi nḏiyāni huwalikwā kūngamāno 10b/a

hualikwa kongamano * chenda hurudi ndiani 10
When I am invited to conferences, I turn back before I arrive.

سِوَانِٔٗ نْيِنْيِ كُوَ مْنُو اتُنُْڠُ هُوٗنَ
kuwa nyinyi siwaoni huwona uṯungu mnuu 10d/c

huona utungu mno * kuwa nyinyi siwaoni 10
I feel exceedingly bitter that I do not see you all there.

نْنِ نتِٖنْدٖ لَكِنِ زتَِانِ هُزاِمَُ نَ
lakini niṯenḏe nni na huziuma ziṯāni 10f/e

na huziuma zitano14 * lakini nitende nini 10
I bite my fingers in frustration, but what can I do?

مُمٖنِوَتَ مَامٖنُ مُمٖئِخِنِ وَنَانْڠُ
māmenu mumeniwaṯa wanāngu mumeikhini 10h/g

wanangu mumeihini * mamenu mumeniwata 10
My children, you have missed your opportunity. You have abandoned your own mother.

مِتِحَانِ ػنَْڠَلِيَ مَاتوُْزِ كْوَا هُلِيَ نَ ١١
kʲangaliya miṯiḥāni na huliya kwā māṯūzi 11b/a

na hulia kwa matozi * changaliya mitihani 11
And I shed tears when I look at the results of the school exams.

12njoroge: a name representing those who have their origins in the East African interior (the bara).
13charo: a name representing those who have their origins in the coastal hinterland (the nyika).
14These words echo the words of the Inkishafi: “wakauma zanda na kuiyuta”. Readers unfamiliar with

this Swahili gesture of regret could consult Eastman and Omar (1985).
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زِوَنِ كِسُومُ وَ نَ كِبْوٖزِ وَ وَنَفُنْدِ
na wa kisūmu ziwani wanafunḏi wa kibwezi 11d/c

wanafundi wa Kibwezi * na wa Kisumu15 ziwani16 11
Students from Kibwezi, and from Kisumu by the lake,

كِلٖلٖنِ وَليُِوكُوْ بَارِزِ وَنَاءٗ نْدِوٗ
waliyūkuu kileleni nḏiwo wanao bārizi 11f/e

ndiwo wanao barizi * waliyukuu kileleni 11
they are the ones who are ahead, who are at the top;

هُكُوْكُوْتَ تنِِ مُكُوْ پْوانِ كْوٖتُ مُلُوْتوُْكَ
mukuu ṯini hukūkūṯa mulūṯūka kweṯu pwāni 11h/g

mulotoka kwetu p'wani * muko t'ini hukokota17 11
and you, students from the coast, you lag far behind.

ػوُٗنِ أُزَمِلِ وَ اتَُفِتِ وَفَانْيَاءٗ ١٢
wa uzamili kʲuwoni waānyao uṯafiṯi 12b/a

wafanyao utafiti * wa uzamili chuwoni 12
Amongst those who are researching for degrees at the universities,

هَوَپَاتكَِانِ اوَْ كَاتتِِ نِ وَسْوَاهِلِ
aw hawapāṯikāni waswāhili ni kāṯiṯi 12d/c

Waswahili ni katiti * au hawapatikani 12
Swahili students are few or non-existent.

نْيَانِ نِ مَاكُوْسَ مْوٖنْيٖ مْلَئِتِ نِ نْيَانِ نِ
mwenye mākūsa ni nyāni ni nyāni ni mlaiṯi 12f/e

ni nyani ni mlaiti * mwenye makosa ni nyani 12
Who is to be blamed? Whose fault is it?

هَامُكُپَاتَ مْڠِنٖ هَامُنِثَمِنِ مِمِ
mgine hāmukupāṯa mimi hāmunithamini 12h/g

mimi hamunithamini * mngine hamukupata 12
You esteem me not at all, yet you have not replaced me by another.

15Kibwezi and Kisumu are places in the East African interior.
16The lake is Lake Nyanza, also known as Lake Victoria.
17Over the years young people on Lamu Island (and indeed elsewhere in northern Swahililand) have

received a raw deal in their primary and secondary education. They have ‘lagged far behind’ their
counterparts from the interior, and so Mother Swahili grieves for her marginalised children.
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مُويُوْنِ هُنِانْٔٗڠُوْنْڠَ هُنِيْنَ كِوَسِكِيَ ١٣
huniongūnga mūyūni kiwasikiya hunı̄na 13b/a

kiwasikiya hunena * huniungonga moyoni 13
When I hear those who are not mother-tongue speakers speaking, I feel sick at heart.

ئتَِمَانِ نَ نَحَؤُ تٖنَ هَكُنَ صَرفَْ
naḥau na iṯamāni ṣarfa hakuna ṯena 13d/c

sarufi hakuna tena * nahau naitamani 13
Inflection is no longer employed, while grammatical [Swahili] is what I desire!

كَانْوَانِ مَشَاپُوْ كَمَ هَيَانَ لَذَ حَتَ نَ
kama mashāpuu kānwāni na ḥaṯa ladha hayāna 13f/e

na hata ladha hayana * kama mashapu kanwani 13
Even [their speech] is wanting in flavour, like a plug of tobacco in one’s mouth.

هُتٖتَ اوَْ هُئِمْبَ هُنٖنَانِ سِئٖلٖوِ
huimba aw huṯeṯa sielewi hunenāni 13h/g

sielewi hunenani * huimba au huteta 13
I do not understand what they are saying. Are they singing? Are they complaining?

دُنيَِانِ تٖنَ ايَْ تَارُدِ مُيَاكَ لَوْ ١٤
ay ṯena ḏuniyāni law muyāka ṯāruḏi 14b/a

lau Muyaka tarudi * ae tena duniani 14
Were Bwana Muyaka to return, were he to come back to the world,

مَحَكَمَانِ كْوٖنٖنْدَ اتَِمْبِدِ موَانَانْڠُ
kwenenḏa maḥakamāni mwānāngu iṯambiḏi 14d/c

mwanangu itambidi * kwenenda mahakamani 14
it would be necessary, my child, for him to go to a court of law,

يَقِيْنِ نيُِوَاءٗ وَ مَشَهِدِ نَ ائَٖتٖ
waniyuwao yaqı̄ni aeṯe na mashahiḏi 14f/e

aete na mashahidi * waniyuwao yakini 14
and he would need to call witnesses who know me well,

كُوَپَاتَ حَتِيَ كْوَا ڠٖرزَٖنِ مْوٖنْدٖ نْيُوْتٖ
kwā ḥaṯiya kuwapāṯa nyūṯe mwenḏe gerezani 14h/g

nyote mwende gerezani * kwa hatia kuwapata 14
and all of you would go to prison for the offence which you have committed against me.
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امَِانِ هَامُوْنَ وَلَ غٖيْرَ هَمُنَ وَاللّٰهِ ١٥
wala hāmūna imāni wallähi hamuna ḡēra 15b/a

wallahi hamuna ghera * wala hamuna imani 15
Truly you have neither zeal nor self-confidence.

هَمُنِثَمِنِ كُوَ لَكُوَكٖرَ هَمُنَ
kuwa hamunithamini hamuna lakuwakera 15d/c

hamuna la kuwakera * kuwa hamunithamini 15
It irritates you not at all that you do not esteem me.

اوَُنْدَانِ هُتٖزٖوَ مْپِوِرِ كَامَ نِ مِمِ
huṯezewa uwanḏāni mimi ni kāma mpiwiri 15f/e

mimi ni kama mpwira * hutezewa uwandani 15
I am just like a ball in the play-ground,

كُپِتَ مْوٖنْيٖ كُلَ نَ تٖكٖنْدِيَانَ هِپِجْوَا
na kula mwenye kupiṯa hipijwā ṯekenḏiyāna 15h/g

hipijwa teke ndiani * na kula mwenye kupita 15
I am given a kick by anyone who passes by in the street.

وَمٖبُوْنِ وَنْڠُ وَاسُوْ اشَُعِرِ كْوٖنْيٖ حَتَ ١٦
wāsuu wangu wamebūni ḥaṯa kwenye usha'iri 16b/a

hata kwenye ushairi * waso wangu wamebuni 16
Even in the field of Swahili prosody, those who are not mine have invented

وَڠٖنِ كُوٗلٖزَ كْوَا بَحَارِ حُرُ لزِٗ زِ
kwā kuwoleza wageni zilizo ḥuru baḥāri 16d/c

zilizo huru bahari * kwa kuoleza wageni 16
free verse, imitating foreigners.

كِفَنِ مَاشَعِرِ سِ سِيَاكِرِ هَايُو ممِ
si māsha'iri kifani mmi hāyuu siyākiri 16f/e

mimi hayo siyakiri * si mashairi kifani 16
For myself, I cannot accept that. That is not Swahili poetry.

زتَ زَا مْبنُ ن هزٗ نْن كْوا نِ ىُوْت هَاىُوْ
hzo n mbnu zā zṯa hāyuu yūṯ ni kwā nn 16h/g

hayo yote ni kwa nini * hizo ni mbinu za zita 16
What is the point of it all? These are preparations for war.
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ڠَانِ عَجَابُ نِ هِنِ سِنَ مْوٖنْيٖوٖ هَمْبِوَ ١٧
hini ni 'ajābu gāni hambiwa mwenyewe sina 17b/a

hambiwa mwenyewe sina * hini ni ajabu gani 17
I am told that I belong to nobody in particular. How extraordinary!

يَانْڠَانِ تَانْدُ نَ كَاوَ شِنَ كاكُوْسَ هُوَاءٖ
kāwa na ṯānḏu yāngāni huwae kākūsa shina 17d/c

huwae kakosa shina * kawa na tandu yangani 17
How can I be rootless below ground and yet have branches above?

نْيَانِ نِ الَوُْنَانْدِكَ ئنَِ نپَِ اَلوُْ نْيَانِ
alūnānḏika ni nyāni nyāni alūnipa ina 17f/e

nyani alonipa ina * alonandika ni nyani 17
Who gave me my name? And who are they who wrote me down?

نَالپُِوپَاتَ وَپِ نِ اسُْوَاحِلِنِ سِ كِوَ
ni wapi nālipūpāṯa kiwa si uswāḥilini 17h/g

kiwa si Uswahilini * ni wapi nalipopata 17
If I do not hail from Swahililand, then whence do I come?

اصَِلَانِ سِدَللِِ هُنِنٖنَ وٖنْڠِ كُوَ ١٨
siḏalili aṣilāni kuwa wengi huninena 18b/a

kuwa wengi huninena * si dalili asilani 18
That many speak me, [Swahili], is not of itself proof of origins,

هَامُوٗنِ كِنْڠٖرزَٖ سِنَ مْوٖنْيٖوٖ يَاكُوَ
kingereza hāmuwoni yākuwa mwenyewe sina 18d/c

yakuwa mwenyewe sina * Kiingereza hamuoni 18
or that I have no owner. What of the English language?

دُنيَِانِ زٗتٖ پٖمْبٖ سَانَ وٖنْڠِ نَ هُنٖنوَا
pembe zoṯe ḏuniyāni hunenwā na wengi sāna 18f/e

hunenwa na wengi sana * pembe zote duniani 18
It is spoken by very many, in all corners of the world,

هَئِكُكَاتَ مِزيِٖ سِنَانِ كْوَاءٗ نَ كِنَ
miziye haikukāṯa kina na kwao sināni 18h/g

kina na kwao sinani * miziye haikukata 18
yet the language remains firmly established in its homeland, its roots have not been severed.
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Appendix E

The keyboard layout file (layout/tz)

This appendix contains the contents of the Andika! file layout/tz. Lines which begin with // are com-
ment lines, intended to explain which glyphs will be output when a particular key is pressed. For more
information, see Section 5.3.

// Keyboard layout for Swahili in Arabic script.
// This file is part of the Andika! project, and is licensed under GPLv3 or later.
// Version 2014-08-12
// Andika! -- kevindonnelly.org.uk/swahili
// Kevin Donnelly (kevin@dotmon.com)

xkb_symbols "swa"
{

name[Group1] = "Swahili";

include "level3(ralt_switch)"

// 1=key, 2=Shift+key, 3=AltGr+key, 4=AltGr+Shift+key

// -------------
// ZXCV row
// -------------
key <LSGT> { [Arabic_superscript_alef, Arabic_maddaonalef, Arabic_hamzaunderalef, U0671] };
// 1 superscript alef, 2 alef with madda above, 3 alef with hamza below (vowelcarrier), 4 alef wasla
key <AB01> { [Arabic_zain, Arabic_jeh, Arabic_zah] };
// 1 zain (z), 2 jeh (zh), 3 zah (zw)
key <AB02> { [Arabic_khah] };
// 1 khah (kh)
key <AB03> { [Arabic_tcheh, U063B, U06AE] };
// 1 tcheh (ch), 2 keheh with two dots above (kj), 3 kaf with three dots below (kj)
key <AB04> { [Arabic_veh] };
// 1 veh (v)
key <AB05> { [Arabic_beh] };
// 1 beh (b)
key <AB06> { [Arabic_noon, U075D] };
// 1 noon (n), 2 ain with two dots above (g in ng')
key <AB07> { [Arabic_meem] };
// 1 meem (m)
key <AB08> { [Arabic_comma, Arabic_hamza_above, comma, leftcaret] };
// 1 comma, 2 hamza as diacritic, 3 UK comma, 4 closing angle bracket
key <AB09> { [Arabic_fullstop, Arabic_sukun, period, rightcaret] };
// 1 fullstop, 2 sukun, 3 UK fullstop, 4 opening angle bracket
key <AB10> { [Arabic_question_mark, NoSymbol, KP_Divide, question] };
// 1 question mark, 3 forward slash, 4 UK question mark

// -------------
// ASDF row
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// -------------
key <AC01> { [Arabic_fatha, Arabic_alef, Arabic_hamzaonalef, Arabic_fathatan] };
// 1 fatha (short a), 2 alef (long a), 3 alef with hamza above (vowelcarrier), 4 fathatan
key <AC02> { [Arabic_seen, Arabic_sheen, Arabic_sad] };
// 1 seen (s), 2 sheen (sh), 3 sad (sw)
key <AC03> { [Arabic_dal, Arabic_thal, Arabic_dad, Arabic_ddal] };
// 1 dal (d), 2 thal (dh), 3 dad (dw), 4 ddal (alveolar dr)
key <AC04> { [Arabic_feh ] };
// 1 feh (f)
key <AC05> { [U06A0, Arabic_ghain, Arabic_gaf] };
// 1 ain with three dots above (g), 2 ghain (gh), 3 gaf (g)
key <AC06> { [Arabic_ha, Arabic_hah, Arabic_tehmarbuta, Arabic_hamza] };
// 1 ha (h), 2 hah (h), 3 tehmarbuta, 4 hamza as letter
key <AC07> { [Arabic_jeem] };
// 1 jeem (j)
key <AC08> { [Arabic_kaf, U06AA] };
// 1 kaf (k), 2 swash kaf (k)
key <AC09> { [Arabic_lam] };
// lam (l)
key <AC10> { [Arabic_semicolon, NoSymbol, semicolon, colon] };
// 1 semicolon, 3 UK semicolon, 4 UK colon
key <AC11> { [Arabic_ain, Arabic_shadda, quoteright, at] };
// 1 ain, 2 shadda, 3 UK single quote, 4 UK @
key <BKSL> { [NoSymbol, NoSymbol, numbersign, asciitilde] };
// 3 UK hash, 4 UK tilde

// -------------
// QWER row
// -------------

key <AD01> { [Arabic_qaf] };
// 1 qaf (q)
key <AD02> { [Arabic_waw, NoSymbol, Arabic_hamzaonwaw, U06CF] };
// 1 waw (w), 3 waw with hamza above (vowel-carrier), 4 waw with dot above
key <AD03> { [U0656, Arabic_yeh, Arabic_hamzaonyeh] };
// 1 subscript alef (short e), 2 yeh (long e), 3 yeh with hamza above (vowel carrier)
key <AD04> { [Arabic_ra] };
// 1 ra (r)
key <AD05> { [Arabic_teh, Arabic_theh, Arabic_tah, Arabic_tteh] };
// 1 teh (t), 2 theh (th), 3 tah (tw), tteh (alveolar tr)
key <AD06> { [Arabic_yeh, Arabic_alefmaksura, Arabic_hamzaonyeh] };
// 1 yeh (y), 2 alef maksura, 3 yeh with hamza above (vowel carrier)
key <AD07> { [Arabic_damma, Arabic_waw, Arabic_hamzaonwaw, Arabic_dammatan] };
// 1 damma (short u), 2 waw (long u), 3 waw with hamza above (vowel-carrier), 4 dammatan
key <AD08> { [Arabic_kasra, Arabic_yeh, Arabic_hamzaonyeh, Arabic_kasratan] };
// 1 kasra (short i), 2 yeh (long i), 3 yeh with hamza above (vowel carrier), 4 kasratan
key <AD09> { [U0657, Arabic_waw, Arabic_hamzaonwaw] };
// 1 inverted damma (short o), 2 waw (long o), 3 waw with hamza above (vowel-carrier)
key <AD10> { [Arabic_peh] };
// 1 peh (p)
key <AD11> { [NoSymbol, NoSymbol, bracketleft, braceleft] };
// 3 UK opening square bracket, 4 UK open١ing brace
key <AD12> { [NoSymbol, NoSymbol, bracketright, braceright] };
// 3 UK closing square bracket, 4 UK closing brace

// -------------
// numeral row
// -------------
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key <AE01> { [Arabic_1, NoSymbol, KP_1, exclam] };
// 1 digit 1, 3 UK digit 1, 4 UK exclamation mark
key <AE02> { [Arabic_2, NoSymbol, KP_2, quotedbl] };
// 1 digit 2, 3 UK digit 2, 4 UK double quote
key <AE03> { [Arabic_3, NoSymbol, KP_3, sterling] };
// 1 digit 3, 3 UK digit 3, 4 UK pound sign
key <AE04> { [Arabic_4, NoSymbol, KP_4, dollar] };
// 1 digit 4, 3 UK digit 4, 4 UK dollar sign
key <AE05> { [Arabic_5, NoSymbol, KP_5, percent] };
// 1 digit 5, 3 UK digit 5, 4 UK percent sign
key <AE06> { [Arabic_6, NoSymbol, KP_6, asciicircum] };
// 1 digit 6, 3 UK digit 6, 4 UK circumflex
key <AE07> { [Arabic_7, NoSymbol, KP_7, ampersand] };
// 1 digit 7, 3 UK digit 7, 4 UK ampersand
key <AE08> { [Arabic_8, NoSymbol, KP_8, KP_Multiply] };
// 1 digit 8, 3 UK digit 8, 4 UK asterisk
key <AE09> { [Arabic_9, NoSymbol, KP_9, parenleft] };
// 1 digit 9, 3 UK digit 9, 4 UK opening parenthesis
key <AE10> { [Arabic_0, NoSymbol, KP_0, parenright] };
// 1 digit 0, 3 UK digit 0, 4 UK closing parenthesis
key <AE11> { [U060D, NoSymbol, KP_Subtract, underbar] };
// 1 date separator, 3 UK dash, 4 UK underscore
key <AE12> { [NoSymbol, NoSymbol, KP_Equal, KP_Add] };
// 3 UK equals sign, 4 UK addition sign

};



Appendix F

Annotated poem, كِسْوَاحِلِ (Kiswahili), 10pt, endnotes
Appendix D presented the poem in Abdulkadir and Frankl (2013) at a font-size of 12pt, with annotations
appear as footnotes. For comparison, this appendix prints the same poem in a font-size of 10pt, with
annotations appearing as endnotes – see Section 8.7.2 and Section 8.7.3.

97



كِسْوَاحِلِ
kiswāhili1

Mtungaji: Ustadh Mau (Mahmoud Ahmad Abdulkadir), 2003

الرهيم الرحمن الله بسم
bismi llähi arraḥmani arraḥı̄mi
bismillahi arrahmani arrahimi

لنِِ حَتَ تَانْيَامَا مٖػوْكَ نِ كُنْيَمَا ١
ṯānyāmā ḥaṯa lini kunyamā ni mekʲūka 1b/a
kunyamaa nimechoka * t'anyamaa hata lini 1

I am weary of staying silent. For how much longer am I to remain dumb?

تَمَانِ نَ كُوَانَٔٗ هُنِئٖپُوْكَ وَنَنْڠُ
kuwaona na ṯamāni wanangu huniepūka 1d/c

wanangu huniepuka * kuwaona natamani 1
My own children avoid me, though I long to see them.

وٖنْدَانِ وَ نِ سِوَنْڠُ كُنِشِكَ والوُْبَاكِ
siwangu ni wa wenḏāni wālūbāki kunishika 1f/e

walobaki kunishika * siwangu ni wa wendani 1
And those who remain to embrace me are not my own, but are the offspring of others.

زتَِ هُنِپِجَ مْبُوْنَ مٖوَتٖنْدَانِ نِ مِمِ
mbūna hunipija ziṯa mimi ni mewaṯenḏāni 1h/g

mimi nimewatendani * mbona wanipija zita 1
What have I done to you? Why do you wage war on me?

أُسْوَاحِلِنِ وَ وَانَ دَمُ وَ مِمِ وَنَانْڠُ ٢
wāna wa uswāḥilini wanāngu mimi wa ḏamu 2b/a
wanangu mimi wa damu * wana wa Uswahilini 2
My own flesh and blood, the children of Swahililand,

نَانِ نِ كُنِيُوَ يَا هَامُ هَوَنَ أَصِلِ
yā kuniyuwa ni nāni aṣili hawana hāmu 2d/c

asili hawana hamu * ya kuniyuwa ni nani 2
are uninterested in knowing who I am,

مَجِرنَِ وَ وَنَ نَ قَؤُمُ وَمٖنَتِيَ
na wana wa majirani wamenaṯiya qaumu 2f/e

wamenatia kaumu * na wana wa majirani 2
and have left me to other peoples, and to the children of neighbours.

زتَِ هُنِپِجَ مْبُوْنَ ڠَانِ كُوْسَ لَنْڠُ كُوْسَ
mbūna hunipija ziṯa kūsa langu kūsa gāni 2h/g

kosa langu kosa gani * mbona hunipija zita 2
What kind of fault is my fault? [O my children] why do you continue waging war on me?

1
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پُنْڠُوَنِ سِنَ وَلَ سِتَاسَ مَامٖنُ مِمِ ٣
wala sina punguwani mimi māmenu siṯāsa 3b/a

mimi mamenu sit'asa * wala sina punguwani 3
I am your mother and am not yet infertile, nor has my ability to reproduce diminished.

زسِِوَنِ كُنْڠِنٖ نَ مَمْبَاسَ وَ مٖزَا نِ
na kungine zisiwani ni mezā wa mambāsa 3d/c

nimezaa wa Mambasa * na kungine zisiwani 3
I have given birth to children in Mambasa, and in the other islands [of the Swahili],

وَدِنِ زيُِوْنْڠُوْزِ نَ سِيَاسَ وَنَ نزِٖ
na ziyūngūzi waḏini nize wana siyāsa 3f/e

nizee wanasiasa * na ziongozi wa dini 3
to politicians and to religious leaders,

زتَِ وَ مَاشُجَا نَ فَنِ كُلَ وَ مَافنُْدِ
na māshujā wa ziṯa māfunḏi wa kula fani 3h/g

mafundi wa kula fani * na mashujaa wa zita 3
to craftsmen in every field, and to war heroes.

عَثْمَانِ مْوٖنْڠٗ پيَِ مُيَاكَ مَامَاكٖ نْدِمِ ٤
piya mwengo 'athmāni nḏimi māmāke muyāka 4b/a
ndimi mamake Muyaka2 * pia Mwengo Athumani3 4

I am the mother of Bwana Muyaka, and of Mwengo Athmani also,

وٖنْدَانِ وَاكٖ وٖنْڠِ نَ كَذَلكَِ زَهِدِ نَ
na wengi wāke wenḏāni na zahiḏi kadhalika 4d/c

na Zahidi4 kadhalika * na wengi wake wendani 4
and of Zahidi too, and many of his contemporaries,

قَرنِِ مُوْيَ مْبوَا وٗتٖ مَتَاكَ نَ كُوْتِ عالى
woṯe mbwā mūya qarini 'ālı̄ kūṯi na maṯāka 4f/e

Ali Koti5 na Mataka6 * wote mbwa moya karini 4
Ali Koti and Mataka, all from just one century,

نْيوتَ كَمَ كَوَا وَ مَاتوُْمبونِ لتُِوْكَ وَ
wa kawā kama nı̄ūṯa waliṯūka māṯūmbūni 4h/g

walitoka mtumboni * wakawaa kama nyota 4
they emerged from my womb, and shone like stars.

كِدَنِ نَ أُكِسٗوْمٖ نْڠَلِيَ انِْكِشَافِ ٥
ukisōme na kiḏani inkishāfi ngaliya 5b/a

Inkishafi7 angalia * ukisome na kidani 5
Look at Inkishafi. Read it attentively

مْوٖنْدانِ كْوَامْبِيَاءٗ نِ كْوٖلٖيَ تَاكَاپُوْ نْدِپُوْ
ni kwāmbiyao mwenḏāni nḏipuu ṯākāpuu kweleya 5d/c

ndipo takapo kwelea * nikwambiyao mwendani 5
and then you will understand, my dear friend,

2
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اصَِلَانِ هَزفِِ نَ زِمٖسَلِيَ توُْنْڠٗ نِ
na hazifi aṣilāni ni ṯūngo zimesaliya 5f/e

ni t'ungo zimesalia * na hazifi asilani 5
what I am telling you. These verses are of enduring worth and will never die.

وَالوُْپتَِ وَنَانْڠُ نِ نْيَانِ نِ وَالوُْزتِنُْڠَ
ni wanāngu wālūpiṯa wālūziṯunga ni nyāni 5h/g

walozitunga ni nyani * ni wanangu walopita 5
Who were those who composed them? They were my children who have passed on.

دِنِ ػِرَاڠُ پيَِ نَ مْڤِتَ وَ مَالٖنْڠَ نَ ٦
na piya kʲirāgu ḏini na mālenga wa mviṯa 6b/a
na Malenga8 wa Mvita * na pia Chiraghudini9 6

And the Bard of Mambasa, and Chiraghdin too,

ادُُنِ هَاوَكُكِرِ ولزِفِوَُتَ نْيايُو
hāwakukiri uḏuni nyāyuu ūlizifuwaṯa 6d/c

nyayo walizifuata * hawakukiri uduni 6
they followed in my footsteps, they did not submit to lower standards.

هُفَلِييانِ لَكِنِ هُتٖتَ نْنَابَهَانِ
lakini hufalı̄yāni nnābahāni huṯeṯa 6f/e

Nabahani10 huteta * lakini hufaliyani 6
al-Nabhany reproves, but to what effect?

اَمٖئِكِتَ انِْڠَا اوَُنْدَانِ پْوٖكٖ نْدِيٖ
ingā ameikiṯa nḏiye pweke uwanḏāni 6h/g
ndiye pweke uwandani * ingawa ameikita 6

He remains alone in the field, yet he stays strong.

اكُِنڠُوْنِ سِيَاكُوْمَ وٖزَ نَ كُزَا بَادٗ ٧
siyākūma ukingūni bāḏo kuzā na weza 7b/a

bado kuzaa naweza * siyakoma ukingoni 7
I am still able to give birth. I have not yet reached the limit,

فوُٗنِ مُمٖئِتٗوَ مُمٖنِپُوْزَ لَكِنِ
mumeiṯowa fuwoni lakini mumenipūza 7d/c

lakini mumenipuuza * mumeitowa fuoni 7
but you have all despised me. You have left me high and dry,

كَانوُْنِ كُنِپانْڠِيَ مٖئِتُوكٖزَ وَنْڠِنٖ
kunipāngiya kānūni wangine meiṯūkeza 7f/e

wangine meitokeza * kunipangia kanuni 7
now others have come forward to regulate me,

مُلِپُوْنوَِتَ نْيِنْيِ كُبُوْنِ مُسَمِيَاتِ
nyinyi mulipūniwaṯa musamiyāṯi kubūni 7h/g

musamiati kubuni11 * nyinyi muliponiwata 7
compiling standardized dictionaries.
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جَردَِنِ ػنَْڠَلِيَ كِسِكِتِكَ هُلِيَ ٨
kʲangaliya jariḏani huliya kisikiṯika 8b/a

hulia kisikitika * changaliya jaridani 8
I weep and lament when I look at the learned journals,

وَڠٖنِ نِ سِوَنَانْڠُ انَْدِكَ وَنَاءُ وٖنْڠِ
siwanāngu ni wageni wengi wanau anḏika 8d/c

wengi wanaoandika * si wanangu ni wageni 8
for many of those who contribute are not my children, they are strangers [to me].

نْيَانِ نِ تنُْڠٗ وَپٖكَ كَذَلكَِ اذَِاعَانِ
wapeka ṯungo ni nyāni idhā'āni kadhalika 8f/e

idhaani kadhalika * wapeka t'ungo ni nyani 8
It is much the same with the media. Who are the ones who send in their compositions?

مْڤِتَ مْبوا كُوَ لػَِ پْوان هَاوَتوُْك وٖنْڠِ
likʲa kuwa mbwā mviṯa wengi hāwaṯūk pwān 8h/g
wengi hawatoki p'wani * licha kuwa mbwa Mvita 8

Many do not come from the coast, although they may have a Mambasa address.

شُلٖنِ زسُِوْمٖشْوَاءٗ زتَِابُ نَ انَڠَلِيَ ٩
zisūmeshwao shuleni angaliya na ziṯābu 9b/a

angalia na zitabu * zisumeshwao shuleni 9
Look at the textbooks which are studied at our schools.

شَانِ سِ وَلَ سُوْدِ سِ رجََبُ نَ هَازَانْدِكْوِ
si sūḏi wala si shāni hāzānḏikwi na rajabu 9d/c

hazandikwi na Rajabu * si Sudi wala si Shani 9
They are written neither by Rajabu, nor by Sudi nor by Shani.

سُكَانِ اَشِشِيٖؤٗ كَتِبُ نْدِيٖ ْنْجُوْرڠٖٗ
ashishiyeo sukāni njūroge nḏiye kaṯibu 9f/e
Njoroge12 ndiye katibu * ashishiyeo sukani 9

The author is Njoroge, he is the helmsman.

هُفُوَتَ نْيُوْمَ نَاءٗ وٖنْدانِ وَاكٖ نَ ػاَرٗ
nao nyūma hufuwaṯa kʲāro na wāke wenḏāni 9h/g
Charo13 na wake wendani * nao nyuma hufuata 9

Charo and his colleagues follow.

نْدِيَانِ هُرُدِ ػٖنْدَ كُوْنْڠَمَانٗ هُوَلكِْوَا ١٠
kʲenḏa huruḏi nḏiyāni huwalikwā kūngamāno 10b/a

hualikwa kongamano * chenda hurudi ndiani 10
When I am invited to conferences, I turn back before I arrive.

سِوَانِٔٗ نْيِنْيِ كُوَ مْنُو اتُنُْڠُ هُوٗنَ
kuwa nyinyi siwaoni huwona uṯungu mnuu 10d/c

huona utungu mno * kuwa nyinyi siwaoni 10
I feel exceedingly bitter that I do not see you all there.
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نْنِ نتِٖنْدٖ لَكِنِ زتَِانِ هُزاِمَُ نَ
lakini niṯenḏe nni na huziuma ziṯāni 10f/e

na huziuma zitano14 * lakini nitende nini 10
I bite my fingers in frustration, but what can I do?

مُمٖنِوَتَ مَامٖنُ مُمٖئِخِنِ وَنَانْڠُ
māmenu mumeniwaṯa wanāngu mumeikhini 10h/g

wanangu mumeihini * mamenu mumeniwata 10
My children, you have missed your opportunity. You have abandoned your own mother.

مِتِحَانِ ػنَْڠَلِيَ مَاتوُْزِ كْوَا هُلِيَ نَ ١١
kʲangaliya miṯiḥāni na huliya kwā māṯūzi 11b/a

na hulia kwa matozi * changaliya mitihani 11
And I shed tears when I look at the results of the school exams.

زِوَنِ كِسُومُ وَ نَ كِبْوٖزِ وَ وَنَفُنْدِ
na wa kisūmu ziwani wanafunḏi wa kibwezi 11d/c

wanafundi wa Kibwezi * na wa Kisumu15 ziwani16 11
Students from Kibwezi, and from Kisumu by the lake,

كِلٖلٖنِ وَليُِوكُوْ بَارِزِ وَنَاءٗ نْدِوٗ
waliyūkuu kileleni nḏiwo wanao bārizi 11f/e

ndiwo wanao barizi * waliyukuu kileleni 11
they are the ones who are ahead, who are at the top;

هُكُوْكُوْتَ تنِِ مُكُوْ پْوانِ كْوٖتُ مُلُوْتوُْكَ
mukuu ṯini hukūkūṯa mulūṯūka kweṯu pwāni 11h/g
mulotoka kwetu p'wani * muko t'ini hukokota17 11
and you, students from the coast, you lag far behind.

ػوُٗنِ أُزَمِلِ وَ اتَُفِتِ وَفَانْيَاءٗ ١٢
wa uzamili kʲuwoni waānyao uṯafiṯi 12b/a

wafanyao utafiti * wa uzamili chuwoni 12
Amongst those who are researching for degrees at the universities,

هَوَپَاتكَِانِ اَوْ كَاتتِِ نِ وَسْوَاهِلِ
aw hawapāṯikāni waswāhili ni kāṯiṯi 12d/c

Waswahili ni katiti * au hawapatikani 12
Swahili students are few or non-existent.

نْيَانِ نِ مَاكُوْسَ مْوٖنْيٖ مْلَئِتِ نِ نْيَانِ نِ
mwenye mākūsa ni nyāni ni nyāni ni mlaiṯi 12f/e

ni nyani ni mlaiti * mwenye makosa ni nyani 12
Who is to be blamed? Whose fault is it?

هَامُكُپَاتَ مْڠِنٖ هَامُنِثَمِنِ مِمِ
mgine hāmukupāṯa mimi hāmunithamini 12h/g

mimi hamunithamini * mngine hamukupata 12
You esteem me not at all, yet you have not replaced me by another.
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مُويُوْنِ هُنِانْٔٗڠُوْنْڠَ هُنِيْنَ كِوَسِكِيَ ١٣
huniongūnga mūyūni kiwasikiya hunı̄na 13b/a

kiwasikiya hunena * huniungonga moyoni 13
When I hear those who are not mother-tongue speakers speaking, I feel sick at heart.

ئتَِمَانِ نَ نَحَؤُ تٖنَ هَكُنَ صَرفَْ
naḥau na iṯamāni ṣarfa hakuna ṯena 13d/c

sarufi hakuna tena * nahau naitamani 13
Inflection is no longer employed, while grammatical [Swahili] is what I desire!

كَانْوَانِ مَشَاپُوْ كَمَ هَيَانَ لَذَ حَتَ نَ
kama mashāpuu kānwāni na ḥaṯa ladha hayāna 13f/e

na hata ladha hayana * kama mashapu kanwani 13
Even [their speech] is wanting in flavour, like a plug of tobacco in one’s mouth.

هُتٖتَ اَوْ هُئِمْبَ هُنٖنَانِ سِئٖلٖوِ
huimba aw huṯeṯa sielewi hunenāni 13h/g

sielewi hunenani * huimba au huteta 13
I do not understand what they are saying. Are they singing? Are they complaining?

دُنيَِانِ تٖنَ ايَْ تَارُدِ مُيَاكَ لَوْ ١٤
ay ṯena ḏuniyāni law muyāka ṯāruḏi 14b/a

lau Muyaka tarudi * ae tena duniani 14
Were Bwana Muyaka to return, were he to come back to the world,

مَحَكَمَانِ كْوٖنٖنْدَ اتَِمْبِدِ موَانَانْڠُ
kwenenḏa maḥakamāni mwānāngu iṯambiḏi 14d/c

mwanangu itambidi * kwenenda mahakamani 14
it would be necessary, my child, for him to go to a court of law,

يَقِيْنِ نيُِوَاءٗ وَ مَشَهِدِ نَ ائَٖتٖ
waniyuwao yaqı̄ni aeṯe na mashahiḏi 14f/e

aete na mashahidi * waniyuwao yakini 14
and he would need to call witnesses who know me well,

كُوَپَاتَ حَتِيَ كْوَا ڠٖرزَٖنِ مْوٖنْدٖ نْيُوْتٖ
kwā ḥaṯiya kuwapāṯa nyūṯe mwenḏe gerezani 14h/g

nyote mwende gerezani * kwa hatia kuwapata 14
and all of you would go to prison for the offence which you have committed against me.

امَِانِ هَامُوْنَ وَلَ غٖيْرَ هَمُنَ وَاللّٰهِ ١٥
wala hāmūna imāni wallähi hamuna ḡēra 15b/a

wallahi hamuna ghera * wala hamuna imani 15
Truly you have neither zeal nor self-confidence.

هَمُنِثَمِنِ كُوَ لَكُوَكٖرَ هَمُنَ
kuwa hamunithamini hamuna lakuwakera 15d/c

hamuna la kuwakera * kuwa hamunithamini 15
It irritates you not at all that you do not esteem me.
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اوَُنْدَانِ هُتٖزٖوَ مْپِوِرِ كَامَ نِ مِمِ
huṯezewa uwanḏāni mimi ni kāma mpiwiri 15f/e

mimi ni kama mpwira * hutezewa uwandani 15
I am just like a ball in the play-ground,

كُپِتَ مْوٖنْيٖ كُلَ نَ تٖكٖنْدِيَانَ هِپِجْوَا
na kula mwenye kupiṯa hipijwā ṯekenḏiyāna 15h/g

hipijwa teke ndiani * na kula mwenye kupita 15
I am given a kick by anyone who passes by in the street.

وَمٖبُوْنِ وَنْڠُ وَاسُوْ اشَُعِرِ كْوٖنْيٖ حَتَ ١٦
wāsuu wangu wamebūni ḥaṯa kwenye usha'iri 16b/a

hata kwenye ushairi * waso wangu wamebuni 16
Even in the field of Swahili prosody, those who are not mine have invented

وَڠٖنِ كُوٗلٖزَ كْوَا بَحَارِ حُرُ لزِٗ زِ
kwā kuwoleza wageni zilizo ḥuru baḥāri 16d/c

zilizo huru bahari * kwa kuoleza wageni 16
free verse, imitating foreigners.

كِفَنِ مَاشَعِرِ سِ سِيَاكِرِ هَايُو ممِ
si māsha'iri kifani mmi hāyuu siyākiri 16f/e

mimi hayo siyakiri * si mashairi kifani 16
For myself, I cannot accept that. That is not Swahili poetry.

زتَ زَا مْبنُ ن هزٗ نْن كْوا نِ ىُوْت هَاىُوْ
hzo n mbnu zā zṯa hāyuu yūṯ ni kwā nn 16h/g
hayo yote ni kwa nini * hizo ni mbinu za zita 16

What is the point of it all? These are preparations for war.

ڠَانِ عَجَابُ نِ هِنِ سِنَ مْوٖنْيٖوٖ هَمْبِوَ ١٧
hini ni 'ajābu gāni hambiwa mwenyewe sina 17b/a
hambiwa mwenyewe sina * hini ni ajabu gani 17

I am told that I belong to nobody in particular. How extraordinary!

يَانْڠَانِ تَانْدُ نَ كَاوَ شِنَ كاكُوْسَ هُوَاءٖ
kāwa na ṯānḏu yāngāni huwae kākūsa shina 17d/c

huwae kakosa shina * kawa na tandu yangani 17
How can I be rootless below ground and yet have branches above?

نْيَانِ نِ اَلوُْنَانْدِكَ ئنَِ نپَِ اَلوُْ نْيَانِ
alūnānḏika ni nyāni nyāni alūnipa ina 17f/e

nyani alonipa ina * alonandika ni nyani 17
Who gave me my name? And who are they who wrote me down?

نَالپُِوپَاتَ وَپِ نِ اسُْوَاحِلِنِ سِ كِوَ
ni wapi nālipūpāṯa kiwa si uswāḥilini 17h/g

kiwa si Uswahilini * ni wapi nalipopata 17
If I do not hail from Swahililand, then whence do I come?
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اصَِلَانِ سِدَللِِ هُنِنٖنَ وٖنْڠِ كُوَ ١٨
siḏalili aṣilāni kuwa wengi huninena 18b/a

kuwa wengi huninena * si dalili asilani 18
That many speak me, [Swahili], is not of itself proof of origins,

هَامُوٗنِ كِنْڠٖرزَٖ سِنَ مْوٖنْيٖوٖ يَاكُوَ
kingereza hāmuwoni yākuwa mwenyewe sina 18d/c

yakuwa mwenyewe sina * Kiingereza hamuoni 18
or that I have no owner. What of the English language?

دُنيَِانِ زٗتٖ پٖمْبٖ سَانَ وٖنْڠِ نَ هُنٖنوَا
pembe zoṯe ḏuniyāni hunenwā na wengi sāna 18f/e

hunenwa na wengi sana * pembe zote duniani 18
It is spoken by very many, in all corners of the world,

هَئِكُكَاتَ مِزيِٖ سِنَانِ كْوَاءٗ نَ كِنَ
miziye haikukāṯa kina na kwao sināni 18h/g

kina na kwao sinani * miziye haikukata 18
yet the language remains firmly established in its homeland, its roots have not been severed.
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Endnotes

1. From Abdulkadir and Frankl (2013).
2. Bwana Muyaka was the outstanding Swahili poet of 19th century Mombasa. After his death many of his verses
were recalled by Mu’allim Sikujua Abdallah al-Batawi (died 1890) and transcribed with annotations by W.E. Taylor
(1856-1927). After Taylor’s death his papers were acquired by the library of the School of Oriental and African
Studies (SOAS), London.
3. Mwengo Athmani: this 18th century poet from Pate composed the Utendi wa Tambuka (The Epic of Heraklios).
4. Zahidi: see El-Maawy (1973).
5. Ali Koti of Pate: see S. Chiraghdin (1987, pp.31-7).
6. Bwana Mataka’s full name is Muhammad bin Shee Mataka al-Famau (1825-1868). He was ruler of Siyu, as was
his father. His mother was Mwana Kupona, famous for the poem of advice written to her daughter. Bwana Mataka
died in Mombasa’s fort while imprisoned by the Busa‘idi.
7. The Inkishafi, according to W.E. Taylor (Stigand 1915, pp96-105), is “a great, if not the greatest, religious classic
of [the Swahili-speaking peoples]”. The poem, concerned with the decay of Pate (formerly a flourishing town in
northern Swahililand), may remind some readers of Thomas Gray’s Elegy written in an English churchyard (London
1751).
8. The Bard of Mambasa refers to Ustadh Ahmad Nassir Juma Bhalo, see S. Chiraghdin (1971).
9. Shihabdin Chiraghdin (1934-1976). See the biography by his daughter – L. Chiraghdin (2012).
10. In an unpublished commendation from 12 June 1974 J.W.T. Allen writes about Ahmad Sheikh Nabhany: “I
am privileged to have a wide circle of friends and acquaintances among Swahili scholars of Swahili. I have some
knowledge of their rating of themselves and I can name perhaps half a dozen (still living) who are always referred
to as the most learned. To me they are walking dictionaries and mines of information and Ahmed is unquestionably
one of them. He comes of a family of scholars whose discipline is as tough as any degree course in the world. They
have no time for false scholarship or dilettantism. That this profound learning is almost wholly disregarded by
those who have been highly educated in the western tradition affects almost everything written today in or about
Swahili. When I want to know some word or something about Swahili, I do not go to professors, but to one of the
bingwa known to me. One of these could give a much greater detail of assessment, but of course his opinion would
not carry the weight of one who can put some totally irrelevant letters after his name”. For a biography see Said
(2012).
11. For almost a century the principal publisher of standardized Swahili dictionaries has been the Oxford University
Press (OUP). Clearly OUP has to be profitable, and profitable is what, over the years, their dictionaries of standard-
ized Swahili have been. However, if one considers excellence in research and scholarship not one of the OUP’s
standardized Swahili lexicons can begin to compare with the Oxford English Dictionary (‘more than 600,000 words
over a thousand years’). Fortunately for Swahili and for Swahili studies there exists the monumental Dictionnaire
swahili-français, compiled by Charles Sacleux (Sacleux 1939). Sacleux’s chef d’oeuvre (‘unprecedented in historical
depth, dialectological detail and philological knowledge’) can now be accessed electronically, courtesy of Swahili
Forum (uni-leipzig.de/~afrika/swafo/index.php/sacleux). Heartfelt thanks are due to Thilo Schadeberg
and Ridder Samsom.
12. njoroge: a name representing those who have their origins in the East African interior (the bara).
13. charo: a name representing those who have their origins in the coastal hinterland (the nyika).
14. These words echo the words of the Inkishafi: “wakauma zanda na kuiyuta”. Readers unfamiliar with this Swahili
gesture of regret could consult Eastman and Omar (1985).
15. Kibwezi and Kisumu are places in the East African interior.
16. The lake is Lake Nyanza, also known as Lake Victoria.
17. Over the years young people on Lamu Island (and indeed elsewhere in northern Swahililand) have received
a raw deal in their primary and secondary education. They have ‘lagged far behind’ their counterparts from the
interior, and so Mother Swahili grieves for her marginalised children.
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